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Chapter 1 Unpacking and Inventory

1.0 Receiving and Inspecting the Repeater

When you receive a repeater from Repeater Technologies, Inc. (RTI), immediately do the 
following:
1. Unpack the repeater. 

2. Inventory the contents against the packing lists, and note any missing items. 

3. Inspect for shipping damage, especially for damage that might have been hidden by the 
packaging. Pay particular attention to the following:

• Bent or dented sheet metal. 
• Loose or broken components. 
• Damaged connectors.
• Damaged or broken wiring or coaxial cables.
• Missing or damaged contents of the accessory kit.
• Missing or damaged optional equipment, ordered with the repeater unit.

If any items are missing or damaged, perform all of the following steps:
1. Report any missing or damaged items, by writing them on the shipping waybill. 

2. Ask the delivery agent to sign the waybill, for verification of the loss or damage. 

3. Notify the transfer (shipping) company as soon as possible.

4. Submit a damage report to the shipping carrier.

5. Send a written report of the loss or damage to the Field Services Department of Repeater 
Technologies.

NOTE: Save the original shipping carton and packing materials, to reuse for any future transport of 
the repeater unit. For example, a repeater might be moved to a new location in a cellular/PCS 
network, or a damaged repeater might need to be returned to RTI.

1.1 Equipment Required, but Not Supplied, for Installation

Table 1-1 lists required installation equipment that RTI does not provide with a repeater. These 
standard tools should be readily available from local suppliers of telephone, electronic, and/or 
computer equipment.

NOTE:  Installing an RTI repeater requires a site plan. These documents define the intended 
parameters of the cellular/PCS network project, including the repeater’s coverage area, gain 
settings, and antenna location. If necessary, consult a network administrator for more 
information.
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Table 1-1 Required Installation Equipment

Use this equipment: To:

Site Plan/Network Engineering documentation Correctly configure the repeater to operate in the 
PCS/Cellular network.

1/8 inch Small Flat Blade Screwdriver Use for AC input power and external alarm plugs.

3/16 inch Medium Flat Blade Bit Screwdriver Use on the older entry box door and DC input power 
terminals.

¼ inch Hex driver Detach security screws.

Voltmeter, Fluke 75 or equivalent VOM Test voltage and power polarity.

Spectrum Analyzer Test RF power output.

RF Signal Generator Test antenna isolation.

Pilot scanner (optional) Measure donor base station receiver power.

Type N (m) 50-ohm Termination, 10 W, (3 ea.) Terminate antenna ports during off-air testing.

Mounting Hardware Mount repeater, antennas and coax.

Electrical Wiring Equipment (as needed) Connect external power to Repeaters.

Laptop Computer (Win95, 98, NT) Configure, control and monitor the repeater 
through the RepeaterNet craft port.

Pole Mounting Tightening/Crimping Tool (for 
pole mounting only)

Mount the repeater to a pole and secure pole 
mounting straps.

Jumper Cables Type N (male to male) calibrate cables for Test 
Equipment (length depends upon application).

Frequency Domain Reflectometer (Feed Line 
Sweep Tester) Wiltron Site Master or 
equivalent

Test Coax/Feed Line and Connector VSWR.

Directional coupler (2 each) –30 dB coupled port Test repeater power output.
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Table 1-2 Accessory Kit Inventory List

Part Number Description Quantity

129-0007-02 Wrench, Hex Key, 5/32” x 3-1/4” LG Short Arm 1

129-0008-01 Hex Bit, Pin-In Socket, 7/32” 1

519-1200-03 RepeaterNet Craft Software 1

187-0713-02 Cable Assembly, Comp (2M) 2X D-Sub 9-Pin, Male/Female 1

187-0929-01 Cable Assembly
AC Power Cord

1

113-0015-01 Shipping Container (For OA1900C Only) 1

113-0016-01 Shipping Container (For OA850C Only) 1

550-5100-01 Repeater Reference Manual, Printed 1

550-5100-02 Repeater Reference Manual, CD-ROM (OA850C Only) 1

137-0446-01 Plug, Button, Recessed-Type Head (OA1900C Only) 1

137-0447-01 Fitting, Conduit, 1/2” LiquidTight 4

137-0447-02 Locknut, Standard Conduit 1/2” 1

129-0011-01 Hex Bit, 7/64” x 1” long Ball Point (1/4” Driver)
For OA850C Only

1

519-5100-01 RTI Tools Disk (OA850 Only) 1
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Chapter 2 Repeater Installation Check List

2.0 Introduction

This chapter includes a check list, which summarizes all of the steps required for successfully 
installing a repeater. Repeater Technologies, Inc. (RTI) recommends a thorough review of the 
check list, both before and during installation of an RTI repeater.

2.1 Contacting Repeater Technologies

This section describes how to contact the Repeater Technologies corporate headquarters at any 
time before, during, or after installing a repeater, for sales information or technical assistance 
for the OA850C or OA1900C repeater, or for any of our communications or related products. 
Refer to the inside cover for contact information.

2.2 RepeaterNet Craft

Some of the steps in the installation process require using RepeaterNet Craft software. This 
software is provided on the appropriately-labeled diskettes. Those diskettes are included with 
this manual.

2.3 Checklist

The OA850C or OA1900A NR Installation Checklist begins on the next page, and continues for a 
total of four pages. The remaining chapters of this manual provide detailed descriptions of each 
of the steps summarized in this checklist.

The Installation Checklist is also included as a single-sheet fold-out, in the front binder-flap of 
the printed Repeater Reference Manual. An installer can take the fold-out sheet into the field, 
and consult it during the repeater installation process. The checklist includes spaces for 
recording details about the repeater site, and for checking off completion of each installation 
step. 
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OA850C or OA1900C NR Installation Checklist
___ 0.1 Site Name _________________________________
___ 0.2 Location _________________________________
___ 0.3 Serial Number 

_________________________________
___ 0.4 BTS Name/Sector

_________________________________
___ 0.5 BTS Location 

_________________________________

1.  EQUIPMENT INSTALLATION
___ 1.1 TEST EQUIPMENT NEEDED. Sweep Tester,  Signal

Generator, Spectrum Analyzer, Pilot Scanner (optional),
and Voltmeter.

___ 1.2 VERIFY BTS OUTPUT POWER . Verify that the donor
BTS to the repeater site is running at rated output power.

___ 1.3 INSTALL ANTENNAS AND FEED LINES.  If a back-
beam antenna is used, install a power divider.

___ 1.4 RUN SWEEP TEST.  Run a sweep test on all antennas
and feed lines, upon completion of their installation. 

___ 1.5 MOUNT PRIMARY F1 REPEATER CABINET. (Cabinet
with Type-N RF connectors on bottom.) Remove the
mounting bracket from the cabinet, and mount the
repeater on a pole, wall or uni-strut. Hang the repeater
over the outside of the mounting bracket, and secure it.
Leave room for the antenna feed connections, F2 Growth
Cabinet, and BUPS, if applicable.

___ 1.6 MOUNT F2 GROWTH CABINET. (Cabinet without
Type-N connectors.) Mount to the left of (or above) the
Primary F1 Repeater Cabinet. Interconnect the two
cabinets, using the cables supplied. First connect the RF
and alarm cables in one conduit, and then the power cable in
another conduit. Remove unused AC or DC leads. (optional)

___ 1.7 MOUNT BACK-UP POWER SYSTEM (BUPS). Mount to
the right of the Primary F1 Repeater Cabinet. This supplies
DC power. (optional)

___ 1.8 INSTALL LIGHTNING SUPPRESSORS for all antenna
feed lines and cabinets.

___ 1.9 GROUND EQUIPMENT.  Connect repeater cabinet(s),
BUPS, antenna feeds, lightning suppressors, and any other
equipment, to external ground.

___ 1.10 TERMINATE ANTENNA PORTS. Use Type-N 50-
Ohm 20-Watt terminations. Two ports for non-diversity,
three ports for diversity.

___ 1.11 HOOK-UP ELECTRICAL POWER. Wire primary power
to the dedicated 20-amp breaker. Open the entry box on
the bottom of the Primary F1 Repeater Cabinet. Verify
proper voltage & polarity (either +24 VDC or 117/230 VAC,
not both). Connect the repeater and/or the BUPS to the
power source. Connect the BUPS alarm cable to J2, if
applicable. DO NOT TURN ON POWER.

2.  ANTENNA ALIGNMENTS
___ 2.1 ALIGN DONOR ANTENNA. Check RSL (Received

Signal Level) from donor BTS. Connect Spectrum Analyzer
or Pilot Scanner (optional) to the antenna feed of Repeater
Donor antenna, and adjust the donor antenna position for
maximum RSL (set for 1 MHz RBW). Confirm polarization of
the Donor antenna. Measure at idle channel power.

   Donor Antenna Polarity (V/H) ____________

   Frequency 1
Frequency__________ MHz
Power __________ dBm

      Desired PN __________ (if using a PN Scanner)
Ec/Io __________ dB
Power __________ dBm

      2nd Highest PN __________ (if using a PN Scanner):
Ec/Io __________ dB
Power __________ dBm

   Frequency 2 (If applicable)
Frequency__________ MHz
Power __________ dBm

      Desired PN __________ (if using a PN Scanner)
Ec/Io __________ dB
Power __________ dBm

      2nd Highest PN__________ (if using a PN Scanner):
Ec/Io __________ dB
Power __________ dBm

___ 2.2 ALIGN MOBILE ANTENNA(s). Using a compass or
topographic map, aim the mobile/subscriber antenna, in
accordance with the network engineering site plan.

___ 2.3 CHECK ISOLATION. Using a signal generator, inject
up to 4 CW signals across the channel (for Frequency 1)
into the donor antenna feed (suggested power level is 0
dBm). Using a Spectrum Analyzer (set for 1 kHz RBW),
measure the received level on each subscriber antenna
feed. Note the worst case difference in power levels.
ISOLATION MUST BE GREATER THAN 80 dB,
110 dB is ideal. Repeat for Frequency 2, if applicable.
Adjust the antenna location, or introduce RF shielding, if
more isolation is required.

   Isolation
TX1 / RXMain     __________ dB

TX2 / RXDiversity  __________ dB (if applicable)
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3.  COMMISSIONING THE REPEATER
___ 3.1 TURN ON POWER. Open the entry box at the bottom

of the Primary F1 Repeater Cabinet; turn ON system power.
THE RED “CRITICAL ALARM” LED ACTIVATES.
THE REPEATER IS IN ALARMED STATE UNTIL
POWER AMPLIFIERS (PAs) ARE TURNED ON.

___ 3.2 HOOK-UP INTERNAL BATTERY.  Connect the black
lead to the negative terminal of the internal battery
backup—located in the entry-box.

___ 3.3 UPDATE SOFTWARE. Load RepeaterNet  Craft
Software, provided in the accessory kit (four floppy disks),
onto an MS Windows 95/NT PC. (Even if RepeaterNet is
loaded on PC, a new Revision might be included with the
repeater.)

___ 3.4 LAUNCH REPEATERNET CRAFT. Connect a PC to the
Craft port (9-pin DB9 connector) in the Primary F1
Repeater entry box. Use the cable in the accessory kit.
Launch the RepeaterNet Craft program on the PC.

___ 3.5 UPDATE FIRMWARE.  When adding F2 Growth Cabinet
upgrades to existing (older) Primary F1 Repeater Cabinets,
update the firmware. See Step 5.16.

___ 3.6 UPDATE CONFIGURATION FOR 2 CHANNELS.
Using RepeaterNet Craft, select “Configuration/Hardware
Settings”  and click “Growth Box”. Click APPLY. Exit
RepeaterNet Craft, and restart.

___ 3.7 TURN PAs OFF. Verify that Forward PA(s) and
Reverse PA(s) are turned OFF. In RepeaterNet Craft, the
FPA(s) and RPA(s) Icons should have a circle with a slash
over them. If not, select “Configuration/Channel 1/PA
Control tab"  and turn OFF both FPA & RPA. Click APPLY.
The FPA & RPA Icons should now have a circle with a slash
over it. Repeat for Channel 2, if applicable.

___ 3.8 SET CHANNEL NUMBERS.  In RepeaterNet Craft,
select “Configuration/Channel 1/Channel #". Enter the
Channel #. Click APPLY. Repeat for Channel 2, if applicable.

   Frequency 1  __________ MHz
Forward (Downlink) Channel # __________
Reverse (Uplink) Channel #   __________

   Frequency 2 (If Applicable)  __________ MHz
Forward (Downlink) Channel # __________
Reverse (Uplink) Channel #   __________

___ 3.9 SET GAINS TO 65 dB. Confirm that the repeater
gain, under the “Configuration/Channel 1/Gain tab” screen,
is set to 65 dB for the forward (downlink) and reverse
(uplink) paths. Be sure to click APPLY. Repeat for Channel
2, if applicable. Do not activate the PAs at this time.

___ 3.10 TURN OFF POWER. Exit RepeaterNet and remove
the antenna terminations.

4.  REPEATER ALIGNMENT 
Requires two people: one at BTS, one at Repeater
___ 4.1 REPEATER SITE SET-UP. Connect the Donor antenna

feed and Diversity TX2  / RXDiversity  Mobile feed (if
applicable) to the Repeater. Connect the signal generator
to the Mobile TX 1 / RXMain port.

___ 4.2 BTS SITE SET-UP. Disconnect the antenna feed from
the diversity antenna port. Connect a spectrum analyzer to
the diversity antenna feed (set for 10 kHz RBW).

___ 4.3 TURN ON REPEATER. Login using RepeaterNet Craft.
___ 4.4 TURN ON REVERSE PA1. Using RepeaterNet Craft,

turn ON RPA1. Ensure that FPA1, FPA2 and RPA2
are turned OFF. Click APPLY. See step 3.7.

___ 4.5 INJECT TEST SIGNAL. Inject a –80 dBm signal at
the Reverse (Uplink) frequency (Step 3.8). Ensure that
the input is –80 dBm, considering signal generator
cable losses. Activate signal generator (TRANSMIT).

___ 4.6 SET REVERSE GAIN. For outdoor coverage - At the
Repeater site, increase the Reverse gain of Channel 1 in
RepeaterNet Craft (see Step 3.9), until the spectrum
analyzer at the BTS reads –82 dBm. Click APPLY. 

If the BTS Donor Sector has a Tower-Top Low-Noise
Amplifier (TTLNA), the reading should be –75 dBm, if
TTLNA Gain is 12 dB & cable loss is 3 dB. (If gain is higher
or loss is lower, add 1 dB for each 1 dB of improvement).

For indoor coverage, readings should be –92 dBm or –85
dBm, respectively. Repeat for Channel 2, if applicable. DO
NOT EXCEED THE ISOLATION IN STEP 2.3.

   Gain Setting - Reverse (Uplink) 
Channel 1 __________ dB
Channel 2 __________ dB (if applicable)

___ 4.7 SET FORWARD GAIN.  Set the Repeater Forward
(Downlink) Gain setting so it is 2 dB higher than the
Reverse (Uplink) Gain setting. DO NOT EXCEED THE
ISOLATION IN STEP 2.3. Click APPLY.

   Gain Setting - Forward (Downlink) 
Channel 1 __________ dB
Channel 2 __________ dB (if applicable)

___ 4.8 DISCONNECT TEST EQUIPMENT. At both sites,
connect antenna feeds.

___ 4.9 CHECK FOR OSCILLATION.  In RepeaterNet Craft
click the upper (Channel 1) “FPA icon/Channel 1 Forward PA
Status/Measurement Tab”. Click  Reset Low/High, and
observe the PA power levels. If the PA is consistently
running “Over Range”, turn the PA Gain down in 2 dB
increments (see Step 3.9), until the PA is not regularly
“Over Range”. Repeat for Channel 1 (upper) RPA1 & Channel
2 (lower) FPA2 & RPA2, if applicable.

___ 4.10 BACK-UP SYSTEM SETTINGS. In RepeaterNet
Craft, select “File/Upload Properties”, name a file. “Save”.

___ 4.11 EXIT RepeaterNet, close the repeater entry box, and
seal the coax connections.

___ 4.12 SET SWITCH TRANSLATIONS. Modify the Cell
Radius/Access Acquisition Search Windows, and the
PAM_SZ, for new coverage. Modify SRCH_WIN_A, and
SRCH_WIN_N, for hand-offs.
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5.  CUSTOMIZING THE REPEATER INSTALLATION 
___ 5.1 LAUNCH REPEATERNET CRAFT. Connect the PC to the

Craft port (9 pin DB9 connector) in Primary F1 Repeater
Cabinet entry box. Use the cable provided in accessory kit.

___ 5.2 SET-UP MODEM . Must have modem option. Select
"Configure/Modem/Modem Properties". Enter the Setup
string, phone number to dial for NOC access, and # of call
attempts. Click APPLY. Select "Configure/Hardware
Settings" and Click "modem attached". Click OK. Exit
RepeaterNet Craft, and restart.

___ 5.3 SET-UP PAGER. Must have the modem option. Select
"Configure/Modem/Pager Properties" and enter the pager
number to dial, # of call attempts, and unique numeric ID
message to be sent to the pager. Click APPLY.

___ 5.4 SET-UP CELLULAR PHONE. Must have the modem
option. Select "Configure/Hardware Setting" and Click
"cellular phone attached". Click OK. In the Primary F1
Repeater Cabinet entry box, remove the cell phone and
activate. Re-install the cell phone in the entry box. Exit
RepeaterNet Craft, and restart.

___ 5.5 SET-UP REMOTE OR DIRECT ACCESS . Must have
the modem option. Use to define whether access is a direct
or remote (via a modem) connection. Launch RepeaterNet
Admin and Click "Direct Connection" (or "Modem
Connection" for remote access). Click SAVE.

___ 5.6 PASSWORD PROTECTION. Select "Systems/
Properties/System Login". Enter the Login ID and
Password. A zero indicates that the feature is not active.
Click APPLY.

___ 5.7 SET-UP COLOR INDEPENDENT ICONS. Select
"Options/Independent Color Icons".

___ 5.8 STORE SITE INFORMATION . Select "System/
Properties/System". Enter the System Name, Site Info,
and Site Phone Number. Click APPLY.

___ 5.9 CONNECT EXTERNAL ALARMS . Wire J2 for alarm
info from the power source; J1 for 2 digital inputs &
outputs and DC Voltage Input; J23 for 2 Form C Relay
Contacts; J22 for Repeater Critical, Major and Minor
Alarm Form C Relays.

___ 5.10 NAME EXTERNAL ALARMS . Select "Configuration/
Alarm Control Unit". Select the "I/O Description" tab and
fill-out the names. Click APPLY.

___ 5.11 TEST EXTERNAL OUTPUTS. Select "Configuration/
Alarm Control Unit". Select the "I/O Controls" tab and
toggle ON/OFF/ON. Click APPLY after each toggle.

___ 5.12 SET-UP DC VOLTAGE ALARM. Select
"Configuration/Alarm Control Unit". Select the "Ext. DC
Voltage" tab and enter the min/max voltages. Click APPLY.

___ 5.13 CHANGE ALARM SEVERITY. To change the factory
default settings, select submenus of "Configure/(item)" for
each alarm severity change. Click APPLY for each change.

___ 5.14 VIEW ALARM LOG. Select “System/Alarm and Event
Log”.

___ 5.15 BACK-UP SYSTEM SETTINGS. In RepeaterNet
Craft, select “File/Upload Properties”, name a file. "Save".

___ 5.16 UPDATE FIRMWARE. Insert "Firmware" floppy disk
in drive (A). Select "File/Update Repeater Firmware/".
Click "OK". “Save” current firmware on (C). Select firmware
file on Floppy (A). "Open". Follow the on-screen directions.
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Figure 2-1 Typical Installation
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Chapter 3 Measuring Power from Donor Base Station

3.0 Introduction

In a CDMA (IS95) network, the dynamic RF power output of a Base Transceiver Stations (BTS) 
depends on the number of subscribers assigned to the BTS. 

The IS-95 specification, for CDMA networks, describes four different channel types, all 
contained within the forward channel: 
• One pilot channel (measures power and performs initial synchronization).

• One sync channel (passes parameters during initial synchronization).

• 0 to 6 paging channels (passes parameters during operation).

• 0 to 62 traffic channels. 

The total number of channels cannot exceed 64.

Usually, a portion of the base station’s total power is assigned to the pilot channel, the paging 
channel, and the sync channel. The traffic channels use the remaining power. For example, 
within an IS-95 network, the power allocations usually adhere to the following convention:
• Pilot Channel Power: 15 – 20%, depending on the requirements of the specific

equipment manufacturer or service provider

• Paging Channel Power: 6%

• Sync Channel Power: 2%

The remaining 72-77% of the BTS power is available for communications traffic channels.

For each repeater installed into a CDMA network, you must determine the received power level 
from the donor BTS, so that you can accurately set the repeater gain. If you do not know the 
received power level, or if you use an inaccurate value, then the repeater might become 
overdriven, and it might enter into an alarm condition.

3.1 Measuring the Donor BTS Signal Strength

If the donor BTS is idle (not carrying any subscriber traffic), you can assume that the repeater is 
radiating only pilot, paging, and sync power. If this is the case, connect a spectrum analyzer to 
the bottom jumper cable of the repeater’s donor antenna, and measure the BTS power. Either 
use a spectrum analyzer that is equipped with a CDMA module, or correct the measurement, for 
the resolution bandwidth of the spectrum analyzer.

For example, a CDMA Personality Module is available for Hewlett-Packard spectrum analyzers, 
to measure CDMA power within a 1.25 MHz band. For spectrum analyzers that do not have 
such a module, however, the closest measurement bandwidth is 1.0 MHz, so you must correct 
the measurement for bandwidth.
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3.1.1 Measuring Donor BTS Idle Power

If the donor BTS is idle (no subscribers), then the only power that the BTS transmits is pilot, 
paging, and sync. If this is the case, you can use either of two measurement methods: 
• Spectrum analyzer. 

• Pilot Scanner. 

Both methods use the same equipment configuration, as shown in Figure 3-1.

Figure 3-1 Equipment Configuration for Measuring Donor BTS Power
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Measurement Using a Spectrum Analyzer

Use the following procedure with a spectrum analyzer, to measure power from the Donor BTS to 
the repeater.
1. Connect the spectrum analyzer to the output end of the bottom jumper cable on the repeater 

donor antenna, as shown in Figure 3-1.

2. Ensure that the donor BTS is idle (no subscribers), and that only the pilot, paging and sync 
channels are active.

NOTE: If the spectrum analyzer does not have a CDMA measurement module, skip to step 4.

3. If the spectrum analyzer has a CDMA measurement module or capability, configure the 
analyzer to measure the CDMA signal. Then record the signal strength, and skip to step 5.

4. If the spectrum analyzer does not have a CDMA measurement module, proceed as follows:

a. Configure the spectrum analyzer for a resolution bandwidth of 1.0 MHz, and for a video 
resolution of 30 kHz.

b. Set Video averaging to ON.

c. Note and record the signal strength.

d. To correct the reading for a 1.25 MHz bandwidth, add 0.9 dB to the reading. For exam-
ple, if the spectrum analyzer indicates –55 dBm, the corrected reading is -54.1 dBm (-54 
dBm, for all practical purposes).

5. Move the antenna for maximum signal strength.

3.1.2 Measuring Donor BTS Loaded Power

If the donor BTS is active (carrying subscriber traffic), you cannot use a spectrum analyzer to 
obtain an accurate measurement of the donor BTS signal strength. In this case, you must use a 
Pilot Scanner and measure Pilot power directly.

Measurement Using a Pilot Scanner

1. Configure equipment as shown in Figure 3-1, but substitute a pilot scanner for the spectrum 
analyzer.

2. Configure the pilot scanner to measure ONLY the pilot channel of the donor BTS.

3. Move the antenna for maximum signal strength.
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Chapter 4 Installing Antennas

4.0 Installing Water Protection for Antenna Connections

NOTE: This should be done after the repeater has been fully configured, functionally set-up and no 
further work is required.

The bottom of an RTI OA850C or OA1900C repeater cabinet includes N-type connections to 
donor and subscriber antennas, as shown in Figure 4-1. RTI recommends that before installing 
the repeater and connecting it to antennas, you apply a tar-like Vapor Wrap, to seal these 
antenna connections against rain or other water sources. 
1. Wrap the threads of the N-Type antenna connectors, with electrical tape. This protects the 

connector threads from the sticky Vapor Wrap substance.

2. Thoroughly coat the outside of the electrical tape, with the Vapor Wrap putty.

3. Wrap another layer of electrical tape over the Vapor Wrap, to seal the Vapor Wrap into place.

After you complete this procedure for all N-type antenna connectors, water should not adversely 
affect the connections between the repeater cabinet, and the donor and subscriber antennas.

Figure 4-1 N-Type Antenna Connectors, Looking Up From Bottom of Repeater Cabinet
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4.1 Antenna Configurations

RTI repeaters can use any one of four basic antenna configurations:
• Donor antenna, and one dual-polarized subscriber antenna (see Figure 4-2).

• Donor antenna, and two vertically-polarized subscriber antennas (see Figure 4-3).

• Donor antenna, and two dual-polarized subscriber antennas (one for main-beam and one for 
back-beam; see Figure 4-4).

• Donor antenna, and one vertically-polarized subscriber antenna (see Figure 4-5).

NOTE: When included in a CDMA network, an RTI repeater can use a back-beam antenna, to transmit 
energy from the repeater, back towards the donor base station. A back-beam antenna 
increases the allowable distance between the donor BTS and the repeater site.
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Figure 4-2 Dual-Polarized Subscriber Antenna Configuration
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Figure 4-3 Two Vertically-Polarized Subscriber Antennas
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Figure 4-4 Back-Beam Antenna Configuration
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Figure 4-5 Non-Diversity Antenna Configuration
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4.2 Antenna RF Cables

A repeater uses the same type of RF cabling as a base station does. Usually, the top and bottom 
jumper cables are made from flexible, 1/2” air dielectric coaxial cable, and the feeder lines are 
made from 7/8” to 1-5/8” foam dielectric coaxial cable. 

Diversity repeater configurations (Figure 4-2, Figure 4-3, Figure 4-4) require three RF lines: 
• One for the donor antenna.

• One for the main subscriber antenna.

• One for the diversity subscriber antenna, if applicable. 

4.3 Lightning Protection

RTI strongly recommends installing lightning arrestors on all feeder cables to the repeater. A 
direct lightning strike can damage any electronic equipment. Damage resulting from a lightning 
strike is not covered under the RTI manufacturer’s warranty, whether or not you use lightning 
arrestors. However, using lightning arrestors can minimize the risk of damaging a repeater, and 
of losing cellular phone coverage, during lightning storms.

Use lightning arrestors that attach directly to the large-diameter feeder cables, and not to the 
repeater itself. Do not use screw-on lightning arrestors, because they attach to the repeater’s 
antenna terminals. Shunt the lightning to ground, as far away from the repeater as possible. 

RTI further recommends installing CSX (800 MHz) or PCX (1900 MHz) PolyPhaser (or 
equivalent), micro lightning protection, which attaches directly to the type-N connectors of the 
repeater (see Figure 4-6). After the PolyPhaser is attached, water-proof both the arrestor and 
connector with Vapor Wrap and electrical tape as described in Section 4.0, Installing Water 
Protection for Antenna Connections, on page 4-1.

Figure 4-6 PSX Polyphaser, for Lightning Protection

Figure 4-7 on page 3-8 shows a typical repeater installation, using coaxial lightning arrestors on 
the feeder lines. For safety and operational dependability, RTI also recommends attaching all 
antennas to the repeater site’s single point ground.
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4.4 Back-Beam Antennas and Directional Couplers

A back-beam antenna transmits a portion of the repeater’s power back toward the donor base 
station (BTS). This technique is helpful on long rural routes, where two repeaters are cascaded. 
In suburban or rural areas, this type of antenna can provide additional signal capability, in the 
area between the donor BTS and the repeater site.

As shown in Figure 4-4, power from the repeater is applied to a directional coupler (or power 
divider), which divides the power proportionately to both the main-beam and back-beam 
antennas. These couplers are available in several power division ratios: 
• 50/50

• 60/40

• 75/25

• 80/20 

• 90/10

These ratios represent the percentage of total power that the repeater channels either to the 
direct port (the higher number) or the coupled port (the lower number). For example, if the 
repeater uses a 75/25 coupler, the repeater sends 75% of its power to the main-beam subscriber 
antenna, and the remaining 25% to the back-beam antenna. 

4.5 Measuring Antenna Isolation

Measure the actual isolation between the antennas, to ensure that the donor (base station) 
antenna is sufficiently isolated from the subscriber (mobile) antenna 

WARNING: This is a crucial step in all repeater installations. 

If the isolation is not sufficient, the repeater might oscillate, or it might operate with less gain 
(signal amplification). In the first case, the repeater can introduce spurious emissions into the 
network. The second case, reduces the range of the repeater’s coverage area.
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Figure 4-8 Equipment Setup for Measuring Antenna Isolation
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Measuring antenna isolation requires a signal generator and a spectrum analyzer. The 
generator transmits a signal from the donor antenna, and the spectrum analyzer measures the 
same signal as the subscriber antenna receives it. Figure 4-8 shows the equipment set-up for 
each antenna configuration. 

Figure 4-8 shows four simplified setups. They show only the overall configuration for measuring 
antenna isolation. Isolation must take into account all cables that will be attached when the 
repeater is in operation. So you must measure isolation with all jumpers and feeder lines in 
place. The only other cables present, that are not part of the actual isolation measurement, 
should be the one from the signal generator, and the one to the spectrum analyzer. Figure 4-9 
shows all cables and equipment in place for measuring actual antenna isolation.

Figure 4-9 Antenna Isolation Measurement—Equipment Configuration

NOTE: If the repeater uses a back-beam antenna, you must measure antenna isolation from both ports 
of both antennas (four measurements). If the repeater uses only one antenna, only two 
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The equation for antenna isolation is:

ISO = PGEN – LC-GEN + LC-SA - P SA

Where:

ISO = Isolation in dB between the antennas.

PGEN = Output level of the signal generator (dBm).

LC-GEN = Loss of the signal generator cable (dB).

PSA = Power indicated on the spectrum analyzer (dBm).

This equation holds true for one donor antenna, and for one vertically-polarized subscriber 
antenna. For a dual-polarized antenna, the equation becomes:

ISO = PGEN – LC-GEN + LC-SA – MAX(PSA(L), PSA(R))

Where:

PSA(L) = Spectrum analyzer level measured on the left antenna port.

PSA(R) = Spectrum analyzer level measured on the right antenna port.

The stronger of the two readings represents the actual isolation available. For example:

PGEN = 0 dBm

LC-GEN = 1.0 dB

LC-SA = 1.0 dB

PSA(L) = -90 dBm

PSA(R) = -88 dBm

ISO = 0  – MAX(-90 or –88) = 98 dB

NOTE: A signal level of –88 dBm is stronger than a level of –90 dBm. 

In this example, the usable antenna isolation is 98 dB. 

To help you calculate the minimum required antenna isolation, RTI provides a simple tool called 
ISOLATION CALCULATOR, which is Tab 4 in the RTI TOOLS DESIGN 97 Workbook.

4.6 Sweeping the Antenna Cables

RTI recommends sweeping all RF cables for the repeater, using a network analyzer or a time-
domain reflectometer. This procedure is similar to the sweeping required for a normal base 
station. At a minimum, record the following data, for each cable or cable assembly:
• Return Loss (dB): the ratio of power transmitted to, versus reflected from, the cable.

• Voltage Standing Wave Ratio (VSWR): a factor in measuring the cable’s impedance.

• Insertion Loss (dB): the ratio of power delivered with the cable, versus without the cable.

• Distance (in feet or meters) from one end of the cable, to a detected fault.

CAUTION: If the sweep finds any faults, correct them before placing the repeater into service.
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Chapter 5 Mounting the Repeater

5.0 Installation Overview

RTI repeaters are designed for indoor or outdoor installation, and can be mounted onto either a 
wall or a pole. The unit’s compact cabinet simplifies installation, and its aesthetically-acceptable 
design means that it conforms to zoning standards in many locations.

RepeaterNet Craft software is required, throughout the physical installation of the repeater. 
Before installing the repeater, do the following:
1. Pre-load the Craft software, onto the laptop computer that you will use at the installation 

site. 

See RepeaterNet Craft for the OA850C NR, for information about installing and using 
RepeaterNet software. 

2. Retrieve the DB-9 cable from the Repeater Accessory Kit. Use this cable to connect the 
laptop with the repeater.

NOTE: Only qualified service or technical personnel should install the repeater.

Figure 5-1 shows a typical repeater installation, with installed components.
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Figure 5-1 Typical Repeater Installation
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Figure 5-13, and Figure 5-14.
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5.2 Mounting the Repeater

Figure 5-2 shows a side view of the repeater, with the rear mounting bracket attached, as 
shipped from RTI. Use this detachable mounting bracket when installing a repeater on either a 
wall or a pole.

Figure 5-2 Rear Mounting Bracket with Unit—Side View
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Figure 5-3 illustrates the bracket for mounting the repeater, and shows its dimensions. In both 
the wall-mounting and pole-mounting installation instructions that follow, this bracket is 
detached from the repeater, attached to the wall or pole, and then reattached to the repeater.

Figure 5-3 Rear Mounting Bracket
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for Wall 
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5.2.1 Wall Mounting

Hardware for wall-mounting a repeater includes the following:
• Four (4) lag (hexagonal-head) bolts.

• Four (4) flat washers.

• Four (4) lock (split) washers (optional).

To mount the repeater on a wall:
1. To separate the rear mounting bracket from the repeater, remove the security bolts and 

washers.

To do this, use either a ratchet or a 1/4” hex driver, and the 7/32” pin-in-socket driver that is 
provided in the accessory kit (see Figure 5-2 on page5-3).

2. Using the mounting hardware (hex-head lag bolts, lock washers, and flat washers), secure 
the bracket to a wall, as shown in Figure 5-4.

Figure 5-4 Installing Rear Mounting Bracket on a Wall

3. To set the repeater into the bracket, align the top of the repeater cabinet just above the top 
of the mounting bracket, so that the mounting bracket will fit inside the left and right walls 
of the repeater cabinet. 
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4. Slide the repeater cabinet downward, so that the guide bolt (on the repeater cabinet) slips 
into the guide slot (on the mounting bracket), as shown in Figure 5-5.

Figure 5-5 Guide Bolt and Slot

Mounting bracket slips 
INSIDE of repeater cabinet
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5.  Replace the attachment bolts and washers, removed in Step 1. See Figure 5-6.

Figure 5-6 Repeater Mounting and Hardware Placement
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5.2.2 Pole Mounting

RTI offers optional pole-mounting equipment, which you can order with the repeater.

Pole installation requires the following materials:
• Pole mounting kit (available from Repeater Technologies). See Table 5-1.

• Banding kit (purchased separately; available from McMaster-Carr), for mounting the 
repeater on a concrete or metal pole. See Table 5-1.

• Class A—Pole Line Hardware, for bolting the Pole Mounting Bracket to a wood pole.

Class A—Pole Line Hardware is a telephone term. It specifies bolts and screws that have a 
heavy electro-galvanized plating, so they do not rust. This type of rugged hardware typically 
is available from telephone equipment distributors, such as Graybar Electric, ALLTEL 
Supply, Spring-North Supply, PowerTel Supply, and so on. The same type of hardware is 
also available from antenna suppliers, and from tower erector companies.

The Pole Mounting Channel is designed so that the repeater is squarely mounted on the pole, 
and does not wobble.

When mounting the repeater onto a concrete or metal pole, use the Banding Kit. You usually 
would not drill a mounting hole through the center of a concrete pole. Similarly, because metal 
poles might have cables running up the center, drilling is not recommended. In both cases, 
banding is preferred over drilling.

However, wood telephone-type poles are easier to drill, so  you can use lag screws or through-
pole bolts to fasten the pole-mounting channel. 

Table 5-1 describes the Pole Mounting and Banding Kits. Because the Banding Kit includes 100 
feet of band, you do not need to purchase a separate kit with every repeater.

NOTE: The process of pole-mounting a repeater requires two people.
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Table 5-1 Pole Mounting and Banding Kits

To mount the repeater to a pole:
1. To separate the rear mounting bracket from the repeater, remove the security bolts and 

washers.

To do this, use either a ratchet or a 1/4” hex driver, and the 7/32” pin-in-socket driver that is 
provided in the accessory kit (see Figure 5-2 on page5-3).

2. Using the hardware provided with the accessory kit, secure the rear mounting bracket to the 
two (2) pole brackets—see Figure 5-7.

Quantity                     Item

Pole Mounting Kit (091-0215-01)

1 Pole Mounting Channel

4 Bolts

4 Lock (Split) Washers

4 Flat Washers

4 Tapered Plug, .312D Hole

3/4-Inch Banding Kit (Part No. 5653K12)
(McMaster-Carr Supply Co., Los Angeles, CA, USA, Tel. # (562) 692-5911)

1 Tightening-Crimping Tool

100 ft 3/4-inch, Type 201 Stainless Steel Band

100 Stainless Steel Buckles

25 Stainless Steel Scru-Lockt Buckles

1 Carrying Case
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Figure 5-7 Pole Mounting Hardware

3. Insert the four plugs provided, into the four outer holes in the rear mounting bracket.

4. Position the rear mounting bracket (the bracket that has an attached pole channel) against 
the pole, and hold it in place.

5. While one person holds the rear mounting bracket in place, the second person installs the 
steel bands that hold the bracket against the pole. 

Consult the manufacturer’s instructions (included with the Banding Kit) for this procedure.

6. To set the repeater into the bracket, slide the guide bolt into the guide slot.

7. Secure the repeater to the bracket, using the security screws and washers, removed in Step 
1.
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Figure 5-8 shows a completed pole-mount installation.

Figure 5-8 Pole Mount—Side View

5.2.3 Grounding the Repeater

A Repeater Technologies application note, titled Installation Standards for Grounding 
Requirements (Document Number 650-0002-01, Rev. 2), provides detailed grounding information 
for RTI repeaters. Contact Repeater Technologies to receive a copy of this application note.

Installing the input power to the repeater includes installing the standard electrical service 
grounds. However, you must also make sure that the OA850/OA1900C Cabinet/Chassis is 
properly grounded to a “water pipe or earth ground.”

Each repeater cabinet (F1/Primary and F2/Growth) includes two external grounding lugs: one 
on the repeater cabinet, and one on the Entry Box under the cabinet, as shown in Figure 5-9.
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Figure 5-9 Location of Ground Lug on Primary Cabinet

1. Connect number 6 (or larger) gauge AWG solid wire, to each ground lug.

2. Carefully dress the wire along cabinet, and the mounting surface, to the Repeater 
Grounding System or the Ground Rod.

NOTE: When dressing the grounding wire, and forming it around corners, avoid making sharp 
bends in the wire. Use a generous radius for each wire bend.

Connect the screw-compression ground lug (located on the left exterior of the repeater’s Entry 
Box) to a suitable earth ground — for example, to a copper ground rod, copper pipe, grounded 
steel building frame, or similar ground point. Use 2 to 7 mm, No. 6 to 2 AWG, copper wire—see 
Figure 5-10.

CAUTION: Ground all other cabinets, enclosures, antennas, and coaxial cables used for installation, 
to reduce any damage from a lightning strike or power surge.

Ground
Lug

RT117901
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Figure 5-10 Typical System Ground

Figure 5-11 Wiring and Ground Connections, At Left Interior of Repeater Entry Box

System 

5 feet (2 m) minimum
(soil type is a factor in 

grounding depth requirements)

Standard Ground Rod,
1/2-inch diameter

COM

HOT

AC IN
J18

GND

white wire

black wire green wire: eyelet
fits over ground lug

110/220
VAC

10 AMPS

AC OUT

110/220
VAC

5 AMPS

COM
HOT

ON
1

0
OFF

N/AN/A

(To F2/Growth 
Cabinet)
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Figure 5-12 Vertically-Mounted Growth Cabinet Example

Figure 5-13 Horizontally-Mounted Growth Cabinet Example

F2

F1

F2 F1
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Figure 5-14 Growth Cabinet Example with BUPS-25/80

F2
F1
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Chapter 6 Installing the Growth Cabinet

6.0 Introduction

The Growth Cabinet is a one-channel Repeater. When used with either an OA850C or OA1900C 
Repeater, the Growth Cabinet lets the whole system handle two traffic channels simultaneously. 
• The Main Cabinet (F1) carries the first channel.

• The Growth Cabinet (F2) handles the second channel. 

NOTE: The Growth Cabinet is not a stand-alone unit; it must always operate in conjunction with the 
main repeater. The main repeater and the Growth Cabinet must be working on the same 
frequency block.

This chapter provides detailed instructions for installing the Growth Cabinet, for use with a 
repeater from Repeater Technologies, Inc. (RTI). A Growth Cabinet adds a second RF channel to 
an existing primary repeater. The following summarizes the steps for installing a Growth 
Cabinet:
1. Inventory the Accessory Kit and the tools required.

2. Mount the Growth Cabinet above or next to the existing repeater.

3. Upgrade the RepeaterNet software.

4. Update the repeater firmware.

5. Turn off power to the repeater, and exit RepeaterNet.

6. Connect the second-channel repeater cabinet, using the Growth Accessory Kit. This includes 
the RF/connect cable and the power cable.

• Install the RF cable at the main repeater.
• Install the RF cable at the Growth Cabinet.
• Install the power cable.

7. Turn on the Primary F1 Repeater Cabinet.

8. Start the RepeaterNet software.

9. In RepeaterNet, add an entry for the Growth Cabinet.

10. Exit RepeaterNet, then restart it, so the software recognizes the Growth Cabinet.

11. Configure the second RF channel.

12. Enable both Channel Power Amplifiers.

13. Conduct verification tests for the primary and secondary channels.
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Notice: For OA1900 Users

Some early production OA1900 primary units (serial number 4057 and earlier) do not include 
the components required for the second channel upgrade. Figure 6-1 shows where the serial 
number is located on an OA1900 repeater. 

For these early OA1900 units, contact Repeater Technologies, Inc. (RTI) for information 
regarding unit upgrades. RTI will issue a Returned Materials Authorization (RMA) number, and 
you must return the repeater to the factory to receive this upgrade. For information about how 
to contact the RTI customer service department, see the RTI Operation Manual.

Figure 6-1 Serial Number Location on OA1900 Repeaters
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If the repeater does not include the RF cables shown in Figure 6-2, then return the repeater to 
Repeater Technologies for an upgrade.

Figure 6-2 Location of RF Cable to Connect a Growth Cabinet

6.1 Step 1—Inventory Accessory Kit and Tools Required

Table 6-1 is a check list, for verifying that the Growth Cabinet includes all of the standard 
accessories. In the Verify column, check or initial receipt of the item listed.

Table 6-1 Contents of Growth Cabinet Accessory Kit

Figure 6-3 illustrates each of these accessories.

Item Number Part Description Quantity Verify

020-2512-01 Growth Cabinet Cover (Bell Housing) 1

187-0923-01 Flexible Conduit Assembly, AC & DC power 1

187-0924-01 Flexible Conduit Assembly, RF & Alarm 1

550-5100-01 (for OA850C)
550-3100-01 (for OA1900C)

Repeater Operations Manual 1

519-XXXX-XX RepeaterNet Firmware 1

519-1200-03 RepeaterNet Craft Software 4 discs

RT080901

Primary Cabinet with RF plumbing, to accommodate adding
a Growth Cabinet, for a second RF Channel 
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Figure 6-3 Accessories Supplied with Repeater Growth Cabinet

Repeater OPS Manual
(See Note)

Growth Cabinet Cover
(Bell Housing)

020-2512-01

Vertical Mounting
Power Conduit

Horizontal
Cable Assembly
RF, 2nd Channel
187-0924-01

RT063905

Vertical Mounting
RF Cable

Flexible Conduit, Power,
2nd Ch., 187-0923-01

RepeaterNet Craft
Software, Version 2.2
or Later

Note: For OA850C NR OPS Manual, P/N 550-5100-01
For OA1900C NR OPS Manual, P/N 550-3100-01
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Table 6-2 is a check list, for verifying that RTI shipped all of the specialized tools required for 
installing the Growth Cabinet. In the Verify column, check or initial receipt of the item listed.

Table 6-2 Kit-Supplied Tools for Installing Growth Cabinet

Item Number Part Description Quantity Verify

129-0001-01 5/16" SMA Wrench 1

129-0008-01 7/32" Pin-in Socket (for Cabinet Security Bolts) 1

129-0011-01 7/64" Allen Ball-Head Bit for 1/4" Driver 1

129-0007-02 5/32" Allen Wrench (3-1/4" long) 1

142-0504-01 SMA Type RF Extender 2

129-0012-01 1-9/16" Socket Wrench 1

129-0013-01 Tightening Handle for 1-9/16" socket 1

519-XXXX-XX (depends 
upon model)

RepeaterNet Firmware 1 disc
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 Figure 6-4 illustrates each of these tools.

Figure 6-4 Tools Supplied with Repeater Growth Cabinet

RT080913

7/64” Allen Ball-Head Bit
for 1/4” Driver
P/N 129-0011-01

1-9/16” Socket Wrench, P/N 129-0012-01,
with tightening handle, P/N 129-0013-01

5/32” Allen Wrench
(3-1/4” Long)
P/N 129-0007-02

5/16” SMA Wrench
P/N 129-0001-01

SMA Type RF Extender
P/N 142-0504-01 (Quantity 2)

Downloadable
Firmware

7/32” Pin-in Socket
(for Cabinet Security Bolts)

P/N 129-0008-01
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Table 6-3 is a check list, for verifying that you obtained all of the necessary tools for installing 
the Growth Cabinet, other than the specialized tools that RTI supplies with the repeater. In the 
Verify column, check or initial that you obtained the item listed.

Table 6-3 Customer-Supplied Tools for Installing Growth Cabinet

Figure 6-5 illustrates each of these tools.

Figure 6-5 Customer-Supplied Tools

Description Quantity Verify

Small Blade (1/8") Screwdriver 1

1/4" Driver 1

Medium Blade (3/16") Bit 1

Number 2 Phillips Bit 1

Channel Lock Pliers 1

RT080912
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6.2 Step 2—Mount the Growth Cabinet

1. Mount the second-channel cabinet (Growth Cabinet) in either of two ways:

• Horizontally, as shown in Figure 6-6 and Figure 6-7.
• Vertically, as shown in Figure 6-8.

2. Install the Growth Cabinet back plate.

3. Install the RF cable.

4. Install the Alarm cable.

Figure 6-6 Horizontal Mount

RT076901

*12.10”

*This dimension is for adding a Growth Cabinet
to a pre-mounted main (primary) cabinet.
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Figure 6-7 Horizontal Mount

(F2) (F1)
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Figure 6-8 Vertical Mount

RT076902

*19.45”
*This dimension is for adding a Growth Cabinet

to a pre-mounted main (primary) cabinet.
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6.3 Step 3—Upgrade RepeaterNet Software

NOTE: This step is not required, for an OA850 repeater.

Before adding a second RF channel to an existing OA850C/OA1900 cabinet, you must upgrade 
the RepeaterNet software (on a PC or a laptop) to the version that was shipped with the growth 
cabinet. The growth cabinet package includes four installation disks for upgrading the software.
1. Insert installation disk #1 into drive a: (the floppy drive).

2. Follow the online instructions.

CAUTION: After installing RepeaterNet Version 2.2 or later, you can no longer download 
configuration files saved with Version 2.1, from an OA1900 repeater, to a PC or laptop.

3. Create a new Back-Up Configuration file.

6.4 Step 4—Upgrade Repeater Firmware

RTI distributes the upgrade for repeater firmware, on one floppy disk.
1. Insert the installation disk into drive a: (the floppy drive).

2. Select File->Firmware Upgrade from the RepeaterNet menus.

3. Follow the online instructions.

6.4.1 Turning Off Power Amplifiers

If the primary repeater cabinet is already installed, turn off the power to the forward and 
reverse Power Amplifiers (PAs).
1. Select Configuration->Channel1 from the RepeaterNet menus.

The Channel 1 Properties form opens.

2. Select the PA Control Tab in the Channel 1 Properties form.

3. Click the two PA Power buttons on the form, as shown in Figure 6-9.

The buttons toggle from ON to OFF.
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Figure 6-9 Forward and Reverse PA Buttons

4. Click the Apply button.

5. Click the OK button.
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6.4.2 Saving Configuration Files

1. In the RepeaterNet software, select File->Save Configuration.

A Select a File dialog box opens.

2. In the File Name field of the dialog box, enter the name of an existing Repeater 
Configuration file to save, as shown in Figure 6-10.

Figure 6-10 Entering File Name for a Configuration File

Select the destination Configuration Files folder, where the existing Configuration files 
should be saved (see Figure 6-11).

NOTE: You must save the Configuration files in the Configuration Files folder, which is located in 
the directory containing Version 2.2 or later of the RepeaterNet software. 
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Figure 6-11 Selecting the Configuration File Folder

3. Click on the Save button, to save the repeater properties.

A status screen shows the progress of saving the Configuration files (see Figure 6-12).

Figure 6-12 Status Screen for Saving Files
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6.4.3 Uploading New Firmware

1. Select File->Update Firmware/Save Configuration from the RepeaterNet menus.

2. Select the new firmware files to install from the a: drive (see Figure 6-13).

Figure 6-13 Selecting New Firmware Files

3. Select the firmware upgrade file, as shown in Figure 6-15.

A confirmation dialog box appears, for confirming or cancelling the firmware download (see 
Figure 6-14).

Figure 6-14 Confirmation Box for Firmware Download
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Figure 6-15 Selecting Firmware Upgrade File

4. Click the OK button to open the file.

A status box shows the progress of the firmware download (see Figure 6-16).

This file takes about 2 to 4 minutes to load.

Figure 6-16 Status Box for Firmware Download

As part of the download process, repeater properties automatically update from the 
configuration file, as shown in Figure 6-17.
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Figure 6-17 Automatic Update of Repeater Properties

5. To verify that the firmware update completed successfully, select System->Properties from 
the RepeaterNet menus.

The System Properties window opens.

6. Click on the System Inventories tab in the System Properties window, as shown in 
Figure 6-18.

Figure 6-18 Selecting System Inventories Tab

7. Exit RepeaterNet and restart.

RT082911
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6.5 Step 5—Turn Off Power and Exit RepeaterNet

6.6 Step 6—Connect the Second Channel Cabinet

6.6.1 Growth Accessory Kit: RF/Connect Cable and Power Cable

The Growth Accessory Kit contains the items described in the following sections, for the RF/
Connect Cable and for the Power Cable.

RF/Connect Cable

The following items are part of the RF/Connect Cable assembly.

• Two 1-inch Liquidtight flexible conduit 90oconnectors, consisting of the components shown 
in Figure 6-19 and Figure 6-20.

• One ribbon cable, 26 AWG, 10 COND.

• Four RF cables, as shown in Figure 6-21.

• Two Liquidtight Flexible Conduit cables, 1 inch. 

One cable is for mounting the second channel horizontally. In this cable, the RF and Ribbon 
cable are threaded through the flexible conduit, for horizontally-mounted cabinets.

One cable is for mounting the second channel vertically. If the repeater cabinets are 
mounted vertically, see Section 6.6.5, RF Cable Vertical Mounting Instructions, on page 1-
38.

NOTE: Check the label on the conduit cable, to determine which cable is correct for the repeater 
application (see Figure 6-22).

Figure 6-19 Liquidtight 1" Connector Parts, Assembled
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Figure 6-20 Liquidtight 1" Connector Parts, Disassembled

Figure 6-21 Cable/Conduit Assembly, with RF and Alarm Connectors



Chapter 6. Installing the Growth Cabinet Repeater Technologies, Inc.—Company Confidential 6-21

C
h

ap
ter 6

Figure 6-22 Identification Label for Conduit

Power Cable

The following items are part of the Power Cable assembly.

• Two 1/2-inch Liquidtight flexible conduit 90oconnectors, consisting of the components shown 
in Figure 6-23 and Figure 6-24.

• Power cord assembly, 18 AWG, 3 COND, with socket (for AC).
Power cord assembly, 14 AWG, 3 COND, with socket (for DC).

Figure 6-25 shows both types of connectors.

• Two LiquidTight Flexible Power Conduit cables, 1/2 inch, as shown in Figure 6-26.

Insert the Socket Housing Plug into the power-out connection of the entry box, on the main 
repeater cabinet.

Figure 6-23 Liquidtight 1/2" Connector Parts, Assembled
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Figure 6-24 Liquidtight 1/2" Connector Parts, Disassembled

Figure 6-25 Cable/Conduit Assembly (Showing AC and DC Power Connectors)



Chapter 6. Installing the Growth Cabinet Repeater Technologies, Inc.—Company Confidential 6-23

C
h

ap
ter 6

Figure 6-26 Cable/Conduit Assembly

6.6.2 Installing the RF Cable at the Main Repeater

1. Remove the eight (8) screws that hold the cover plate, on the left side of the main repeater 
cabinet (see Figure 6-29).

2. Remove the cover plate and gasket (see Figure 6-27). 

You will not re-use this plate, gasket, and mounting hardware.

3. Using a 5/16" open-end wrench, remove the four RF terminators from the main repeater 
cabinet (see Figure 6-28). 

Figure 6-27 Removing Screws and Cover Plate
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4. Remove the Lock Nut from the connector.

5. Thread the cables through the Bell Housing box, as shown in Figure 6-29.

6. Inside the Bell Housing box, thread the cables through the Lock Nut.

Figure 6-28 Removing RF Terminator

Figure 6-29 Threading Cables and Tightening Lock Nut
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7. Using the 1-9/16" socket wrench (provided with the Growth Cabinet), tighten the Lock Nut, 
as shown in Figure 6-29.

8. Mount the housing unit to the primary repeater cabinet, as shown in Figure 6-30.

Figure 6-30 Mounting Housing to Cabinet

9. Connect and latch the ribbon cable to the alarm socket, aligning the arrows on the cable and 
the socket, as shown in Figure 6-31.

CAUTION: When adding the Growth Cabinet to an early version of an OA1900C Primary Cabinet, 
the connector on the primary cabinet might not have a polarizing key. In this case, insert 
the ribbon cable connector, so that the red color-stripe conductor is to the RIGHT, as 
shown in Figure 6-32 .
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Figure 6-31 Orienting Alarm Ribbon Cable

Figure 6-32 Close-up of Alarm Connector

(Growth Cabinet)
48.0”

(Main Repeater)

Red strip designates Wire #1

Arrows indicate
 pin 1 of connector
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10. Connect the RF cables, in place of the four RF terminators, removed in Step 3 (see 
Figure 6-28 on page 24).

Connect the cable marked A into the connector marked A, the cable marked B into the 
connector marked B, and so on.

• Figure 6-33 shows connections for horizontally-mounted cabinets.
• Figure 6-34 shows connections for vertically- mounted cabinets.

Figure 6-33 Connections for Horizontal Mount
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Figure 6-34 Connections for Vertical Mount

Figure 6-35 and Figure 6-36 show the two types of RF connector arrangements. The first 
type requires installing extenders, which are supplied with the Growth Cabinet, as shown in 
Figure 6-35.
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Figure 6-35 RF Connectors with Extenders, Type 1

11. Loosely screw the Lock Nut to the Bell Housing box.

12. To secure the elbow to the Bell Housing, tighten the Lock Nut at the Bell Housing box. Use 
the Lock Nut Wrench and tightening bar (supplied with the Growth Cabinet), as shown in 
Figure 6-30 on page 25.

13. To install the Bell Housing to the Primary Repeater cabinet, tighten the captive screws on 
the Bell Housing.

Figure 6-37 shows the completed Bell Housing installation.
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Figure 6-36 RF Connectors, Type 2

Figure 6-37 Installed Bell Housing
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6.6.3 Installing the RF Cable at the Growth Cabinet

In the preceding section, you connected the RF cable, to the Main Repeater. In this section, you 
connect the opposite end of the RF cable conduit, to the Growth Cabinet.
1. Remove the Lock Nut from the unattached conduit connector elbow.

2. Thread the cables from the bottom of the entry box on the Growth Cabinet, through the 
opening, as shown in Figure 6-38.

Figure 6-38 Threading Cables in Growth Cabinet

3. When the cables are inside the entry box of the Growth Cabinet, feed them through the Lock 
Nut.

4. Connect the ribbon cable.

5. Connect the RF cables, using a 5/16" wrench (see Figure 6-38). Do not over-tighten.

6. Secure the Lock Nut to the entry box, using channel-lock pliers to tighten.

Figure 6-39 shows the completed cable installation to the Growth Cabinet.
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Figure 6-39 Installed Cables and Conduit on Growth Box

6.6.4 Installing the Power Cable

The Power Cable includes both AC and DC wiring, which are marked accordingly. 
• The AC wiring is 18-gauge (smaller size).

• The DC wiring is 14-gauge (larger size). 

The cable also includes two 1/2-inch flexible conduits.

The Power Cable is threaded though the flexible conduit, for horizontally-mounted repeater 
cabinets. 

NOTE: If the repeater cabinets are mounted vertically, use the conduit marked vertical.

1. While holding the cable that you will use, pull out the cable that you will not use.

2. Remove the Lock Nut from the connector at the Growth Cabinet end (the end with the 
connector installed).

3. Thread the Power Cable up through the bottom of the entry box on the Growth Cabinet.

4. Replace the Lock Nut, and tighten it using channel-lock pliers.

5. Connect the Power Cable to the power socket, in the entry box of the Growth Cabinet, as 
shown in Figure 6-40 and Figure 6-41. 

NOTE: Connect the cable so that the beveled or keyed corner is at the top right.
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Figure 6-40 Growth Box Power Connector

Figure 6-41 Detail of Power Connector on the Growth Box
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6. Thread the opposite end of the Power Cable through the opening of the entry box, on the 
Main Repeater cabinet.

7. Connect the green wire (the wire with the eyelet), from the Power Cable, to the grounding 
stud (located in the entry box of the Main Repeater cabinet).

8. Insert the other two wires into the appropriate slots in the power plug.

Figure 6-42, Figure 6-43, Figure 6-44, and Figure 6-45 show the Growth Box AC power 
connector, two different types of primary repeater AC connector arrangements, and the DC 
type connector.

Figure 6-42 AC Power Connections for Growth Cabinet
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Figure 6-43 AC Power Connections for Primary Cabinet

Figure 6-44 AC Power Connections for Primary Cabinet
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Figure 6-45 DC Power Connections for Primary Cabinet

9. Plug the power cable into the socket.

10. To connect the elbow to the main repeater cabinet, tighten the Lock Nut at the Growth 
Cabinet connector box.

11. Ground the Growth Box to earth, and to the Primary cabinet, as shown in Figure 6-46.
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Figure 6-46 Ground Connection
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6.6.5 RF Cable Vertical Mounting Instructions

If the repeater and growth cabinets are mounted vertically, you must remove the RF cables and 
ribbon cable from the longer length of conduit, and thread them through the shorter length of 
conduit.
1. Unscrew the ferrule completely off of the longer conduit, and slide the gland ring and cap 

nut off.

2. Install these three parts onto the shorter length of conduit.

3. Transfer the connectors from the longer to the shorter piece of conduit.

4. Thread the cables through the flexible conduit, and through the connector.

Figure 6-47 RF Cable, Growth Cabinet End
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Figure 6-48 RF Cable, Repeater End

6.6.6 Power Cable Vertical Mounting Instructions

If the repeater and growth cabinets are mounted vertically, you must remove the Power Cable 
from the longer length of conduit, and thread it through the shorter length of conduit.
1. Unscrew the ferrule completely off of the longer conduit, and slide the gland ring and cap 

nut off.

2. Install these three parts onto the shorter length of conduit.

3. Transfer the connectors from the longer to the shorter piece of conduit.

4. Thread the cables through the flexible conduit, and through the connector.

6.7 Step 7—Power Up Both Repeater Boxes

6.8 Step 8—Start the RepeaterNet Software
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6.9 Step 9—Add the Growth Box in RepeaterNet

1. From the RepeaterNet Configuration menu, select Hardware Configuration.

The Hardware Setting  window opens, as shown in Figure 6-49.

Figure 6-49 Hardware Setting Window

2. Check the “Growth Box is attached” box.

3. Click the OK button.

6.10 Step 10—Exit RepeaterNet, then Restart

RepeaterNet displays icons for the second channel.

6.11 Step 11—Configure the Second Channel

Use the RepeaterNet software to configure the second channel, assigning the appropriate 
channel number and gain settings.
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6.12 Step 12—Enable Both Channel Power Amplifiers

1. Select Configuration/Channel 1 from the RepetaerNet menus.

2. Click on the PA Control tab.

3. In the PA Control tab, set the gain of the F2 box, to match the existing setting for the 
primary repeater box.

4. Click on the power boxes, to change the forward and reverse Power Amplifier settings from 
OFF to ON.

5. Click the Apply button, then click the OK button.

6. Select Configuration/Channel 2 from the RepeaterNet menus.

7. Click on the PA Control tab.

8. Click on the power boxes, to change the forward and reverse Power Amplifier settings from 
OFF to ON.

9. Click the Apply button, then click the OK button.

10. Exit the RepeaterNet software.

11. Turn off power to the repeater.
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Chapter 7 Functional Repeater Test

7.0 Overview

This chapter describes how to test a repeater from Repeater Technologies, Inc. (RTI), to verify 
that it is operating properly. You must perform these tests, before connecting the repeater to an 
antenna system.

7.1 Test Equipment Required

Table 7-1 lists test equipment and tools required for testing RTI repeaters. You can substitute 
equivalent equipment.

Table 7-1 Required Equipment for Testing Repeaters

7.2 Applying Power to the Repeater

NOTE: When RTI ships the repeater from the factory, the Forward and Reverse Power Amplifiers 
(PA) are left in the OFF position, and the standby battery inside the repeater’s Entry Panel is 
disconnected.

1. Remove the antenna cables, and terminate the repeater’s antenna ports, using Type N 
(male) 50 ohm terminations. 

2. Apply primary power, AC or DC, as required. 

Refer to Chapter 9, Connecting the Power Source, for detailed instructions. 

NOTE: The Critical and Minor LEDs, located on the Repeater Entry Panel, should be ON 
(illuminated).

3. Open the entry box, under the main repeater cabinet.

As you face the repeater from the front, the standby NiCad battery is at the right side of the 
entry box. The battery is provided with two wire leads: one red wire and one black wire.

Item For Testing

Voltmeter, Fluke 75 Electrical Power

Type N (m) 50 ohm Termination, 20 W, (2 ea.) Off Air

Laptop computer RepeaterNet Configurations

Screwdriver, 1/4 inch, 6 mm Blade Wiring

Screwdriver, #1 Phillips Wiring
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Figure 7-1 NiCad Battery in Repeater Entry Box

4. Connect the red battery lead to the standby NiCad battery. 

NOTE: The Minor  LED, located on the Repeater Entry Panel, should now be OFF. 

5. Measure the AC/DC voltage at the Input Power connector in the Entry Panel.

Make sure that the voltage is within the operating parameters of the repeater:

• 110/230 Volts AC or +24 Volts DC.

7.3 Checking Repeater Properties

NOTE: When the Repeater is shipped from the factory, the Subsystem Properties alarms are 
configured to the Default setting.

1. Connect the laptop computer to the CRAFT port, P1. 

2. Start RepeaterNet. 

3. Use the RepeaterNet Craft Admin  program to connect the Repeater.

NOTE: You must perform this step, before you can access the RepeaterNet Craft  software. 

NiCad Battery
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Figure 7-2 RepeaterNet Craft Software Start-up Screen

4. Use the subsystem Properties screen to check the repeater. 

To open a Properties screen, select a subsystem from the Configuration menu selections 
listed below:

• Frond End.
• Channel 1.
• Channel 2.
• Alarm Control Unit (ACU).
• Modem.
• Cellular Phone.
• Power System.
• UPS.
• Hardware Setting
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7.3.1 Checking the Power 
System Properties

1. Select Power System from 
the Configuration menu, in 
the Main Control screen. 

The Power System 
Properties screen opens, and 
lets you view or redefine the 
settings of the power system.

2. Select the Alarm Setting  
tab.

Table 7-2 shows the types of 
power system alarms, and 
their default severity settings.

Table 7-2 Power System Alarm Types and Default Settings

7.3.2 Checking the Front 
End Subsystem 

1. Select Front End 
from the 
Configuration 
menu, in the Main 
Control screen. 

The Front End 
Properties screen 
opens, and lets you 
view or redefine the 
settings of the front-
end system. The 
Front End subsystem 
consists of the 
Forward Front End, 
Reverse Front End, 
and Diversity Front 
End.

Alarm Default Severity Setting

Input Power Alarm Critical

Power Supply Alarm Critical

PS Battery Alarm Minor

Growth Box Input Power Alarm Major

Growth Box Power Supply Alarm Major

Figure 7-3 Power System Properties Screen

Figure 7-4 Forward Front End Status Screen
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2. Select the Alarm Setting  tab.

Table 7-3 shows the types of front-end alarms, and their default severity settings.

Table 7-3 Front End Alarm Types, and Default Settings

7.3.3 Checking Channel 1 or Channel 2 

1. Select Channel 1 (for standard 
repeaters) or Channel 2 (for 
Growth-Box units only) from 
the Configuration menu, in 
the Main Control screen. 

The Channel Properties 
screen opens, and lets you view 
or redefine one of the Channel 
Properties.

2. Select one of the following 
Channel Properties tabs:

• Reverse PA.
• Forward PA.
• PA Control.
• Channel Reverse Filter.
• Channel Forward Filter.
• Channel #.
• Channel Gain.

Reverse PA Tab

Table 7-4 shows the types of Reverse Power Amplifier alarms, and their default severity 
settings.

Table 7-4 Reverse Power Amplifier Alarm Types, and Default Settings

Alarm Default Severity Setting

Forward Front End Alarm Critical

Reverse Front End Alarm Critical

Diversity Front End Alarm Critical

Alarm Default Severity Setting

Reverse PA Alarm Critical

Reverse PA1 Thermal Major

Reverse PA Ext. Shutdown Alarm Disabled

Figure 7-5 Channel Properties Screen, 
Reverse PA Tab
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Forward PA Tab

Table 7-5 shows the 
types of Forward Power 
Amplifier alarms, and 
their default severity 
settings.

Table 7-5 Forward Power Amplifier Alarm Types, and Default Settings

Alarm Default Severity Setting

Forward PA Alarm Critical

Forward PA1 Thermal Major

Forward PA Ext. Shutdown Alarm Disabled

Figure 7-6 Channel Properties Screen, 
Forward PA Tab
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PA Control Tab

The Channel Control  tab 
provides a switch to turn PA 
(Power Amplifier) power either 
ON or OFF. 
1. Set both the Forward PA and 

Reverse PA to ON. 

2. Check that the Channel 1 
Forward and Channel 1 
Reverse Power Amplifier 
icons, on the Main Control 
screen, both turned Green.

Channel Reverse Filter Tab

 Table 7-6 shows the types of 
Channel Reverse Filter alarms, 
and their default severity 
settings.

Table 7-6 Channel Reverse Filter Alarm 
Types, and Default Settings

Channel Forward Filter Tab

Table 7-7 shows the types of 
Channel Forward Filter alarms, 
and their default severity 
settings.

Table 7-7 Channel Forward Filter Alarm Types, and Default Settings

Alarm
Default 
Severity 
Setting

CSF 1 Rev Alarm Event

Alarm Default Severity Setting

CSF 1 Fwd Alarm Event

Figure 7-7 Channel Properties Screen, 
Channel PA Tab

Figure 7-8 Channel Properties Screen, 
Channel Forward Filter Tab



7-8 Repeater Technologies, Inc.—Company Confidential Chapter 7. Functional Repeater Test

Channel # Tab

The Channel #  tab lets you 
check the operating channel for 
either Channel 1 or 2. After you 
select a channel, the 
RepeaterNet Craft  software 
displays the corresponding 
frequencies.

Channel Gain Tab

The Channel Gain  tab lets you 
change the Forward and Reverse 
gain of the currently-selected 
channel. Use the following 
procedure to adjust Forward PA or 
Reverse PA Gain.
1. Click the Gain tab.

2. Press and hold the mouse 
button, and drag the horizontal 
sliders to the defined forward 
and reverse gain.

3. Click Apply (to set the channel 
gain and leave the form open) 
or OK (to set the channel gain 
and close the form).

The Gain value box (centered 
under each slider) displays the 
selected value.

Figure 7-9 Channel Properties Screen, 
Channel # Tab

Figure 7-10 Channel Properties Screen, 
Channel Gain Tab
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7.3.4 Checking the Alarm Control 
Unit (ACU)

1. From the Configuration menu 
in the Main Control screen, select 
ACU. 

The ACU Properties screen 
opens. This screen includes the 
following tabs:

• I/O Descriptions.
• I/O Control.
• Alarms.
• DC Voltage Alarm Threshold.

2. Use the I/O Description and I/O 
Control tabs, to check external 
equipment that is connected to 
the RTI repeater.

ACU Alarms Tab

Table 7-8 shows the types of Alarm Control Unit alarms, and their default severity settings.

Table 7-8 Alarm Control Unit Alarm Types, and Default Settings

NOTE: If the repeater does not have a Growth Box attached, all Growth Box alarms are disabled.

Open the Repeater Main door, to cause a Tamper alarm. The ACU icon changes from Green to 
Yellow.

Alarm Default Severity Setting

Ext. Input 1 Alarm Disabled

Ext. Input 2 Alarm Disabled

Temp Alarm Minor

Tamper Alarm Major

Analog Input Alarm Disabled

External Growth Box Alarm Major

Figure 7-11 ACU Properties Screen, Alarms Tab
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7.3.5 Checking Modem Properties

1. From the Main Control screen, 
select the Configuration  menu. 

2. From the Configuration menu, 
select Modem. 

The Modem Properties screen 
opens. This screen includes the 
following tabs:

• Alarm Setting.
• Modem Properties.
• Pager Setting.

Alarm Setting Tab

Table 7-9 shows the types of 
Modem alarms, and their default 
severity settings.

Table 7-9 Modem Alarm Types, and Default Settings

NOTE: If the repeater does not have a modem, the Modem Properties alarm is disabled.

Modem Properties Tab

The Modem Properties tab lets you 
check the values for the Setup, 
Phone Number, and Call 
Attempts. You can use these values 
only if you are using RepeaterNet 
Network Management System 
(NMS).

Alarm Default Severity Setting

Modem Alarm Minor

Figure 7-12 Modem Properties Screen, Alarms Tab

Figure 7-13 Modem Properties Screen, 
Modem Properties Tab
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Pager Setting Tab

The Pager Setting tab lets you check 
the value for the Pager Number, 
Call Attempts , Repeater Number, 
and Minimum Alarm Severity.

7.3.6 Checking Cell Phone 
Properties

1. From the Main Control screen, 
select the Configuration  
menu. 

2. From the Configuration 
menu, select Cell Phone. 

The Cell Phone Properties 
screen opens.

Table 7-10 shows the types of 
Cell Phone alarms, and their 
default severity settings.

Table 7-10 Cell Phone Alarm Types, and Default Settings

NOTE: If the repeater does not have a cellular phone, the Cell Phone Properties  alarm is disabled.

Alarm Default Severity Setting

Modem Alarm Minor

Figure 7-14 Modem Properties Screen, 
Pager Setting Tab

Figure 7-15 Cellular Phone Properties Screen
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7.3.7 Checking Back-Up Power System (UPS) Properties.

1. From the Main Control screen, select the Configuration menu. 

2. From the Configuration menu, select UPS . 

The UPS Properties  screen opens.

Table 7-11 lists the Back-Up Power System alarm types, and their default severity settings.

Table 7-11 Back-Up Power System Alarm Types, and Default Settings

7.4 Preparing the Repeater 
for Operation

After you successfully complete 
all of the foregoing steps, the 
repeater is ready to place into 
service. Proceed as follows.
1. Enter the PA control screen, 

and turn off the forward and 
reverse Power Amplifiers (see 
Figure 7-16).

2. Remove the terminations 
from the repeater’s antenna 
ports.

3. Reconnect the antenna cables.

Proceed to Chapter 8, Connecting 
External Alarms, for information 
about connecting external alarms. 
Then see Chapter 9, Connecting 
the Power Source, for the final 
connection of primary power 
(final configuration of the repeater).

NOTE: The output power of the repeater can approach 7 to 8 Watts (39 dBm), under some 
circumstances. The directional couplers used must have at least 30 dB coupled ports, to allow 
direct connection to a spectrum analyzer.

Alarm Default Severity Setting

AC Fail Alarm Disabled

Low Battery Alarm Disabled

High Battery Alarm Disabled

Charger Fail Alarm Disabled

UPS Summary Alarm Disabled

UPS Tamper Alarm Disabled

Figure 7-16 PA Control Screen
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Chapter 8 Connecting External Alarms

8.0 Overview

This chapter describes how to connect external equipment that sends a visual or audible signal, 
whenever an alarm condition occurs at a repeater site.

8.1 Alarm and Control Wiring

Figure 8-1 shows the external alarm inputs and outputs connectors for an RTI repeater. 
• Use Connector J2 to wire alarms from the Back-Up Power Supply (BUPS) to the repeater. 

• Use Connector J1 for digital inputs to custom external alarms, or for digital outputs to 
remotely-controlled devices at the repeater site. You can also use this connector for external 
shutdown of the forward and reverse power amplifiers, if required. 

• Connector J23 provides two independently-controlled “dry contact” relays, each with 
standard 1C contact sets. RepeaterNet software can use these relays to control devices at 
the repeater site.

• Connector J22 provides three independent relays, with contact sets in standard 1C form. 
Each relay is driven by specific summary alarms that the repeater generates. 

For example, one relay activates whenever the repeater generates any critical alarm. 
Similarly, the second relay activates whenever the repeater generates any major alarm, and 
the third activates on any minor alarm. 

You can use these relay contacts to activate external alarms or other equipment, in the 
event of a repeater alarm. 

Figure 8-1 shows the location of these connectors on the repeater. The plugs are actually 
removable terminal blocks. To connect to these terminals, use the following procedure.
1. Remove the appropriate terminal block.

Figure 8-1 shows connector (terminal block) J1 removed. 

Figure 8-1 Input/Output Terminals

2. Insert wires into the appropriate input and output pins.
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3. Secure each wire to its pin, using the screws provided, as shown in Figure 8-2.

Figure 8-2 Wire Connected to Terminal 1

4.  Repeat Steps 2 and 3 to connect wires to all input and output pins. 

5. Reinsert (plug in) the terminal blocks to the appropriate slot on the repeater.

The plugs are polarized; you cannot insert them incorrectly.

CAUTION: Do not exceed the specified voltage and current limits of the alarm outputs and inputs. 
Excessive voltage or current can damage the repeater.

External Alarm Pins

Table 8-1 lists all of the input and output connections, pin numbers, and functions, for the 
repeater’s external alarm connectors.

NOTE: The ground reference for J1 and J2 inputs and/or outputs is the chassis ground terminal.
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Table 8-1 Input/Output Pin Descriptions

Block Pin # Signal Name Function

1 Digital Output 1 User Controllable Open Collector Driver

2 Digital Output 2 User Controllable Open Collector Driver

J1 3 DC Voltage Input 0-60 V Input Voltage

IN/OUT 4 Digital Input 1 External Input Alarm

5 Digital Input 2 External Input Alarm

6 Forward PA Shutdown External PA Control 

7 Reverse PA Shutdown External PA Control

1 External Tamper Input Secondary Door Open

2 UPS Tamper Input External Input Alarm

3 UPS AC Fail Input External Input Alarm

J2 4 UPS Low Battery Voltage Input External Input Alarm

UPS 5 UPS High Battery Voltage Input External Input Alarm

6 UPS Charger Failure Input External Input Alarm

7 UPS Summary Normally Closed External Input Alarm

8 N/C No Connection

1 Critical Relay NO Normally Open Output

J22 2 Critical Relay NC Normally Closed Output

Alarm 3 Critical Relay COM Common Input

Relay 4 Major Relay NO Normally Open Output

5 Major Relay NC Normally Closed Output

6 Major Relay COM Common Input

7 Minor Relay NO Normally Open Output

8 Minor Relay NC Normally Closed Output

9 Minor Relay COM Common Input

1 User 1 NO Normally Open Output

2 User 1 NC Normally Closed Output

J23 3 User 1 COM Common Input

User 4 User 2 NO Normally Open Output

Relay 5 User 2 NC Normally Closed Output

6 User 2 COM Common Input
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8.1.1 Digital User-Controlled Outputs

The repeater includes two digital outputs, each with one lead for an open-transistor collector. 
When the RepeaterNet software sets one of these digital output switches to ON, the repeater 
sends a voltage to the input resistor of the transistor pair, as shown in Figure 8-3.

This voltage causes the transistor to saturate. Because the transistors are configured in a 
Darlington pair, the on-state saturation voltage is about 1 volt. This makes these outputs 
unsuitable for driving TTL loads directly. However, these two outputs can drive any other type 
of DC load, within their maximum ratings. Outputs are not isolated from the repeater’s power 
subsystem, and the repeater’s chassis ground terminal is the ground reference point for all 
inputs and outputs. Each of the digital outputs has the following maximum characteristics.

Forward Current (IC) continuous 500 mA
Maximum collector-to-emitter voltage (VCE) 50 Volts
Collector-to-emitter saturation voltage (VCE(SAT)) 1.0 V
Leakage Current in OFF State (maximum) 50 µA 

Figure 8-3 depicts the output circuitry of each user-controlled digital output.

Figure 8-3 User-Controlled Digital Output – Typical

Figure 8-4 and Figure 8-4 show two typical applications for digital outputs.

Refer to the “Alarm Control Status Screen” in Chapter 10, Configuring the Repeater, for 
instructions about activating digital outputs.

VCC

5V 1.0V

0V

0V

Chassis

Ground

REPEATER Terminal

2.7K

5.0K

3.0K

J1-1, or J1-2
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8.1.2 User-Controlled Relay Outputs

The repeater also provides two user-controlled relay outputs, with form C contacts. These relays 
respond to user commands through the RepeaterNet software, similar to those described above 
for digital outputs. When the RepeaterNet software sets one of these relay switches to ON, the 
transistor saturates, and energizes the relay. Figure 8-5 shows the relay in the energized or ON 
state.

Figure 8-5 Typical Relay Output

The maximum switching characteristics for each of the user-controlled relays are:
Maximum current 30 VDC @ 2 Amperes or 125 VAC @ 0.5 Ampere

Maximum switching voltage 220 VDC

• Figure 8-6 shows a circuit that uses user-controlled relay output number 2 to control a lamp 
at the repeater site. 

• Figure 8-6 shows a circuit that uses user-controlled relay output number 1 to control a fan or 
blower at the repeater site.

Refer to the “ACU Status Screen”  in RepeaterNet Craft, for instructions about activating the 
digital outputs of a repeater.

REPEATER

+V

5

6

4

+5V

0

J23

Chassis

Ground

Terminal
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8.1.3 Alarm Relay Outputs

You can use the RepeaterNet software to set the severity of all internal and external alarms. 
The choices of severity settings are:
• Critical.

• Major.

• Minor. 

• Event.

• Disable.

Whenever the repeater generates an alarm, it also generates a summary alarm for that severity. 
For example, if the repeater generates a critical alarm, it also generates a critical summary 
alarm. The repeater also generates similar summary alarms for major and minor alarms. 

Each summary alarm is connected to a relay. The contacts of these alarm relays are accessible 
through J22 on the repeater’s connector panel. Figure 8-7 shows the basic internal circuit, which 
is similar to the circuit for the user-controlled alarm relay outputs (see Section 8.1.2, User-
Controlled Relay Outputs, on page 1-6). When the repeater generates an alarm, the transistor 
saturates and energizes the relay, as shown in Figure 8-7.

Figure 8-7 Alarm Summary Relay Output—Typical

Figure 8-8 shows the critical alarm summary output relay, which is controlling an external, 
dual-color (green/red) LED. Normally, the relay is open, and the green LED is biased on. When 
an alarm occurs, the relay closes, and the LED turns red.

CRITICAL ALARM

SUMMARY 2

OUTPUT

3

1

REPEATER

+5V

0

+V J22
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Figure 8-8 Critical Alarm Summary Relay, Controlling an External LED

Figure 8-9 shows circuitry that connects all alarm summary relays to external lamps, through a 
flasher. This circuit provides an external indication of any internal alarm in the repeater.

CRITICAL ALARM

SUMMARY 2 4

OUTPUT

3 6

1 4

REPEATER

Red Green

+5V

0

Chassis Ground Terminal

+V J22
+V
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Figure 8-9 External, Flashing Alarm Lamps
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8.1.4 Digital Inputs

The repeater has two digital inputs, and one battery monitor input. 

You can use the two digital inputs to monitor equipment or events that are external to the 
repeater. You control and process these external alarms through the RepeaterNet software, in 
the same way you do for internal alarms (see Section 8.1.3, Alarm Relay Outputs, on page 1-8). 
You can set the severity of each external alarm input. 

Figure 8-10 shows the basic circuit for the external alarm inputs. The digital inputs are 
accessible through connector J1 on the repeater’s connector panel.

Figure 8-10 Digital Input Circuit – Typical

One of the most common external alarms, at a base station or a repeater site, is the failure of a 
tower hazard warning light. This light, used for warning aircraft of the existence of a tower, 
must be replaced immediately if it fails. Figure 8-11 and Figure 8-12 show two ways that the 
external digital alarm inputs can monitor a tower light.

4

Varistor

REPEATER

100 Ohm J1

(+)



8-12 Repeater Technologies, Inc.—Company Confidential Chapter 8. Connecting External Alarms

Figure 8-11 Monitoring a Tower Hazard Light – Configuration 1

Do not exceed the following specifications when connecting digital inputs:

Input Voltage for Logic 0 <0.5Volts

Input Voltage for Logic 1 (active alarm/disable PA) >4.0Volts

Maximum Input Voltage 5.0 Volts

Minimum Input Voltage 0.0 Volts

Maximum Input Current 2 mA

+5VDC (MAX)

5

Varistor

Lamp failure

alarm output

LAMP

CONTROL

REPEATER

CHASSIS GROUND

TERMINAL

115 - 220 VAC  47 - 63 Hz
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No alarm =  0VDC +0.25V
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Tower

Warning

Light

Converter/

adapter/

scaler
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Figure 8-12 Monitoring a Tower Hazard Light – Configuration 2

8.1.5 External DC Input Voltage

The repeater has one analog input, to monitor an external DC power source. The monitoring 
range is from 0 to 60volts, with a resolution of 250mV.
1. Connect an external DC power source to the repeater, using a single lead from the positive 

line/terminal of the battery to Connector J1, as shown in Figure 8-13.

2. Connect the negative lead of the battery to the repeater’s chassis-ground terminal. 

CAUTION: Do not allow any input to exceed the 60-Volt limit.
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Figure 8-13 Typical DC Monitoring Configuration

8.1.6 Power Amplifier (PA) External Disable Input

To disable the forward and reverse power amplifiers of the repeater, use terminal 6 (for forward 
PA) and pin 7 (for reverse PA) of connector J1. If these inputs are open, or are connected to a 
voltage of at least 5 VDC, the corresponding power amplifier is disabled. If you return these pins 
to ground, the “external disable” function, itself, becomes disabled. 

Figure 8-14 shows the Power Amplifier disable function.

Figure 8-14 External Power Amplifier Disable Function
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Chapter 9 Connecting the Power Source

9.0 Introduction

Power connects to the OA850C Primary Repeater, and to the OA850C Growth Cabinet, through 
the Entry Box of the Primary Cabinet.

Table 9-1 shows the specifications for the input power.

Table 9-1 Input Power Specifications

NOTE: The OA850C Repeater is available, from the factory, as either an AC-powered or DC-powered 
unit. Repeater Technologies does not supply any AC to DC, or DC to AC, field conversion 
options.

9.1 AC Power Wiring for Primary Cabinet

The following sub-sections describe how to connect AC power to the primary repeater cabinet.

See Chapter 6, Installing the Growth Cabinet, for instructions on how to connect AC power to 
the Second Channel or Growth Cabinet.

9.1.1 Inside Wiring

For installations that are located inside of a building (in a protected area), connect the AC input 
power to the Repeater. A standard 8-foot long North American NEMA 15-5 (three prong) AC line 
cord is included with the Repeater Accessory Kit. You can substitute a longer cord if needed. 
Figure 9-1 shows a typical installation.

WARNING: If the line cord is not connected, and plugged it into the repeater receptacle, EXACTLY 
as described and illustrated in this section, the repeater can be physically damaged, and 
anyone operating or servicing the repeater can be injured by electrical shock. 

Current Type Power Specification

Alternating Current 115 / 230 Volt AC Auto-ranging, 47 to 63 Hz
(Operating Range: 86 to 268 Volt AC)

1-Channel = 1.5 / 0.9 Amps, typical
2-Channel = 2.6 / 1.5 Amps, typical

Direct Current 24 Volt DC, -3 / + 6 Volts

1-Channel = 6.0 Amps, typical
2-Channel = 10.2 Amps, typical
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Figure 9-1 Typical 2-Channel Horizontal Wall Installation

1. Feed the power cord through the 1/2” plastic strain-relief.

The strain-relief is a water-tight plastic connector, provided to relieve strain on the AC 
power cord. This connector is included in the Repeater Accessory Kit. Figure 9-2 shows how 
to install the strain-relief.

Figure 9-2 Installing the Plastic Strain-Relief Conduit

2. Insert the strain-relief for the AC power cord, into the Entry Box of the main repeater 
cabinet, as shown in Figure 9-3.

• Insert the cord into the upper-left conduit opening, as shown in Figure 9-3 and 
Figure 9-4.

• Feed the stripped and tinned end of the line cord through the plastic strain-relief, so that 
approximately 6 inches of line cord is inside the Entry Box opening.

AC or DC
Interconnect

Conduit Assembly

Supply
Voltage
Conduit

RF and Alarm
Interconnect

Conduit
RT113901

Entry
Box

RT113907

To Entry Box To AC commercial
power plug
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Figure 9-3 Installing AC Power Cord and Strain Relief into Entry Box

Figure 9-4 Power Cord Installation

RT113906

Hand Tighten Only
Thread the power

cable through

AC Power Cord Entry

RT113903
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3. Slide the 1/2” Lock Nut for the conduit, onto the strain relief. Tighten it until it is snug, but 
still fits loosely. Refer to Figure 9-5.

Figure 9-5 Lock Nut Installation

4. Install the AC-In power plug, onto the power cord, as shown in Figure 9-6.

Use the small screwdriver to terminate the black (Hot) and white (Neutral or Common) 
stripped leads, on the AC line-cord plug.

Figure 9-6 AC-In Power Plug for Primary Cabinet

RT113902

1/2” conduit
Lock Nut installed

AC cable with 6”
service loop

Top Connector 
is not used

White (neutral or common
is in the middle

Black (Hot wire)
is at the bottom

Green (or Green-Yellow)—Spade terminal

RT113908
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5. Connect the green (ground) wire spade-terminal, to the ground lug.

6. Plug the AC-In power plug, into the J18 receptacle (see Figure 9-5, Figure 9-7, and
Figure 9-8).

NOTE: Plug the power cord into a dedicated wall outlet that is hard-wired to a circuit breaker. 
The circuit breaker must be 10 to 15 Amps for 115-Volt AC service, or 7.5 to 10 Amps for 
230-volt AC service, and MUST be dedicated exclusively to the repeater.

Figure 9-7 Location of J18

RT113905

J18 Connection
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Figure 9-8 Entry Box for OA850 Primary Cabinet

7. After connecting the repeater and closing the circuit-breaker, turn the repeater ON, using 
the Repeater Power Switch.

NOTE: RTI provides standard North American color-coded wires (white, black, and green). For 
international 230-Volt AC, 50-Hz applications, if local code requires the use an international 
color-coded line cord (blue, green, and green-yellow), and requires the use of a country-
specific power plug, you must obtain the wiring and plug locally. RTI does not provide 
international color-coded wiring or country-specific power plugs.

Table 9-2  lists the conversions from North American to international wiring color-codes.

Table 9-2 Power Cord Conversion

Wire Description North America International

AC (Hot) Black Brown

Neutral (Common) White Blue

Ground (Grd) Green Green-Yellow

Craft Port for Connecting a
Computer to the Repeater

Power
Switch

Green LED,
Power ONAC

Receptacle

Grounding Stud

Alarm LEDs

CRAFT

P1

GND GND

UPS IN/OUT

USER RELAY ALARM RELAY

J23 J22

AC IN
J18

AC OUT
J21

J2 J1

5
A
M
P

CKT BRK DO NOT EXCEED
5 AMPS

WILL REFLECT
REPEATER
INPUT VOLTAGE

OUTLET VOLTAGE
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9.1.2 Outside Wiring

If the repeater is outside, use the following procedure.
1. Install the repeater power, using 1/2” Liquidtight flexible conduit, and the appropriate 

Liquidtight conduit fittings.

2. Wire the repeater using #16 AWG (or larger) stranded PVC wire.

Number 16 Gauge wire complies with most local and national electrical codes, because the 
Repeater Power Switch is also a thermal-magnetic circuit breaker, which limits current to a 
maximum of 10 Amps.

NOTE: You can use larger-gauge wire, but it might be difficult to install the larger wire into the 
AC plug, provided with the repeater.

9.2 DC Power Wiring

You can connect 24-Volt nominal Direct Current power to the repeater, from either of the 
following DC power sources:
• A fixed 24-Volt DC Cell Site-type power system.

• A Repeater Technologies BUPS-25/80 Back-up Power System (RTI part number 250-1011-
01), or equivalent.

9.2.1 DC Supply From a Fixed Cell-Site Power Plant

If a fixed power plant provides DC power to the repeater, use the following procedure.
1. Connect the repeater to the DC power via a dedicated fuse or circuit-breaker.

• Use a 10-Amp fuse or circuit-breaker for a single-channel system.
• Use a 15- Amp fuse or circuit-breaker for a two-channel system.

2. To plan for growth, wire the Primary cabinet to support future addition of a Growth 
Cabinet.

To support this growth, use #10 AWG stranded wire for power cables under 20 feet long, or a 
larger wire gauge for runs of 20 feet or more. Consult your local or national electrical safety 
codes, for the appropriate wire sizing.

3. Use 1/2” flexible PVC conduit to bring the wire into the Repeater Entry Box, through the 
left-most 1/2” conduit knockout.

NOTE: You must provide the junction box, from which the DC cable leads into the repeater.

Figure 9-9 and Figure 9-10 show the typical DC Entry Box layout, and the recommended 
wiring.
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Figure 9-9 OA850C DC Entry Box, Front View, with Cover Removed

Figure 9-10 OA850C DC Entry Box, Front View, with Cover Removed

RT113904

DC INPUT
TERMINAL

POINTS

CRAFT

P1

GNDGND

UPS IN/OUT

J2 J1

J23 J22

USER RELAY ALARM RELAY

MAIN DC
INPUT

GROWTH
BOX

GROWTH

GND

MAIN

CRI T

MAJ

MIN

PWR
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9.2.2 Back-up Power Supply

A typical Back-up Power Supply (BUPS) consists of a charger/rectifier, and has 24-Volt batteries 
floated across the charger/rectifier output. The capacity of the BUPS should be sufficient to 
handle the addition of a Second Channel or Growth Cabinet.

Figure 9-11 shows a block diagram of the BUPS from Repeater Technologies, Inc. (RTI).
• The RTI BUPS-25/80 rectifier supplies 25 Amperes of continuous current, at 24 Volts DC. 

• The two internal 100 Amp-Hour batteries are sized to provide 80 Amp-Hours of service 
without AC power. 

• For a one-channel OA850C, the BUPS-25/80 provides approximately 13 hours of back-up, 
without AC power.

• For a two-channel system, the BUPS-25/80 provides approximately 8 hours of back-up.

For more details about the RTI BUPS, see the RTI BUPS-25/80 Operation Manual, Document 
Number 550-1011-01.

Figure 9-11 Simplified BUPS-25/80 Block Diagram, RTI P/N 250-1011-07

Position the BUPS, and the OA850C Network Repeater, with sufficient spacing for hardware 
access, and to allow the addition of a Growth Cabinet. Figure 9-12 shows the layout that RTI 
recommends.

24
Volts

RT116901

115/230
Volt AC

(switchable)

To
Repeater

Current
and

Voltage
Regulation

Circuit

Two
12-Volt

Batteries

Monitors and Alarm Circuitry with
Indicators and Relay Outputs Alarms

Rectifier/Charger

Circuit
BreakerCircuit

Breaker

Circuit
Breaker
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Figure 9-12 Recommended Mounting of Primary/Growth Cabinets, with BUPS-25/80

Figure 9-13 shows how to connect the BUPS-25/80 to the OA850C repeater. Figure 9-15 shows 
the dimensions of the RTI BUPS-25/80 unit.

NOTE: The RTI BUPS-25/80 Back-up Power Supply includes the 1/2” Liquidtight flexible steel 
conduit, the power and alarm wiring, and the necessary Liquidtight conduit fittings, to connect 
the repeater to the BUPS.

Hardware
Access
9.00

10.00

10.00
8.00

Suggested
Minimum
Distance

Suggested
Minimum
Distance

0.625

0.875

27.00

Minimum

Growth
Cabinet

Main
(Primary)
Cabinet

AC In
DC Power
and Alarms

BUPS-25/80
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Figure 9-13 Wiring Connections from OA850C/OA1900C Network Repeater to BUPS-25/80

You must locally obtain the AC input conduit and wiring for the BUPS. Make sure that the 
conduit and wire size comply with local electrical and safety codes. The following are typical 
BUPS-25/80 input Voltage and current specifications:

115 Volts AC @ 9 Amps
230 Volts AC @ 4.5 Amps

CAUTION: Before starting to wire the BUPS, verify that all input power and circuit breakers are in 
the OFF position, for both the OA850C repeater and the BUPS.

1- Digital Output 1
2 - Digital Output 2
3 - DC Voltage Input (Monitor)
4 - Digital Input 1
5 - Digital Input 2
6 - Forward PA Shutdown
7 - Reverse PA Shutdown

OA850C/OA1900C Network Repeater to BUPS-25/80 Wiring Kit

1 - External Tamper Alarm (Secondary Door Alarm)
2 - UPS Tamper Input (External Input Alarm)
3 - UPS AC Fail Input (External Input Alarm)
4 - UPS Low Battery Voltage Input (External Input Alarm)
5 - UPS High Battery Voltage Input (External Input Alarm)
6 - UPS Charger Fail Input (External Input Alarm)
7 - UPS Summary Normally Closed (External Input Alarm)
8 - UPS Summary Com (Protected Ground)

8 Ft. Belden 8743m 22 AWG Solid, 6 Twisted Pairs, PVC Insulation, 150V-
80 deg., Jacket cut back 4”, conductor ends stripped back 1/4”, Grd. Lug
and terminated in single yellow #10 spade terminal. (Part of RTI Part No.
187-0188-01, Power & Alarm Cable Assembly, included with the RTI 
BUPS-25/80 product).

8 Ft. Royal W0781, 10 AWG, Stranded, PVC Insulation, 300V -60 C, OA850 or OA1900 
ends stripped back 0.3” and tinned, BUPS ends stripped-back and terminated with #10 
Spade Term. (part of RTI P/N 187-0188-01, BUPS Power & Alarm Cable Assembly,
 included with the RTI BUPS-25/80 product).

6 1/2” Liquidtight Flex Conduit” 

HIGH
DC

VOLT
LOW
DC

VOLT
CHGR
FAIL
AC

Tie back leads if door 
alarm is not available, 

and disable Ext. 
Tamper Alarm in 

BLK

BLK

COM
OK

FAIL
COM
OK

FAIL

COM
OK

FAIL
COM
OK

FAIL
COM
OK

FAIL
COM
OK

FAIL
COM
OK

FAIL

BLK

BLK

BLK

BLK

RED

WHT

GRN

BLU

YEL

BRN

SUMM
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FAIL
GRD

FAIL
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LOAD
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INPUT

GRD
LUG

GRD
LUG
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INPUT

Two
Batteries

Chassis Ground and -24
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Door - future
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(IN/OUT)

OA850C/OA1900C NETWORK 
REPEATER TERMINAL BLOCKS
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CHARGER TERMINAL 

BLOCK

Legend:
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#10 AWG Spade Term.

#6 AWG Spade Term.
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J2 (UPS)

#10-12 AWG Pin Term.
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Circuit Breaker Sequence for Using the BUPS with an OA850 Repeater

1. Install the two 12-Volt “Gel Cell” batteries.

2. Use the wires provided with the BUPS, to connect the batteries to the BUPS Rectifier.

Figure 9-14 shows the front panel of the BUPS Charger-Rectifier.

3. Verify the battery voltage at the BUPS Rectifier terminal block, using a multi-meter.

The multi-meter should read approximately 25 to 27 Volts.

4. Close the BUPS AC Input Breaker.

5. Close the BUPS Charger Circuit Breaker.

6. Close the Battery Circuit Breaker.



Chapter 9. Connecting the Power Source Repeater Technologies, Inc.—Company Confidential 9-13

C
h

ap
ter 9

Figure 9-14 Front Panel of BUPS-25/80 Charger-Rectifier

7. Verify the voltage, using the BUPS Test Terminals.

The multi-meter should read approximately 27 Volts.

8. Close the OA850C Power Switch.

9. Observe the Repeater load (Amps), using the BUPS Load Test Terminals.
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Under normal conditions, the load should be approximately 6.0 Amps for a Primary 
Channel, and 10.2 Amps with a two-channel system (Primary and Growth Cabinets).

Figure 9-15 RTI BUPS-25/80 Dimensions

Table 9-3 provides the typical back-up time that a repeater can operate without AC. The worst-
case battery recharge time, as measured from the low-voltage (below 21 volts) cutoff-point of a 
rectifier, is 8 to 9 hours.

Overall Dimensions:  28.25 H x 16” W x 15.187” D

Product w/o batteries:  95 lb.

    (Includes Charger wt.:  23 lb.

Batteries (each):  72 lb.

Total Mounted Weight  240 lb.

Shipping Weight (Two containers):

    Container #1

          Cabinet & Charger - 150 lb.*

    Container #2

          Two Batteries - 145 lb.*

8.0”

16.0”

4.0”

25.5”

0.687
”

0.875”

Drip Shield
Screen

Fan Assembly

Batteries

Charger /
Rectifier

1.5”

1.25”
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Table 9-3 Back-up Power Support, Using RTI BUPS-25/80 Back-up Power System

NOTE: For solar-power applications, whenever the repeater is not handling any CDMA traffic (only 
pilot, paging, and sync channels), the repeater enters “Power-Save Mode,” reducing power 
consumption by 20%.

Additional Back-up Without AC Power

If the repeater requires longer electrical-power back-up time, contact the Customer Service 
Department at Repeater Technologies, for more information.

9.3 Grounding

Installing the input power to the repeater includes installing the standard electrical service 
grounds. However, you must also make sure that the OA850 Cabinet/Chassis is properly 
grounded to a “water pipe or earth ground.”

Each repeater cabinet (Primary/F1 and Growth/F2) includes two external grounding lugs: one 
on the repeater cabinet, and one on the Entry Box under the cabinet, as shown in Figure 9-16.

Typical RTI OA Repeater Backu-up Time, Without AC/Commercial Power

Repeater 
Configuration

RF Output 
Power

AC Input 
Power

DC Input 
Current

Back-
up Time

Back-up Power System

ACP @ 
Antenna Port

Watts @ 117 
volts AC

Amps @ 24 V Hours Model RTI Part #

OA850C, 1 channel 7 180 6 13.3 BUPS-25/80 250-1011-07

OA850C, 2 channels 14 310 10.2 7.8 BUPS-25/80 250-1011-07

OA1900C, 1 channel 6.3 205 7.5 10.6 BUPS-25/80 250-1011-07

OA1900C, 2 channels 12.6 350 12.8 6.3 BUPS-25/80 250-1011-07
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Figure 9-16 Location of Ground Lug on Primary Cabinet

1. Connect number 6 (or larger) gauge AWG solid wire, to each ground lug.

2. Carefully dress the wire along cabinet, and the mounting surface, to the Repeater 
Grounding System or the Ground Rod.

NOTE: When dressing the grounding wire, and forming it around corners, avoid making sharp 
bends in the wire. Use a generous radius for each wire bend.

For more information about grounding repeaters, consult the RTI Application Note titled 
Installation Standards for Ground Requirements, Document Number 650-0002-01, Rev. 2.

9.3.1 Grounding the BUPS-25/80

Ground the Back-up Power Supply (BUPS) in a manner similar to a repeater cabinet. However, 
you must also add an external chassis ground lug to the BUPS-25/80, at the same time that you 
install the electrical service.

Ground
Lug

RT117901
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Chapter 10 Configuring the Repeater

10.0 RepeaterNet Craft Software

The RepeaterNet Craft software (Craft) provides configuration management and alarm 
monitoring capabilities for individual repeaters from Repeater Technologies, Inc. (RTI). It also 
dynamically manages repeater maintenance sessions in real time, through one of these 
connections:
• A laptop computer with a direct connection to the repeaters—a technician can visit 

repeater sites and connect to the repeaters directly, using the serial port on the laptop.

• A laptop or desktop computer with a modem connection to the repeater— a technician can 
use the modem to connect to the repeaters, without visiting the physical repeater sites.

The Craft software can operate under either Windows 95 or WindowsNT. The Craft user 
interface varies, depending on the model of repeater that the software is configuring or 
monitoring. 

10.1 Minimum System Requirements

Craft system requirements include:
• Pentium 120 MHz, running Windows 95, with 32 MB of memory.

• If you are using the Craft system with Windows 95, you must use the Microsoft Service Pack 
1 Update (Version 4.00.950 A) or later releases. 

• If you are using the Craft system with Windows NT, you must use the Microsoft Service 
Pack 3 Update.

• Approximately 10 MB of free disk space.

• Modem (if a modem connects the laptop to the repeater).

NOTE: Use “Hayes-compatible” modems only. RTI repeaters are “Connect with Rockwell” certified, 
for modems of 56K and above. US Robotics modems are not supported.

If the PC or laptop uses a fax program, such as Microsoft Fax, make sure that the Auto Answer 
feature is disabled. See Appendix B, Troubleshooting (Problem 7) for how to disable Auto 
Answer for Microsoft Fax.

10.2 Installation Procedure

The RepeaterNet Craft software is distributed on 4 High Density (HD) floppy disks. To install 
this software, use the following procedure.
1. Insert Disk 1  into the a: drive.

2. From the Windows Start menu, select Run.

3. Type a:\setup and click on the OK button.

4. Follow the online instructions, to install the Craft software.
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The Craft software includes default configuration files, which you can download to the repeater. 
You can download the appropriate file for the repeater type, and for the number of channels, 
instead of manually configuring the repeater’s properties. 

10.3 Configuring the Repeater Connection

You must use the RepeaterNet Craft Admin  program, to configure the connection to the 
repeater, before you can access the RepeaterNet Craft software. 

Follow the path in Figure 10-1, to invoke the RepeaterNet Administrator from the Start menu. 

Figure 10-1 Starting the RepeaterNet Administrator

When you invoke the Administrator, RepeaterNet displays the window shown in Figure 10-2.

You can save both Direct and Dial-Out 
(Modem) configurations, but you must 
assign a unique COM Port Number to 
each. Also, you can check Use this 
connection for only one of the 
configurations. The RepeaterNet Craft 
software uses the selected connection, to 
connect to the repeater.

For example, you might do the following:
1. Assign the connection type as Direct 

through COM Port 1. 

2. Check the Use this connection  box, 
to make this the default 
configuration. 

3. Click on the Save button.

Next, you can save a Modem configuration to another COM port, such as COM Port 2:
1. Assign a COM Port Number that is different from the COM Port Number used for the 

Direct connection.

2. Click on the Save button.

3. Click on OK to exit RepeaterNet Admin.

Figure 10-2 RepeaterNet Admin 
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10.4 Starting Craft

Double-click on the Craft icon. 

The window in Figure 10-3 (at right) displays.

RepeaterNet connects to the repeater, and 
displays the Craft Main Control screen for the 
repeater, as shown in Figure 10-3.

10.5 Repeater Craft Main Control 
Screen

The Craft Main Control screen provides access to 
all monitor and control functions of the Network 
Repeater (NR).

Main Control screen icons (shown in 
Figure 10-4) provide access to both subsystem 
status screens, and report alarms.

Figure 10-4 Repeater Craft Main Control Screen

Figure 10-3 RepeaterNet Craft Window

Forward
Front End

Channel 1
Forward Channel

Select Filter

Channel 2
Forward Channel

Select Filter

Channel 1
Reverse Power

Amplifier

Channel 2
Reverse Power

Amplifier

Alarm Control Unit

Modem Cell Phone Power Supply (AC) Back-up Power Supply (BUPS)

Channel 1
Forward Power
Amplifier

Channel 2
Forward Power
Amplifier

Channel 1
Reverse Channel
Select Filter

Channel 2
Reverse Channel
Select Filter

Reverse Front End

Diversity Front End

Connector Indicator
(green=connected,
red=not connected)
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Figure 10-5 RepeaterNet Craft Pull-down Menus

NOTE:

• All RTI repeaters are shipped with the PAs (Power Amplifiers) turned OFF. In this condition, 
the PA OFF indicator (a circle with a slash through it) displays over each PA subsystem icon 
(FPA and RPA) in the Repeater Craft Main Control Screen (not shown in Figure 10-4). Keep 
each repeater’s PA turned OFF, until you have adjusted the gain for that repeater.

• The appearance of the Main Control screen might vary from that shown in Figure 10-4, 
depending on the hardware configuration of the repeater unit. For example, Channel 2 icons 
are grayed-out (unavailable) for a single-channel repeater.

File Configuration System

Options Help
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10.5.1 Subsystem Configuration

To configure the repeater, select the subsystem Properties screens, from the Craft 
Configuration  menu.

Table 10-1 lists the choices in the Configuration menu.

Table 10-1 Configuration Menu

Menu Selection Description See Section

Hardware Setting To configure the repeater for adding 
a growth cabinet, a mode, or a cell 
phone.

Section 10.9, Hardware Settings, on 
page 1-8

Front End Configures Forward, Reverse, and 
Diversity front end.

Section 10.10, Front End Properties, on 
page 1-9.

Channel 1 Configures repeater channel 1. 
Available on all units.

Section 10.11, Channel Properties, on 
page 1-10.

Channel 2 Configures repeater channel 2. 
Available on 2-channel units only.

Section 10.11, Channel Properties, on 
page 1-10.

Alarm Control Unit Configures ACU. Section 10.12, ACU Properties, on page 
1-16.

Modem Configures internal or external 
modem.

Section 10.13, Modem Properties, on 
page 1-19

Cellular Phone Configures internal cell phone, if 
the repeater has the Cellular option.

Section 10.14, Cell Phone Properties, on 
page 1-23.

Power System Configures input, battery, and 
internal power.

Section 10.15, Power System Properties, 
on page 1-24.

Uninterruptable 
Power Supply (UPS)

Configures Back-up Power System 
(BUPS).

Section 10.16, Backup Power System 
(UPS) Properties, on page 1-26.

Hardware Setting Configures Growth Box Modem Cell 
Phone
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10.6 Status Reporting

After configuring the repeater, you can use the subsystem Status screens to monitor and control 
repeater system functions. For example, when a repeater alarm triggers, the appropriate 
subsystem icon for the type of alarm changes appearance, and starts blinking. An audible alarm 
also activates.
1. Click on the subsystem icon for the type of alarm that triggered.

The appropriate status screen opens. The icon stops blinking, and the audible alarm stops. 
This acknowledges that you are aware of the alarm condition. However, the icon remains 
changed to its alarm configuration.

2. Fix the problem that triggered the alarm.

After you clear the alarm condition, the display of the icon reverts to normal.

The display of the Forward PA and Reverse PA icons indicate the operational status of the Power 
Amplifiers. If a PA is OFF, a circle with a slash displays over the associated icon.

If a subsystem is not available to the repeater, RepeaterNet displays that subsystem as 
disabled. For example, if a repeater has no cellular phone, the cellular icon is light gray.

10.6.1 Alarm Status Reporting on the Main Control Screen

RepeaterNet uses a color system to report subsystem alarm status on the Main Control screen. 
Table 10-2 shows the meanings of the colors, and of any corresponding color-independent icons.

Table 10-2 Alarm Icons

When an alarm is triggered, the icon color of the affected subsystem changes, from green 
(normal), to the color of the alarm definition, and the icon blinks.

RepeaterNet also offers two optional alarm features:
• The Color Independent Icons feature is provided for operators who are unable to 

distinguish colors.

• The Alarm Sounds feature adds an audible alarm. 

If an individual subsystem triggers more than one alarm, the Main Control screen reports the 
higher-severity alarm, in both the color and color-independent icons. 

Subsystem Alarm Status Icon Color Color Independent Icon Action

Normal—No Alarm Green N/A N/A

Critical Alarm Red X through icon Call Out

Major Alarm Yellow Back slash through icon Call Out

Minor Alarm Blue Dotted line slash through icon Call Out

Event White None None

Disabled Dark Gray* N/A None

System Not Available Light Gray N/A` N/A

* If all alarms in a subsystem are disabled or set to event severity, the icon color is dark gray.
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For example, if both a major and a minor Reverse PA alarm trigger, a yellow subsystem icon is 
reported. If you clear the major alarm while the minor alarm remains active, a blue subsystem 
icon is reported.

NOTE: When a subsystem alarm triggers, click the icon (to open the status screen. This action 
terminates the icon blinking feature, and silences the audible alarm. However, icon color 
continues to report, and a color-independent icon (if applicable) continues to display, until you 
clear the condition that triggered the alarm.

Color reporting does not apply to subsystems that are set to Event severity.

10.7 Defining Alarm Severity

The repeater is factory-configured with a standard set of alarm severity settings. You can use 
the subsystem Properties  screens to adjust alarm severity, from these defaults. See Section 
10.8, Configuring Repeater Properties, on page 1-8, for more information about alarm severity 
and the factory configuration.

The levels of alarm severity are:
• Critical.

• Major.

• Minor.

• Event.

• Disabled.

To define alarm severity, use the following procedure.
1. Login to a session with the repeater.

2. Select Configuration from the Main Control menu bar, then select a subsystem, to open its 
Properties screen. 

For example, select Configuration -> Channel 1. The Alarms tab displays.

For actual screen examples, see Section 10.8, Configuring Repeater Properties, on page 1-8.

3. Click the down-arrow next to an Alarm  field, to select a new alarm severity.

4. Click the Apply  or OK button to change the alarm severity.

The Apply button changes the alarm severity, and keeps the Channel Properties screen 
open.

The OK button changes the alarm severity, and closes the Channel Properties screen.
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10.8 Configuring Repeater Properties

Use the subsystem Properties screens to configure the repeater. 

To open a Properties screen, select one of the following subsystems from the Configuration 
menu:
• Front End.

• Channel 1.

• Channel 2.

• Alarm Control Unit.

• Modem.

• Cellular Phone.

• Power System.

• UPS.

• Hardware Settings

The Properties screens display tabs that are specific to each subsystem. 

NOTE: Screens shown in this manual might not exactly match what you see on the PC or laptop. 

You can configure two types of repeater properties:
• Redefine alarm severity.

• Specify operational settings for the repeater.

NOTE: Some subsystem Properties screens include tabs for redefining alarm severity, and for 
specifying operational settings. Others have a single tab, for redefining alarm severity.

10.9 Hardware Settings

Use the Configure->Hardware Setting  screen (see 
Figure 10-6) to inform RepeaterNet, when you add 
one or more of the following to the repeater 
configuration:
• Growth Box.

• Modem.

• Cellular Phone.

Figure 10-6 Hardware Setting Screen
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10.10 Front End Properties

The Front End Properties screen configures the Front End subsystems. This screen includes 
tabs that set the alarm severity for:
• Forward FE.

• Reverse FE.

• Diversity FE.

NOTE: Do not adjust power 
amplifier gain while any of 
these alarms are active.

10.10.1 Forward FE Tab

This tab (see Figure 10-7) sets 
the alarm severity of the 
Forward FE alarm. 

The Forward FE alarm  
becomes activate when the 
forward signal power level is too 
strong, and is being attenuated 
to protect the repeater from 
possible damage.

10.10.2 Reverse FE Tab

The Reverse FE tab (see 
Figure 10-8) sets the alarm 
severity of the Reverse FE alarm.

The Reverse FE alarm becomes 
activate when the reverse signal 
power level is too strong, and is 
being attenuated to protect the 
repeater from possible damage.

Figure 10-7 Front End Properties Screen, Forward FE Tab

Figure 10-8 Front End Properties Screen, Reverse FE Tab
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10.10.3 Diversity FE Tab

The Diversity FE tab (see 
Figure 10-9) sets the alarm 
severity of the Diversity FE.

The Diversity FE alarm 
becomes activate when the 
Diversity Receive signal power 
level is too strong, and is being 
attenuated to protect the 
repeater from possible damage.

NOTE: Do not adjust power 
amplifier gain while this 
alarm is active.

10.11 Channel Properties 

From the Main Control screen menu bar, select Channel 1 or Channel 2 (for two-channel 
repeater units only), to open a Channel Properties screen. Channel properties include:
• Reverse PA.

• Forward PA.

• PA Control.

• Reverse Filter.

• Forward Filter.

• Channel #.

• Gain

Figure 10-9 Front End Properties Screen, Diversity FE Tab
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10.11.1 Channel Reverse PA Tab

The Reverse PA tab sets the alarm 
severity for the following types of 
Reverse Power Amplifier alarms 
(see Figure 10-10):

Reverse PA Alarm

Indicates a failure in the power 
amplifier. The PA is inoperative, 
and the repeater is off the air.

Reverse PA Thermal Alarm

Indicates that the system 
temperature has exceeded the 
alarm threshold. The repeater has 
shut down the Power Amplifier. 
When the temperature is again 
within subsystem tolerances, the 
repeater automatically reactivates 
the PA.

Reverse PA External Shutdown Alarm

Indicates that the repeater has shut down the Power Amplifier, and has activated one RPA 
(Reverse Power Amplifier) alarm. RTI recommends disabling this alarm.

To redefine alarm severity for the Reverse PA subsystem, using this tab:
1. Click the down-arrow next to an Alarm  field, to select a new alarm severity.

2. Click the Apply  or OK button, to change the alarm severity.

• The Apply button changes the alarm severity, and keeps the Channel Properties 
screen open.

• The OK button changes the alarm severity, and closes the Channel Properties screen.

Figure 10-10 Channel Properties 
Screen, Reverse PA Tab



10-12 Repeater Technologies, Inc.—Company Confidential Chapter 10. Configuring the Repeater

10.11.2 Channel Forward PA Tab

The Forward PA tab (see 
Figure 10-11) sets the alarm 
severity for the following 
types of Forward PA alarms:

Forward PA Alarm

Indicates a failure in the 
power amplifier. The PA is 
inoperative, and the repeater 
is off the air.

Forward PA Thermal Alarm

Indicates that the system 
temperature has exceeded 
the alarm threshold. The 
repeater has shut down the 
Power Amplifier. When the 
temperature is again within 
subsystem tolerances, the 
repeater automatically 
reactivates the PA.

Forward PA External Shut-
down Alarm

Indicates that the repeater has shut down the Power Amplifier, and has activated one FPA 
(Forward Power Amplifier) alarm. RTI recommends disabling this alarm.

To redefine alarm severity for the Forward PA subsystem:
1. Click the down-arrow next to an Alarm  field, to select a new alarm severity.

2. Click the Apply  or OK button, to change the alarm severity.

• The Apply button changes the alarm severity, and keeps the Channel Properties 
screen open.

• The OK button changes the alarm severity, and closes the Channel Properties screen.

Figure 10-11 Channel Properties Screen, 
Forward PA Tab
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10.11.3 Channel PA Control Tab

The PA Control tab provides a 
switch to turn PA power ON or 
OFF (see Figure 10-12). 
1. Click on the value in the 

Reverse PA Power box, and 
in the Forward PA Power 
box, to change the value. 

The icon toggles between ON 
and OFF.

2. Click on the Apply or OK 
button, for the setting to take 
effect.

• The Apply button 
changes the PA value, and 
keeps the Channel 
Properties screen open.

• The OK button changes 
the PA value, and closes 
the Channel Properties 
screen.

10.11.4 Channel Reverse Filter Tab

The Channel Reverse Filter  tab sets the alarm severity for the Channel Reverse Alarm. A 
failure in the Reverse Filter assembly triggers a CSF Reverse Filter alarm, and the filter 
becomes inoperative.

To redefine alarm severity for the Reverse Filter  subsystem: 
1. Click the down-arrow next to an Alarm  field, to select one of the following alarm severity 

settings:

• Disabled.
• Event.
• Minor.
• Major.
• Critical.

2. Click the Apply  or OK button.

The Apply button changes the alarm severity setting, and keeps the Channel Properties 
screen open.

The OK button changes the alarm severity setting, and closes the Channel Properties  
screen.

NOTE: The Channel Reverse Filter tab is similar to the Channel Forward Filter tab, shown in 
Figure 10-13.

Figure 10-12 Channel Properties Screen, 
Channel PA Tab
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10.11.5 Channel Forward Filter Tab

The Channel Forward Filter 
tab (see Figure 10-13) sets the 
alarm severity for the Channel 
Forward Alarm. A failure in the 
Forward Filter assembly triggers 
a CSF Forward Filter alarm, 
and the filter becomes 
inoperative.

To redefine alarm severity for the 
Forward Filter subsystem:
1. Click the down-arrow next to 

an Alarm field, to select 
one of the following alarm 
severity settings:

• Disabled.
• Event.
• Minor.
• Major.
• Critical.

2. Click the Apply or OK button.

• The Apply button changes the alarm severity setting, and keeps the Channel 
Properties screen open.

• The OK button changes the alarm severity setting, and closes the Channel Properties 
screen.

10.11.6 Channel # Tab

The Channel # tab (see 
Figure 10-14) sets the operating 
channel (or band), for either 
Channel 1 or Channel 2. 

After you select a channel, the 
Channel Properties screen 
displays the corresponding 
frequencies. 

NOTE: Consult your network 
administrator, or the system 
Site Plan, for the proper 
channel or band setting.

Figure 10-13 Channel Properties Screen, 
Channel Forward Filter Tab

Figure 10-14 Channel Properties Screen, 
Channel # Tab
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10.11.7 Channel Gain Tab

The RepeaterNet software detects 
the configuration of the repeater, 
and displays the applicable gain 
range on the Gain tab (see Figure 
10-15). You can adjust Forward and 
Reverse gain for the selected 
channel. 

The adjustable gain range depends 
on the type of repeater, and the 
power level of the repeater’s power 
amplifiers. RepeaterNet limits 
your choice of gain adjustments, to 
selections that are valid for the 
specific repeater type and power 
level.

NOTE: Carefully balance the gain in 
any repeater application, to 
ensure proper hand-off and 
system operation.

To adjust Forward PA or Reverse PA gain:
1. Select Configuration->Channel 1 or Configuration->Channel 2 , to open the Channel 

Properties screen.

2. Click the Gain tab (see Figure 10-15).

3. Press, hold, and drag the mouse across the horizontal sliders, to define forward and reverse 
gain.

NOTE: Gain adjusts in 2 dB increments. 

The gain value box (centered under each slider) displays the selected gain.

4. Click the Apply  or OK button.

• The Apply button changes the gain setting, and keeps the Channel Properties screen 
open.

• The OK button changes the gain setting, and closes the Channel Properties screen.

Figure 10-15 Channel Properties Screen, 
Channel Gain Tab
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10.12 ACU Properties

The Alarm Control Unit (ACU) subsystem provides alarm and control functions for the repeater. 
The ACU monitors all repeater subsystems, and reports the status of a subsystem, either to a 
directly-connected device, or to remote devices (through a dial-up modem connection). 

In addition to monitoring the repeater system, the ACU contains a number of external inputs 
and outputs, for monitoring and controlling external devices.

To monitor and control a repeater’s alarms:
1. Select Alarm Control Unit from the Configuration  menu, in the Main Control screen.

The Alarm Control Unit Properties screen opens. 

2. Select one of the following ACU tabs:

• I/O Descriptions.
• I/O Control, Alarms.
• DC Voltage Alarm Threshold.

10.12.1 ACU I/O Descriptions Tab

RepeaterNet can monitor two digital 
alarm inputs, and one DC voltage input, 
from external devices. Up to four 
external devices (two relay outputs and 
two digital outputs) can also be active.

Use the I/O Descriptions tab (see 
Figure 10-16) in the Alarm Control 
Unit Properties screen, to identify 
external equipment that is connected to 
the repeater’s inputs and outputs.

External equipment could be a security 
light, or any other site equipment.

NOTE: For information about connecting 
inputs and outputs to a repeater, see 
Chapter 8, Connecting External 
Alarms.

To add I/O descriptions for the Alarm Control Unit, use the following procedure.
1. Select Configuration->Alarm Control Unit. 

The ACU Properties screen opens (see Figure 10-16). The I/O Descriptions tab is active.

2. Provide I/O Descriptions in the screen’s data fields.

Enter names for any or all of the following types of repeater inputs and outputs:

• Two different relay outputs.
• Two different digital outputs.
• One DC input.
• Two different digital inputs.

Figure 10-16 ACU Properties Screen, 
I/O Descriptions Tab
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3. Click the Apply  or OK button.

• The Apply button adds the repeater input or output, and keeps the ACU Properties 
screen open.

• The OK button adds the repeater input or output, and closes the ACU Properties 
screen.

10.12.2 ACU I/O Controls Tab

The I/O Controls tab (see Figure 10-17) 
turns the 2 relay outputs and digital 
outputs ON or OFF.
1. Toggle the appropriate output either 

ON or OFF.

2. Click the Apply  or OK button.

• The Apply button turns the 
selected outputs either ON or 
OFF, and keeps the ACU 
Properties screen open.

• The OK button turns the 
selected outputs either ON or 
OFF, and closes the ACU 
Properties screen.

10.12.3 ACU Alarms Setting Tab

The Alarms tab (see Figure 10-18) 
redefines alarm severity for ACU 
subsystems.
1. Click the down-arrow next to an 

Alarm field, to select one of the 
following alarm severity settings:

• Disabled.
• Event.
• Minor.
• Major.
• Critical.

NOTE: Alarm settings for External Input 
1 and External Input 2 are 
initially set to Disabled.

2. Click the Apply  or OK button.

• The Apply button changes the alarm severity, and keeps the ACU Properties screen 
open.

• The OK button changes the alarm severity, and closes the ACU Properties screen.

Figure 10-17 ACU Properties Screen, 
I/O Controls Tab

Figure 10-18 ACU Properties Screen, Alarms Tab
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You can set the following types of alarms:
• External Input Alarms (1 and 2) : An alarm generated from optional, external equipment.

• Temperature Alarm : The temperature threshold of the repeater system has been exceeded.

• Tamper Alarm: The repeater door is open.

• Analog Input Alarm: The upper or lower voltage limits have been exceeded, from the DC 
voltage source for the analog input.

• External Growth Alarm: The physical growth box connection to the primary box is detached, 
disconnected, or broken.

• Growth Temperature Alarm: The temperature threshold of the growth box system has been 
exceeded.

• Growth Tamper Alarm: The growth box door is open.

10.12.4 ACU DC Voltage Alarm 
Threshold Tab

RepeaterNet can monitor 
an external DC voltage 
power source (a battery) in 
a range of 0 to 60 volts, in 
250 mV increments. In 
addition to monitoring the 
voltage level, you can define 
upper and lower limits for 
the voltage. Exceeding 
these limits, activates the 
DC Voltage alarm in the 
ACU subsystem.

Use the Ext. DC Voltage 
tab to monitor the voltage of 
a user-supplied DC power 
source, used to power 
external site equipment. An 
alarm triggers if the voltage 
fluctuates, outside of a 
defined operating range.

To define an operating range for DC voltage:
1. Select Configuration->Alarm Control Unit.

The ACU Properties screen opens.

2. Click the Ext. DC Voltage tab (see Figure 10-19).

3. Define (type in or arrow-click) the normal operating range for the DC power source, in the 
Less Than and Greater Than data fields.

4. Click the Apply  or OK button.

• The Apply button turns the selected outputs either ON or OFF, and keeps the ACU 
Properties screen open.

• The OK button turns the selected outputs either ON or OFF, and closes the ACU 
Properties screen.

Figure 10-19 ACU Properties Screen, External DC Voltage Tab
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10.13 Modem Properties

From the menu bar in the Main 
Control screen, select 
Configuration->Modem. 

The Modem Properties screen 
opens (see Figure 10-20). This 
screen has three tabs:

Alarm Setting Tab

Sets the alarm severity for the 
Modem alarm. This alarm indicates 
a failure of the internal modem.

Modem Properties Tab

Defines the port settings for the 
internal or external modem.

Pager Setting Tab

Configures a pager, which is notified 
when an alarm (of a specified 
severity level) occurs.

10.13.1 Alarm Setting Tab

Use the Alarms tab to redefine alarm 
severity for the repeater’s modem (see 
Figure 10-21). Internal modem 
component failure triggers a Modem 
alarm .
1. Click the down-arrow next to an 

Alarm field, to select one of the 
following alarm severity settings:

• Disabled.
• Event.
• Minor.
• Major.
• Critical.

2. Click the Apply  or OK button.

• The Apply button changes the 
alarm severity, and keeps the 
Modem Properties screen 
open.

• The OK button changes the 
alarm severity, and closes the 
Modem Properties screen.

Figure 10-20 Modem Properties Screen

Figure 10-21 Modem Properties Screen, 
Alarms Tab
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10.13.2 Modem Properties Tab

To define modem settings for the 
repeater’s modem, use the Modem 
Properties tab (see Figure 10-22).

NOTE: The RepeaterNet Craft software 
uses the values for Setup String, 
Phone Number, and Call 
Attempts , ONLY IF you are 
using the RepeaterNet Network 
Management System, or other 
network management software. If 
you do not have NMS, skip to 
Section 10.13.3, Pager 
Setting Tab, on page 1-22 .

To define modem properties, use the 
following procedure.
1. Select Modem from the 

Configuration  menu, in the 
Main Control screen.

The Modem Properties screen 
opens (see Figure 10-22).

2. Click the Modem Properties tab.

If you are using RepeaterNet NMS, or another network management system, define the 
Setup String , Phone Number, and Call Attempts.

• Setup String  configures a modem. The modem setup string is S37=6.
• The Phone Number is the phone number of a remote computer that the repeater calls. 
• Call Attempts is the number of callouts to attempt before disconnecting; a value of zero 

(0) disables calling.
3. Set the Baud Rate  for the modem.

The Baud Rate  is the communication speed between the modem and the cell phone. This 
speed must be greater than 2400. The modem automatically adjusts the Baud Rate 
downward, when necessary.

4. Set the Parity to None. 

5. Set Data Bits to 8.

NOTE: Set the Parity and Data Bits the same on both the repeater’s and the computer’s modem.

6. Set the Dial Type to Tone.

7. Click the Apply  or OK button.

• The Apply  button sets the modem properties, and keeps the Modem Properties screen 
open.

• The OK button sets the modem properties, and closes the Modem Properties  screen.

Figure 10-22 Modem Properties Screen, 
Modem Properties Tab
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Setting Up A Modem for Over-the-Air Repeaters

If you connected an external wireless interface (such as the Telular) to an OA (Over-the-Air) 
repeater from Repeater Technologies, Inc. (RTI), then you must properly configure the repeater’s 
modem. If you improperly set up the modem, calls to the OA repeater will not be successful.

Use the following procedure to set up the modem for all Repeater Technologies OA products.
1. Connect to the repeater through the local Craft port.

2. Start the RepeaterNet software.

3. Establish a connection to the repeater.

4. Select Configuration from the menu bar, located at the top of the screen.

5. From the Configuration menu, select Modem Properties .

6. Click on the Modem Properties tab.

7. Enter S37=6 in the Setup String field (the top field on the Modem tab).

8. Enter a Phone Number.

For example, enter:

9, 222 123-4567

NOTE: Each comma creates a two-second delay in dialing. The RepeaterNet software ignores 
parentheses () and spaces.

9. Enter the number of times that RepeaterNet should attempt to make the connection.

For example, enter:

3

NOTE: Entering 0 (zero) in this field disables calling.

10. Click the Apply  or OK button at the bottom of the window.

• The Apply  button sets the modem properties, and keeps the Modem Properties screen 
open.

• The OK button sets the modem properties, and closes the Modem Properties  screen.

Important Points About Modem Setup

• This procedure forces the repeater to initialize the modem to 2400 baud, which improves the 
connection on analog wireless networks.

• If you configure a repeater to automatically call out and report alarm status, the repeater 
COM port settings must match the settings of the modem that the repeater calls.

• If you use a modem to login to the repeater, the port settings of the computer’s modem 
(defined in the configuration file) must match the settings of the repeater modem. 

• If the repeater is equipped with an internal modem, the repeater’s hardware automatically 
controls the setup string. However, if the repeater is connected to an external modem, you 
must consult the modem’s documentation for the setup string.

• Changes to the default settings on the Modem Properties screen, take effect when you exit 
the RepeaterNet software.
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10.13.3 Pager Setting Tab

The Pager Setting tab sets the RepeaterNet software, so that it sends out a page when an 
alarm occurs. It also assigns a specified severity level to the alarm. Table 10-3 describes the 
Alarm Severity settings.

RepeaterNet generates a page if the summary alarm severity is greater than or equal to the 
selected Minimum Severity setting. When RepeaterNet detects a page request, the repeater 
terminates any current modem connection, and generates a page. The page format consists of 
the repeater number, followed by the severity level. For example:

123456-2

where 123456 is the repeater number, and 2 is the severity level of the alarm.

If RepeaterNet detects a change in the current alarm severity, it does the following:
• If you set the Minimum Severity to Major, the RepeaterNet software generates a page 

with a severity of 2.

• If the RepeaterNet software detects a Critical alarm, it generates a new page with a 
severity of 3.

• If you clear the Major alarm, but the Critical alarm remains, the RepeaterNet software 
generates a new page with a severity of 1, indicating that the Critical alarm remains. 

• If you then clear the Critical alarm, the RepeaterNet software generates a page with a 
severity of 0.

• If the RepeaterNet software detects a Minor or Event alarm, it does not generate a page.

Table 10-3 Alarm Severity Numbers 

Use the following procedure to set a pager.
1. Click on the Pager Setting tab of the Modem Properties screen.

2. Enter the Pager Number.

The Pager Number is the phone number to call. This phone number must include the 
networking access number (9), 1, and the area code (if needed). Access the network dial 
number, and wait five seconds before sending the page sequence. 

Alarm Type Severity Number

No Alarms 0

Critical Alarm 1

Major Alarm 2

Critical + Major 3

Minor Alarm 4

Critical + Minor 5

Major + Minor 6

Critical + Major + Minor 7
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Several commas must follow the phone number. Each comma generates a delay of one 
second. Generally, a pager company requires about three seconds to pick up the line, and 
allows a maximum of five seconds before they drop the connection. 

Therefore, a good delay setting is five seconds—that is, add five commas. For example:

9 1 408 555-1212,,,,, 

NOTE: RepeaterNet ignores any characters used for clarity, such as spaces, dashes, and 
parentheses.

3. Enter the number of times RepeaterNet should attempt to call the pager number (Call 
Attempts).

NOTE: A value of 0 in this field disables paging.

4. Enter the number of the repeater (Repeater Number). 

This is a system identification number or description.

5. Select one of the following minimum alarm severity settings for paging:

• Critical.
• Major.
•  Minor.

6. Click the Apply  or OK button.

• The Apply button sets the pager properties, and keeps the Pager Properties screen 
open.

• The OK button sets the pager properties, and closes the Pager Properties screen.

10.14 Cell Phone Properties

1. From the Configuration 
menu in the Main Control 
screen, select Cellular Phone. 

The Cell Phone Properties 
screen opens (see Figure 10-23).

NOTE: If the repeater does not 
have a cell phone, the 
Cellular Phone Properties 
selection is disabled.

2. Use the Alarms Setting tab to 
set the alarm severity for the 
Cellular Alarm. 

The Cell Phone alarm 
indicates a failure of a cellular 
phone.

Figure 10-23 Cellular Phone Properties Screen
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3. Click the down-arrow next to an Alarm  field, to select one of the following alarm severity 
settings:

• Disabled.
• Event.
• Minor.
• Major.
• Critical.

NOTE: The cellular phone alarm severity should normally be set to minor. The Cell Phone alarm 
generates if the cell phone fails to report an alarm, after all retry attempts by either the 
modem or the pager. This alarm clears when the cell phone succeeds in reporting an 
alarm.

4. Click the Apply  or OK button.

• The Apply button changes the alarm severity setting, and keeps the Cellular Phone 
Properties screen open.

• The OK button changes the alarm severity setting, and closes the Cellular Phone 
Properties screen.

10.15 Power System Properties

1. From the Configuration 
menu in the Main Control 
screen, select Power System . 

The Power System 
Properties screen opens (see 
Figure 10-24). This screen 
provides access to initial 
configuration settings for the 
power subsystem. 

2. Use the Alarms Setting tab 
to redefine alarm severity for 
the power systems.

The Alarm Setting tab sets 
the alarm severity for the 
following alarms:

Input Power Alarm

The input power to the 
repeater is out of system 
tolerances.

Power Supply Alarm

The internal system power of the repeater is out of tolerances.

Figure 10-24 Power System Properties Screen
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PS Battery Alarm

The voltage of the internal battery is below tolerances. This battery supplies power to the 
Alarm Control Unit (ACU), modem, and cell phone, in the event of a system power failure. 
This internal battery lets the repeater call out and report its status. It also supplies power to 
the memory that stores the Alarm and Event Log .

NOTE: The internal battery does not provide power for RF components. The repeater cannot 
provide RF coverage during a power failure.

Growth Box Input Power Alarm

The input power to the growth box is out of system tolerances.

Growth Box Power Supply Alarm

The internal system power of the growth box is out of tolerances.

3. Click the down-arrow next to an Alarm  field, to select one of the following alarm severity 
settings:

• Disabled.
• Event.
• Minor.
• Major.
• Critical.

4. Click the Apply  or OK button.

• The Apply button changes the alarm severity setting, and keeps the Power System 
Properties screen open.

• The OK button changes the alarm severity setting, and closes the Power System 
Properties screen.
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10.16 Backup Power System 
(UPS) Properties

The UPS Properties  screen 
provides the initial configuration 
settings for the optional Back-
Up Power Supply (BUPS), which 
is external to the repeater.
1. From the menu bar in the 

Main Control screen, select 
Configuration -> UPS. 

The UPS Properties screen 
opens (see Figure 10-25).

2. Use the Alarms Setting tab 
to redefine alarm severity for 
the backup power systems.

The Alarm Setting tab sets 
the alarm severity for the 
following alarms:

AC Fail Alarm

Indicates that the input power to the BUPS has failed. Depending on which BUPS model is 
installed at the repeater site, the BUPS will then provide 40 or 80 amp-hours of backup 
power for the repeater, before shutdown. The AC source powers the charger.

Low Battery Alarm

Indicates that battery voltage for the BUPS is below operating tolerances, and the BUPS 
cannot power the repeater.

High Battery Alarm

Indicates that the battery voltage of the BUPS is above operating tolerances, and the BUPS 
cannot power the repeater.

Charger Fail Alarm

Indicates that the internal charger of the BUPS has failed, and the BUPS is unable to 
recharge its batteries.

UPS Summary Alarm

Indicates that one or more of the BUPS alarms have triggered.

UPS Tamper Alarm

Indicates that the door of the BUPS is open.

Figure 10-25 UPS Properties Screen
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3. Click the down-arrow next to an Alarm  field, to select one of the following alarm severity 
settings:

• Disabled.
• Event.
• Minor.
• Major.
• Critical.

4. Click the Apply  or OK button.

• The Apply button changes the alarm severity setting, and keeps the UPS Properties 
screen open.

• The OK button changes the alarm severity setting, and closes the UPS Properties 
screen.

10.17 Monitoring Repeater Status

The subsystem Status screens monitor and control various repeater system functions. By 
clicking the appropriate subsystem icons, you can check each subsystem in the repeater. 

Each Status screen includes one or more of the following tabs:

Alarms Tab

Reports present subsystem alarm states, with date and time stamps.

Measurements Tab

Reports power and operational temperature measurements, including Low and High values. 
A Reset Low/High button resets the values.

Voltages Tab

Reports present voltages for a subsystem.

Control Tab

Includes ON/OFF switches for internal and external subsystem hardware.

Status screens for the repeater are:
• Front End Status.

• Channel Status:

• Filter Status (Forward and Reverse).

• PA Status (Forward and Reverse).

• Alarm Control Unit (ACU) Status.

• Modem Status.

• Cellular Phone Status.

• Power System Status.

• UPS Status.
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10.18 Front End Status 

Click an FFE (Forward 
Front End) icon, to 
display the Front End 
Status screen. 

The Alarm tab, in the 
Front End Status screen, 
reports these alarms:

Forward FE Alarm

This alarm activates 
when the forward signal 
power level is too strong, 
and is being attenuated to 
protect the repeater from 
possible damage (see 
Figure 10-26).

Figure 10-26 Forward Front End Status Screen
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Reverse FE Alarm

This alarm activates 
when the reverse 
signal power level is 
too strong, and is 
being attenuated to 
protect the repeater 
from possible 
damages (see Figure 
10-27).

Diversity FE 
Alarm

This alarm activates 
when the Diversity 
Receive signal power 
level is too strong, 
and is being 
attenuated to protect 
the repeater from 
possible damage (see 
Figure 10-28).

Figure 10-27 Reverse Front End Status Screen

Figure 10-28 Diversity Front End Status Screen
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10.19 Channel Filter Status

Click a Channel 1 or 
Channel 2 filter icon (sine 
waves), to open a filter 
Status screen. 

The Channel Filter Status 
screen (see Figure 10-29) 
reports a CSF1 Forward 
Alarm (Forward Filter), 
and a CSF1 Reverse 
Alarm (Reverse Filter), 
both including date and 
time stamps.

A failure in the Reverse or 
Forward filter assembly 
triggers an alarm.

10.20 Channel PA Status

Click a Channel 1 or 
Channel 2 FPA 
(Forward Power 
Amplifier) or RPA 
(Reverse Power 
Amplifier) icon, to 
open a PA Status 
screen.

10.20.1 PA Alarm Tab

The PA Alarms tab 
(see Figure 10-30) 
reports subsystem 
alarms, including 
date and time stamps. 
A failure in the 
Forward or Reverse 
PA assembly triggers 
an alarm.

Figure 10-29 Channel Filter Status Screen

Figure 10-30 Power Amplifier Status Screen, Alarms Tab
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10.20.2 PA Measurement 
Tab

The Channel 1 and 
Channel 2 PA 
Measurement tabs 
(see Figure 10-31) 
report the output 
power of the repeater, 
including low and high 
output values. 

To reset low and high 
output values, click 
Reset Low/High.

10.21 ACU Status

Click the ACU icon, to open 
the ACU Status screen. 

This screen has two tabs:
• Alarm.

• Measurement.

ACU Alarm Tab

The Alarm tab (see Figure 
10-32) reports subsystem 
alarms, including date and 
time stamps. A failure in the 
ACU assembly triggers an 
alarm. ACU alarms include:

External Input Alarms (1 and 2)

The alarm is from a piece of 
optional, external equipment.

Temperature Alarm

The system temperature threshold was exceeded.

Tamper Alarm

The repeater door is open.

Analog Input Alarm

The upper or lower voltage limit was exceeded, from the DC voltage source for the analog input.

External Growth Box Alarm Status

The growth box connection (to the primary repeater box) is detached, disconnected, or broken.

Figure 10-31 Power Amplifier Status Screen, Measurement Tab

Figure 10-32 ACU Status Screen, Alarm Tab
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10.21.1 ACU 
Measurement 
Tab

The Measurement 
tab (see Figure 10-33) 
reports current, low, 
and high system 
temperature.

It also reports DC 
voltage source values. 

Click on the Reset 
Low/High button, to 
reset the low and 
high values.

10.22 Modem Status

Click the Modem 
icon. 

The Modem Status 
screen opens (see 
Figure 10-34). This 
screen reports a 
modem alarm, 
including a date and 
time stamp. 

Failure of an internal 
modem component 
triggers a Modem 
alarm .

Figure 10-33 ACU Status Screen, Measurement Tab

Figure 10-34 Modem Status Screen
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10.23 Cell Phone Status

Click the Cell Phone icon.

The Cell Phone Status 
screen (see Figure 10-35) 
opens. This screen reports 
any Cell Phone Alarm, 
including a date and time 
stamp. 

Failure of an internal cellular 
phone component triggers a 
Cell Phone alarm .

10.24 Power System Status

Click the Power icon.

The Power System Status screen opens. This screen monitors and operates the repeater’s 
power subsystem.

10.24.1 Alarm Tab

The Alarm tab (see 
Figure 10-36) reports 
the status of the 
following alarms, 
including severity, 
date, and time 
information for each:

Input Power Alarm

The input power to 
the repeater is out of 
tolerance.

Power Supply Alarm

The system power for 
the repeater is out of 
tolerance.

PS Battery Alarm

Indicates that the voltage of the internal battery is out of tolerance. This battery supplies power 
to the ACU, modem, and cellular phone, in the event of a system power failure. The repeater 
uses this battery to call out and report its status. The battery also supplies power to the 
memory, which stores the Alarm and Event Log.

The internal battery does not provide power for RF components. The repeater cannot provide RF 
coverage during a power failure.

Figure 10-35 Cell Phone Status Screen

Figure 10-36 Power System Status Screen, Alarms Tab
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10.24.2 Voltages Tab

The Voltages tab (see 
Figure 10-37) shows the 
current power values for:
• Battery Volts.

• Channel 1 PA (Power 
Amplifier) Volts.

• Channel 2 PA volts.

10.25 UPS Status

The UPS Status (Uninterruptable Power Supply status) screen monitors the optional, external 
Back-Up Power Supply (BUPS).

The Alarms tab in this 
screen (see Figure 10-38) 
displays the alarm status of 
the following alarms:

AC Fail Alarm
Input power to the BUPS 
failed. The BUPS provides 
40 or 80 amp-hours of 
backup power (depending on 
the installed BUPS type) at 
the repeater site, before 
shutdown. The AC source 
powers the charger.

Low Battery Alarm
BUPS battery voltage is below operating tolerances, and cannot power any repeater functions.

High Battery Alarm
BUPS battery voltage is above operating tolerances, and cannot power any repeater functions.

Charger Fail Alarm

The internal charger for the BUPS has failed. The BUPS cannot recharge its batteries.

UPS Summary Alarm
One or more of the BUPS alarms has triggered.

UPS Tamper Alarm
The door of the BUPS is open.

Figure 10-37 Power System Status Screen, Voltages Tab

Figure 10-38 UPS Status Screen, Alarms Tab
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10.26 RepeaterNet Menu Commands

This section describes commands that you can run from the menu bar, in the Repeater Main 
Control screen.

10.26.1 File Menu—RepeaterNet Craft 

From the Main Control screen, open the File menu. 
Figure 10-39 shows the RepeaterNet commands in this menu.

Download Properties

Use the Download Properties command to download all 
settings that are already uploaded to a repeater, including:

• Download the default configuration file, which is distributed with the Craft software. 
Downloading avoids manually configuring each setting.

• Restore repeater configuration settings. Restoring overwrites existing configuration 
settings. Use this option if you previously used the Upload Properties command to store 
repeater configuration settings.

Figure 10-40 shows the preset configuration files that are distributed with RepeaterNet Craft 
installation software. To find these files, follow the Windows Explorer path shown. Table 10-4 
describes each of these files.

NOTE: Examples shown are for the OA850C repeater.

Figure 10-39 RepeaterNet 
Craft, File Menu

Figure 10-40 Preset Configuration Files in RepeaterNet Craft
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Table 10-4 Descriptions of Configuration Files

Use the following procedure to download settings to a repeater, from the standard repeater 
configuration file.
1. From the Craft Main Control 

File menu, select Download 
Properties.

A confirmation box lets you 
either confirm, or cancel, the 
downloading. 

2. Click on the OK button to 
proceed.

A Select File to Restore box 
displays (see Figure 10-41).

3. Select the repeater 
configuration file, whose 
properties will be 
downloaded.

4. Click on the Open button, to 
proceed with the download.

When the download is complete, a confirmation message box displays.

Upload Properties

RepeaterNet stores system settings in a repeater configuration (.rcf) file. You can upload all 
settings from one repeater, and download these settings to additional repeaters in a network. 
You also can use existing configuration files to configure a replacement unit.

To upload the configuration from a repeater, use the Upload Properties command. You can 
then can use the Download Properties command, to copy the configuration to individual 
repeaters in the CDMA network. 

Configuration File Configuration

OA850C_2_Chan_NMS.rcf 2-channel OA850C repeater without modem or phone

OA850C_2_Chan_ModemPhonePager.rcf 2-channel OA850C repeater with modem or phone

OA850C_1_Chan_ModemPhonePager.rcf 1-channel OA850C repeater with modem or phone 

OA850C_1_Chan_NMS.rcf 1-channel OA850C repeater without modem or phone

Figure 10-41 Downloading Repeater Configuration Files
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Use the following procedure to upload 
system settings, and to create 
repeater configuration files.
1. Select a repeater.

2. Open the Craft software.

3. Select File->Upload 
Properties.

4. A Select a File to Save Repeater 
Properties To dialog box opens 
(see Figure 10-42).

5. Enter a name for the file, without 
a file extension. 

RepeaterNet Craft automatically 
adds a .rcf extension to the file 
name; for example:

filename.rcf

6. Click Save to initiate the upload.

When the upload is complete, a message box displays. 

7. Click the OK button.

8. Save a copy of the repeater configuration file onto a floppy disk, for safe keeping.

NOTE: When creating a backup file, be aware that if you used a Network Monitor login to create 
Repeater Configuration (.rcf) files, then the files include IDs and passwords. 

The Craft software saves the Repeater Configuration (.rcf) file in the RepeaterNet program 
directory.

Update Repeater Firmware

Use the Update Repeater Firmware  command to install a firmware upgrade. 

NOTE: Repeater Technologies, Inc. (RTI) automatically sends firmware updates to the designated 
point of contact, for every affected owner of a specific type of repeater. RTI uses overnight 
delivery to send update packages. 

Firmware updates include:
• A detailed description of the update. 

• A floppy disk containing the firmware update.

• Installation instructions. 

Direct any questions concerning the firmware upgrade to the Repeater Technologies Customer 
Service Department.

Figure 10-42 Saving Repeater Properties to a File
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To install a firmware upgrade:
1. Read the documentation 

provided with the firmware 
upgrade.

2. Login to a communications 
session, using the repeater to 
be upgraded. 

3. Insert the upgrade disk into 
the computer’s floppy drive.

4. From the menu bar in the Main 
Control screen, select 
File->Update Repeater 
Firmware.

A message box displays (see 
Figure 10-43). 

5. Click on the OK button.

A file selection screen displays 
(see Figure 10-44).

6. Select whether to save the 
repeater’s configuration. 

• To save the configuration 
and continue updating 
firmware, select an .rcf file, 
and click the Save button.

• To cancel saving the repeater 
configuration to a file, click 
the Cancel button.

Either way, the upload operation 
proceeds. An Uploading Repeater  
window displays the progress of the 
upload.

When the upload completes, the 
Select a Firmware File to 
Download to the Repeater  box 
displays (see Figure 10-45).

7. In the Look In field, select the disk 
drive that contains the upload disk.

8. Double-click the upgrade file. 

The upgrade file is labeled with an 
.s09 extension—for example:

filename.s09

Installation overwrites the previous 
firmware version.

When the upgrade is complete, the Craft software automatically restores the repeater’s 
configuration, from the file selected in the Open dialog box.

Figure 10-43 Firmware Update Message Box

Figure 10-44 Selecting File Names for 
Saving Firmware Updates

Figure 10-45 File Selection Box for 
Downloading Firmware
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Exit

The Exit command ends an active session in the RepeaterNet software, and returns to the 
Welcome screen.

10.26.2 Configuration Menu—RepeaterNet Craft 

To initially configure the repeater, use the Configuration 
menu commands, shown in Figure 10-46.

See Section 10.8, Configuring Repeater Properties, on page 1-
8, for detailed information.

10.26.3 System Menu—RepeaterNet Craft 

This section describes commands in the System menu, 
as shown in Figure 10-47.

Properties

Select Properties from the System menu. 

The System Properties screen opens.

NOTE: When the repeater is on a network, you must enter the 
system name, as used at the Network Management 
Station. This ensures that RepeaterNet Craft 
recognizes unsolicited alarms.

Figure 10-46 RepeaterNet 
Craft, Configuration Menu

Figure 10-47 RepeaterNet 
Craft, System Menu
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System Tab

The System tab includes data 
fields for storing site-specific 
information (see Figure 10-48):
• The system name (name of 

the repeater).

• Brief site information (such 
as a network name, or a city 
location).

• The repeater phone number, 
if the repeater has a modem 
option.

Entering summary data (on the 
System Tab) is optional, but RTI 
recommends entering this data.

To record system data:
1. Type the required 

information in each data 
field:

• System (Repeater) Name, up to 12 characters (required). 
During automatic reporting, the repeater name displays in the title bar of the Main 
Control screen, identifying the selected repeater.

• Site Information, Field 1 , up to 14 characters. Typically, identifies the cell phone 
network (optional).

• Site Information, Field 2 , up to 14 characters. Typically, identifies the repeater location 
(optional).

• Site Phone Number of the repeater, up to 12 characters (optional).
2. Click the Apply  or OK button.

• The Apply button sets the system properties, and keeps the System Properties screen 
open.

• The OK button sets the system properties, and closes the System Properties screen.

Figure 10-48 System Properties Screen, System Tab
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System Inventory Tab

The System Inventory tab (see 
Figure 10-49) displays 
information about the repeater to 
which the PC or laptop is 
connected. 

After you successfully login, 
RepeaterNet reads this 
information directly from the 
repeater. 

NOTE: You cannot edit data in any 
fields of this tab.

Table 10-5 summarizes the data 
displayed in the information-only 
fields of this tab.

Table 10-5 Description of System Inventory Fields

Field Name Description

Assembly Part Number The part number of the repeater (for example, 090-1200-09).

Serial Number The 9-digit serial number of the repeater.

Date Code The date when the repeater was built.

Hardware Revision The repeater hardware revision (such as Rev. A).

Boot Code Version The version number of the boot code installed in the repeater.

Installed Options Optional internal equipment in the repeater (such as a cell 
phone).

Firmware Version The version number of the firmware installed in the repeater.

Figure 10-49 System Properties Screen, 
System Inventory Tab
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System Login Tab

The System Login tab (see 
Figure 10-50) includes fields to do 
the following:
• Type in login Ids.

• Type in passwords.

• Configure the Auto-Logout 
function. 

In the Auto-Logout Inactivity 
Time field, define how long 
RepeaterNet should wait, during a 
period of inactivity, before it 
terminates a session. 

You can define a separate time 
interval in minutes, between 1 and 
60, for each access level. If you 
enter a zero in a time field, this 
feature becomes disabled.

NOTE: When the repeater is part of a network, the time field must be zero (0).

To change a login ID or password:
1. Login to the repeater (as an administrator).

2. Select Properties… from the System menu.

3. Click the Login tab.

4. Type the new login ID or password into the appropriate fields.

NOTE: The login ID and the password must each consist of six or fewer characters.

5. Write down the login IDs and passwords, and secure them in a safe place.

6. Click the Apply  or OK button to set the new information.

• The Apply button sets the login information, and keeps the System Properties screen 
open.

• The OK button sets the login information, and closes the System Properties screen.
7. Notify affected operators about the ID and password changes.

NOTE: When the repeater is networked, this information also must reside in the NMS Database.

Figure 10-50 System Properties Screen, 
System Login Tab
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Alarm and Event Log

Open the Alarm and  Event Log  from the System menu, to view the alarm and event history. 
This log dynamically updates during viewing.

Line entries in the Alarm and Event Log are organized as follows:
1. Subsystem affected by an alarm or event.

2. Alarm severity.

3. Date and time stamp.

You can use Notepad to print or save Alarm and Event Log entries.

10.26.4 Options Menu—RepeaterNet Craft

Figure 10-51 shows the RepeaterNet commands in the 
Options menu.

Color Independent Icons

Color Independent Icons are special graphic indicators, 
designed to assist operators who are unable to 
distinguish colors. As part of the alarm reporting 
system, Color Independent Icons display on the Main 
Control screen for a Critical, Major, or Minor alarm. 

By default, the Color-Independent Icons feature is OFF. 

From the Main Control screen menu bar, select Options->Color Independent Icons, to turn 
ON this feature. Table 10-6 describes each of the color-independent icons.

Table 10-6 Description of Color Independent Icons

Alarm Sounds

The Alarm Sounds feature allows an intermittent audible alarm to activate, when a subsystem 
triggers an alarm. 

By default, the Alarm Sounds feature is OFF. 

From the Main Control screen menu bar, select Options->Alarm Sounds, to turn ON this 
feature. 

To silence an audible alarm, either click a subsystem icon (to open the Status screen), or clear 
the alarm.

Alarm Type Color Independent Icon Symbol

Critical X through the subsystem icon.

Major Back slash (\) through the subsystem icon.

Minor Dotted-line back slash through subsystem icon.

Figure 10-51 RepeaterNet 
Craft, Options Menu
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10.26.5 Help Menu—RepeaterNet Craft 

RepeaterNet on-line help provides quick access to information 
related to the operation of the repeater. Figure 10-52 shows the 
Help menu.
• To open RepeaterNet Help, select Help->Help Topics.

• To learn about the version of RepeaterNet Craft, 
RepeaterNet NMS, or RepeaterNet Administrator installed, 
select About… from the Help menu of any program window. 

Figure 10-53 shows a typical window that opens when you select Help->Help Topics.

Figure 10-53 Help Topics Window 

Figure 10-52 RepeaterNet 
Craft, Help Menu
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Contents Tab

1. From the Contents 
tab (see Figure 10-54) 
of the Help Topics 
window, double-click a 
book icon.

Online Help opens the 
book’s contents.

2. Double-click a topic 
icon.

This opens the topic’s 
Help page. 

A help page provides 
detailed topic 
information. Help 
pages can contain links 
to related topics (green, 
underlined text 
identifies a link).

Index Tab

1. From the Index tab (see 
Figure 10-55) of the Help 
Topics window, do either 
of the following:

• Type a topic name in 
the data field.
Online Help 
automatically jumps 
to the index entry for 
the selected topic.

• Use the scroll bar to 
locate a topic entry.

2. Double-click an index 
entry.

The appropriate Help 
page opens.

Figure 10-54 Help Topics Window, Contents Tab

Figure 10-55 Help Topics Window, Index Tab
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Find Tab

1. In the Help Topics 
Window, click on 
the Find tab.

The Find Setup 
Wizard utility 
opens (see Figure 
10-56). 

Use this wizard to 
search for specific 
words and 
phrases in Online 
Help, instead of 
searching by 
category.

2. Follow the 
prompts in the 
Find Setup 
Wizard utility.

When the Find 
Setup Wizard 
finishes, a 
window such as 
Figure 10-57 
displays.

Figure 10-56 Find Setup Wizard (Two Screens)
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Figure 10-57 Result of Find in Help Topics Window

10.26.6 Exiting RepeaterNet

To exit RepeaterNet, return to the File menu in the Main Control screen, and select Exit.
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Chapter 11 Final Testing and Optimization

11.0 Link Engineering Considerations

11.0.1 Ensuring Adequate Isolation for a Repeater Application

Compare the maximum forward and reverse gain settings, to the available isolation.
• If the available isolation is at least 15 dB higher than the maximum gain setting, then the 

repeater will operate with good stability.

• If the isolation is less than 15 dB higher than the maximum gain setting, then some 
oscillation might result.

For CDMA systems, pre-oscillation begins at about 15 dB margin over gain, and becomes very 
problematic at about 10 dB margin-over-gain. Therefore, you should strictly follow the 15 dB 
margin-over-gain rule.

11.1 System Timing Issues

11.1.1 Worst-Case Position for Active Search Window Width

This process estimates the required width setting for the active search window, to ensure that 
the repeater properly covers a transition zone (between the base station and the repeater).

The typical value required for SRCH_WIN_A (for repeater operation in a transition zone), is 
about +/- 30 chips. This corresponds to SRCH_WIN_A = 8. This value is more than sufficient for 
most applications, where the repeater is less than three miles from the donor site, and the 
repeater radius is two miles or less.

For a detailed description of this issue see Appendix E: “System Timing Issues, Cell Radius, 
Search Window Widths, and Pilot Inc”, in the Repeater Engineering Handbook.
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11.1.2 Worst-Case Position for Neighbor Search Window Width

This process estimates the required width setting for the neighbor search window, to ensure 
that the repeater properly covers a soft hand-off zone (between the base station and the 
repeater).

The worst-case position is wherever the greatest differential delay exists, between the cell that 
the mobile uses for timing, and a hand-off candidate cell.

NOTE: This relationship is symmetrical and reciprocal for neighboring cells, if those cells are 
candidates for the donor sector. That is, the neighbor cells also need wider search windows. 

Wider search windows can search the TOA (Time Of Arrival) of the specific pilot, that is 
associated with the donor sector (the pilot is accessible via the repeater).

The following equation calculates the differential delay:

The typical process is:
1. Determine the place where the differential delay is greatest, and where a mobile is likely to 

be operating.

2. Calculate the differential delay.

This worst-case differential delay determines the SRCH_WIN_N parameter setting.

The typical value required for SRCH_WIN_N (for repeater operation in the transition zone) is 
about +/- 40 chips. This corresponds to SRCH_WIN_N  = 9. This value is more than sufficient for 
most applications, where the repeater is less than three miles from the donor site, and the 
repeater radius is two miles or less. For a detailed description of this issue, see Appendix E: 
“System Timing Issues, Cell Radius, Search Window Widths, and Pilot Inc”, in the 
Repeater Engineering Handbook .

( ) ( )

( ) ( )
( )

( )
( )

( )

∆

∆

Chips D R S N Chips

Where

Chips Differential Delay Chips

D Donor Path Length Chips

R peater Delay Chips

S Subscriber Path Length Chips

N Neighbor Path Length Chips

= + + −

=

=

=

=

=

:

_

_ _

Re _

_ _

_ _



Chapter 11. Final Testing and Optimization Repeater Technologies, Inc.—Company Confidential 11-3

C
h

ap
ter 11

11.1.3 Channel Search Window Width for Reverse Link Access

The mobile station searches the forward link TOA probability space, for new pilot offsets. A 
similar search process occurs at the base station.

The base station modem chip (CSM) also contains a searcher. Both the access channel and the 
traffic channel use this searcher, to determine the TOA of the mobile’s energy. Because the 
access channel does not know how far an originating mobile is from the base station, it must 
search the entire TOA probability space associated with the cell’s maximum radius.

For example, if the cell has a maximum radius of 20 chips, then the searcher must search the 
range of relative TOA, from near zero chip delay (for very close mobiles), to delays as great as 40 
chips.

NOTE: The round trip delay is the important variable, because the mobile is “phase locked” to the PN 
sequence of the down-link (forward link) path. Also, the TOA (round-trip delay) of the base 
station, is twice the one-way delay.

The cell radius plays a central role in determining the required width for the access-channel 
search window. Most CDMA network manufacturers derive all of the required search window 
parameters from a simple parameter, called Cell_Radius or something similar. Usually, if you 
set this parameter to the maximum cell radius, the Link Engineering Spread Sheet (LESS) 
automatically calculates and updates all corresponding parameters (such as preamble size, 
PROBE_RAN_PN, and so on). 

NOTE: You must set this parameter properly. An incorrect setting can limit the range of access, to the 
base station, via the repeater.

The setting for this parameter is simply the sum of the donor link radius, the repeater delay in 
miles, and the maximum repeater coverage range, as shown in the following equation:

If the equipment manufacturer does not provide a Cell Radius type parameter, or if you need 
more information on this subject, refer to the “Reverse Search Window Overview ” document. 
The Repeater Technologies Application Engineering Group can also address issues such as this.
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11.1.4 Setting Radius of Traffic Channel Search Window

The new base station must acquire the reverse traffic channel during a soft hand-off attempt. 
This search process is similar to the one that the access channel performs during initial system 
access.

The Primary Base Station  (initial base station) receives the Pilot PN Phase information in 
the Pilot Strength Measurement Message. You can use this information to estimate the Time 
of Arrival (TOA) at the new base station. This can significantly reduce the acquisition time of 
the reverse traffic channel. Due to the dynamic nature of the mobile propagation environment, 
and the delay associated with hand-off processing, the search window must be wider than a 
single-point Time Of Arrival (TOA) set. Typically, the reverse traffic channel search window 
centers around the estimated TOA, and its width depends on two factors:
• The accuracy of the TOA estimate.

• The maximum expected variation of the TOA, during hand-off processing.   

If the CDMA equipment manufacturer uses the Pilot PN Phase to estimate the TOA at the 
neighbor base station, then the search window width needs to be only a few tens-of-chips wide 
(+/- 20 chips). This is typically the case; however, some manufacturers might not use the Pilot 
PN Phase data to estimate the TOA.

If the TOA estimate is not available for the neighboring base station, then you must run a 
complete search of all possible Times of Arrival, just as you do during the access channel search 
process. In this case, the search process takes longer, and therefore the hand-off is slower. The 
required width of the search window, used in this process, depends on the TOA of the mobile’s 
energy, at the new base station.

The equation that calculates the TOA is similar to (but not identical to) setting the neighbor 
search window:

After this equation calculates the worst-case TOA, you can set the search window width 
accordingly.

11.1.5 Updating MTSO Data Base, Using New Timing Parameters

After you determine all of the parameters, you can update both the Mobile Telephone Switching 
Office (MTSO) data base, and the repeater data base, using the proper parameters. Do not 
perform this update, until you are ready to activate the repeater. 
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11.2 Drive Testing Requirements

11.2.1 Collecting Data

To ensure proper repeater operation, drive test all of the following areas:
• Repeater coverage area.

• Transition zone, between the donor base station coverage area, and the repeater coverage 
area.

• Soft hand-off zones, between the repeater and adjacent cell sites.

For CDMA networks, RTI recommends that you accumulate data for both the forward and 
reverse link, at the same time. Usually, this requires invoking “call trace,” or some similar 
function within the switch. Once invoked, the switch logs the test call by time stamp. You can 
later correlate this to the forward link data.

This method helps you to more-accurately analyze the link balance, and to identify areas of high 
RFER and/or high Mobile_TX parameters.

11.2.2 Collection Equipment

The minimum equipment required for drive testing is: 
• CDMA phone.

• Serial data cable.

• Laptop or notebook computer, running collection software.

• GPS receiver.

This equipment is available from a variety of sources, such as:
• Qualcomm, Incorporated.

• Safco.

• Grayson.

• LCC, Inc.

• Berkeley Veritronics.

Analyzing the drive test results might require a change in network timing parameters, and/or 
adjustment of the repeater subscriber antenna. That is, you must optimize the repeater, using 
the same methods as you use for a base station. 
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Chapter 12 Reviewing Technical Specifications

12.0 OA850C Specifications

Table 12-1 Models and Frequency Range

Table 12-2 Electrical Characteristics

Table 12-3 Mechanical/Electrical Characteristics

Table 12-4 AC and DC Electrical Power Characteristics

NOTE: For solar-power applications, if the repeater is not handling CDMA traffic (only paging, pilot, 
and sync channels), it enters Power-Save Mode, reducing power consumption by 20%.

Models and Frequency Range (MHz)

Model Channel 
Bandwidth

Band Forward Reverse

OA850C 1.25 MHz A 869.0–880.0 and 890.0–891.5 824.0–835.0 and 845.0–846.5

OA850C 1.25 MHz B 880.0–890.0 and 891.5–894.0 835.0–845.0 and 846.5–849.0

Electrical Characteristics

RF Output Power Per Carrier at the Antenna Port

Link 1-Channel 2-Channel Gain (in 2 dB steps)

Forward +38.5 dBm +38.5 dBm 65 – 95

Main Reverse +18 dBm +18 dBm 65 – 95

Diversity Reverse +18 dBm +18 dBm 65 – 95

Mechanical/Electrical Characteristics

Power 
Consumption

Size Weight Input Voltage 
Options

Temperature Antenna 
Connectors

1-channel 260 Watt 16H x 14W x 11.5D (inch) 110/230 VAC -40° to 55° C Type N

2-channel 500 Watt 
(total)

436H x 356W x 292D 
(mm)

Or +24 VDC ambient (f)

Power Type Voltage Current (Typical)
1 channel

Current (Typical)
2 channels

AC 85 to 264 Volts
(auto-ranging)

1.5 Amps @ 117 Vac
0.9 Amps @ 230 Vac

2.6 Amps @ 117 Vac
1.5 Amps @ 230 Vac

DC 21 to 32 volts 6.0 Amps @ 24 Vdc 10.2 Amps @ 24 Vdc
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Table 12-5 Inputs and Outputs

Table 12-6 Additional Characteristics

Table 12-7 RepeaterNet Alarm, Monitoring, and Control

Table 12-8 Alternate Power Options

Inputs and Outputs

Local I/O Output Type Local I/O Output Type Local I/O Output Type

Critical 
Alarm

Form C 
Relay

Remote Control 
Relays (2)

Form C Relay External 
Battery Monitor

Analog (DC 
Volts)

Major 
Alarm

Form C 
Relay

Digital Outputs (2) Opto-Isolated 
TTL

BUPS Monitor 6 Alarms

Minor 
Alarm

Form C 
Relay

Digital Inputs (2) Opto-Isolated 
TTL

Additional Characteristics

Waveform 
Quality factor 
Degradation 

(rho)

Spurious 
Response

3 dB SAW 
Filter 

Bandwidth

Delay Maximum 
Input Signal 

(without 
damage)

VSWR Noise Figure

ρ > 0.95 per IS-95/IS-97 <1.27 MHz <6 µsec +10 dBm <1.5:1 <6 dB per path

RepeaterNet Alarm, Monitoring, and Control

Access Options GUI Functions

• RS-232 (local)

• POTS (dial-up)

• Wireless Modem

• Windows® 95/NT (Craft)

• Windows NT (NMS)

• 32-bit

• Point-and-click

• Wireless Modem

• Summary Alarm

• Interrupt Reporting

• Definable Threshold

• Remote Control: Gain, Channel, PA On/Off

Alternate Power Options

Type Description

BUPS 2-8 hours of backup power, without AC.

Solar Power PV (Photovoltaic), with regulated charging to batteries.

Hybrid Solar and TEG PV, with thermal electric propane generation assistance.

Hybrid Solar and MG PV, with propane or diesel generation assistance.
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12.1 OA1900C Specifications

Table 12-9 Frequency Range Options (MHz)

Table 12-10 Electrical Characteristics

Table 12-11 Mechanical/Electrical Characteristics

Frequency Range Options (MHz)

Block Bandwidth Reverse Forward

A 15 1850— 1865 1930—1945

B 15 1870— 1885 1950— 1965

C 15 1895—1910 1975—1990

D 5 1865—1870 1945—1950

E 5 1885—1890 1965—1970

F 5 1890—1895 1970—1975

Electrical Characteristics

RF Output Power Per Carrier at the Antenna Port

Link 1-Channel 2-Channel Gain (dB)

Forward +38 dBm +38 dBm 65-95

Main Reverse +18 dBm +18 dBm 65-95

Diversity Reverse +18 dBm +18 dBm 65-95

Mechanical/Electrical Characteristics

Power 
Consumption

Size Weight Input Voltage 
Options

Temperature Antenna
Connectors

1-Channel
310 

Watts
16H x l4W x 

11.5D(inches)
406H x 356W x 

292D (Mm)

<50l~or
23 Kg.

110/23O VAC
or +24/48 

VDC

-40° to 55°C
ambient

Type N (f)
7/16 DIN (f) 

optional

2-Channel
570 

Watts 
(total)
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Table 12-12 AC and DC Electrical Power Characteristics

NOTE: For solar-power applications, if the repeater is not handling CDMA traffic (only paging, pilot, 
and sync channels), it enters Power-Save Mode, reducing power consumption by 20%.

Table 12-13 Additional Characteristics

Table 12-14 RepeaterNet Alarm, Monitoring, and Control

Table 12-15 Alternate Power Options

Power Type Voltage Current (Typical)
1 channel

Current (Typical)
2 channels

AC 100 to 264 Volts
(auto-ranging)

1.75 Amps @ 117 Vac
0.95 Amps @ 230 Vac

3.0 Amps @ 117 Vac
1.6 Amps @ 230 Vac

DC 22 to 32 volts 7.5 Amps @ 24 Vdc 12.8 Amps @ 24 Vdc

Additional Characteristics

Waveform 
Quality Factor 
Degradation 

(rho)

Spurious 
Response

3 dB SAW 
Filter 

Bandwidth

Group 
Delay

Maximum Input 
Signal (without 

damage)
VSWR

Noise Figure

Þ > 0.95 Per ANSI 
J-STD-008

<1.27 MHz <6µsec +10dBm <1.5:1 <6dB per path

RepeaterNet Alarm, Monitoring, and Control

Access Options GUI Functions

• Windows® 95 Craft • Summary Alarm

• RS-232 (local) • Windows NT (NMS) • Interrupt Reporting

• POTS (dial-up) • 32-bit • Definable Threshold

• Wireless Modem • Point-and-click • Remote Control: Gain, Channel and PA On/Off

• Wireless Modem

Alternate Power Options

Type Description

BUPS 2-8 hours of backup power, without AC

Solar Power PV (Photovoltaic), with regulated charging to batteries

Hybrid Solar and TEG PV, with thermal electric propane generation assistance

Hybrid Solar and MG PV, with propane or diesel generation assistance
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Table 12-16 Inputs and Outputs

Table 12-17 LED Indicators

12.2 Ordering Information

The tables that follow provide information about ordering from Repeater Technologies, Inc.; 
specifically:
• Ordering Considerations.

• Repeater Configurations and Part Numbers.

• Optional Equipment Available from Repeater Technologies.

• Back-up Power System (BUPS).

• Accessory Kit Items.

When ordering, specify a shipping destination and a billing address. Repeater Technologies will 
return an order acknowledgment, and the scheduled shipping date. Each shipment includes an 
equipment list, showing the equipment ordered, and the equipment shipped. This list includes 
details about system and equipment options. Contact the Repeater Technologies Sales 
Department for ordering information.

Inputs and Outputs

Local I/O Output Type Local I/O Output Type Local I/O Output 
Type

Critical Alarm Form C Relay Remote Control 
Relays (2)

Form C Relay External 
Battery Monitor

Analog:
DC volts

Major Alarm Form C Relay Digital Ouputs (2) Opto–isolate TTL BUPS Monitor 6 Alarms

Minor Alarm Form C Relay Digital Inputs (2) Opto–isolate TTL

LED Indicators

System Ready

Critical Alarm

Minor Alarm

Major Alarm
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Table 12-18 Ordering Considerations

Table 12-19 OA850C Configuration Part Numbers

Item Requirement

Electrical Power AC or DC, power cord, watertight conduit or connector.

Back-up Power A power supply, in case of interrupted electrical service; a Back-up 
Power System (BUPS) is available from Repeater Technologies.

Antennas—Donor or Subscriber What types are required; what is the intended system coverage. 
Antennas are available from Repeater Technologies.

Coaxial Cabling What type and length are required. Coaxial cable is available from 
Repeater Technologies.

Mounting Special requirements for the repeater and antennas.

Antenna Interface Connectors Type N to 7/16 DIN Jumper Cables

Part # Block Description

900-5100-01 A or B* Assembly, OA850C Repeater, 1-Channel, 115/230 VAC, with diversity

900-5120-01 A or B* Assembly, OA850C Repeater, 1-Channel, 115/230 VAC, without diversity

900-5140-01 A Assembly, OA850C Repeater, 1-Channel, 115/230 VAC, with diversity, 10 MHz, 
A-block

900-5150-01 A Assembly, OA850C Repeater, 1-Channel, 115/230 VAC, without diversity, 10 
MHz, A-block

900-5110-01 A or B* Assembly, OA850C Repeater, Growth Box, 115/230 VAC (adds second channel 
to any AC system)

900-5100-02 A or B* Assembly, OA850C Repeater, 1-Channel, 24 VDC, with diversity

900-5120-02 A or B* Assembly, OA850C Repeater, 1-Channel, 24 VDC, without diversity

900-5140-02 A Assembly, OA850C Repeater, 1-Channel, 24 VDC, with diversity, 10 MHz, A-
block

900-5150-02 A Assembly, OA850C Repeater, 1-Channel, 24 VDC, without diversity, 10 MHz, 
A-block

900-5110-02 A or B* Assembly, OA850C Repeater, Growth Box, 24 VDC (adds second channel to 
any DC system)

* Includes coverage for A and B extended bands.
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Table 12-20 OA1900C Configuration Part Numbers

Part # Description

090-3100-01 Assembly, OA1900C,CDMA,A BLK, 1 CH,115/230V, W/DIV

090-3100-02 Assembly, OA1900C,CDMA,A BLK, GROWTH BOX 115/230V

090-3100-03 Assembly, OA1900C,CDMA,A BLK, 1 CH,115/230V, W/O DIV

090-3100-05 Assembly, OA1900C,CDMA,A BLK, 1 CH,24/48V, W/DIV

090-3100-06 Assembly, OA1900C,CDMA, A BLK, GROWTH BOX 24V

090-3100-07 Assembly, OA1900C,CDMA,A BLK, 1 CH,24/48V, W/O DIV

090-3110-01 Assembly, OA1900C,CDMA,B BLK, 1 CH,115/230V, W/DIV

090-3110-02 Assembly, OA1900C,CDMA,B BLK, GROWTH BOX 115/230V

090-3110-03 Assembly, OA1900C,CDMA,B BLK, 1 CH,115/230V, W/O DIV

090-3110-05 Assembly, OA1900C,CDMA,B BLK, 1 CH,24/48V, W/DIV

090-3110-06 Assembly, OA1900C,CDMA,B BLK, GROWTH BOX 24V

090-3110-07 Assembly, OA1900C,CDMA,B BLK, 1 CH,24/48V, W/O DIV

090-3120-01 Assembly, OA1900C,CDMA,C BLK, 1 CH,115/230V, W/DIV

090-3120-02 Assembly, OA1900C,CDMA,C BLK, GROWTH BOX 115/230V

090-3120-03 Assembly, OA1900C,CDMA,C BLK, 1 CH,115/230V, W/O DIV

090-3120-05 Assembly, OA1900C,CDMA,C BLK, 1 CH,24/48V, W/DIV

090-3120-06 Assembly, OA1900C,CDMA, C BLK, GROWTH BOX 24V

090-3120-07 Assembly, OA1900C,CDMA,C BLK, 1 CH,24/48V, W/O DIV

090-3121-01 Assembly, OA1900C, CDMA C-LOW BLK,1 CH,115/230V, W/DIV

090-3121-02 Assembly, OA1900C, CDMA C-LOW BLK,GROWTH BOX,115/230VAC

090-3121-03 Assembly, OA1900C,CDMA C-LOW BLK,1CH,115/230 V W/ODIV

090-3121-05 Assembly, OA1900C,CDMA C-LOW BLK,1CH,24 V W/DIV

090-3121-06 Assembly, OA1900C,CDMA C-LOW BLK GROWTH BOX 24V

090-3121-07 Assembly, OA1900C,CDMA C-LOW BLK,1 CH,24V W/O DIV

090-3122-01 Assembly, OA1900C,CDMA C-HIGH,1 CH,115/230V, W/DIV

090-3122-02 Assembly, OA1900C,CDMA C-HIGH BLK,GROWTH BOX,115/230VAC

090-3122-03 Assembly, OA1900C,CDMA C-HIGH BLK,1 CH,115/230 V W/ODIV

090-3122-05 Assembly, OA1900C,CDMA C-HIGH BLK,1CH,24 V W/DIV

090-3122-06 Assembly, OA1900C,CDMA C-HIGH BLK GROWTH BOX 24V
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Table 12.20 (continued) OA1900C Configuration Part Numbers

Part # Description

090-3122-07 Assembly, OA1900C,CDMA C-HIGH BLK,1 CH,24V W/O DIV

090-3130-01 Assembly, OA1900C,CDMA,D BLK, 1 CH,115/230V, W/DIV

090-3130-02 Assembly, OA1900C,CDMA,D BLK, GROWTH BOX 115/230V

090-3130-03 Assembly, OA1900C,CDMA,D BLK, 1 CH,115/230V, W/O DIV

090-3130-05 Assembly, OA1900C,CDMA,D BLK, 1 CH,24/48V, W/DIV

090-3130-06 Assembly, OA1900C,CDMA, D BLK, GROWTH BOX 24V

090-3130-07 Assembly, OA1900C,CDMA,D BLK, 1 CH,24/48V, W/O DIV

090-3140-01 Assembly, OA1900C,CDMA,E BLK, 1 CH,115/230V, W/DIV

090-3140-02 Assembly, OA1900C,CDMA, E BLK, GROWTH BOX 115/230V

090-3140-03 Assembly, OA1900C,CDMA,E BLK, 1 CH,115/230V, W/O DIV

090-3140-05 Assembly, OA1900C,CDMA,E BLK, 1 CH,24/48V, W/DIV

090-3140-06 Assembly, OA1900C,CDMA, E BLK, GROWTH BOX 24V,

090-3140-07 Assembly, OA1900C,CDMA,E BLK, 1 CH,24/48V, W/O DIV

090-3150-01 Assembly, OA1900C,CDMA,F BLK, 1 CH,115/230V, W/DIV

090-3150-02 Assembly, OA1900C,CDMA, F BLK, GROWTH BOX 115/230V

090-3150-03 Assembly, OA1900C,CDMA,F BLK, 1 CH,115/230V, W/O DIV

090-3150-05 Assembly, OA1900C,CDMA,F BLK, 1 CH,24/48V, W/DIV

090-3150-06 Assembly, OA1900C,CDMA, F BLK, GROWTH BOX 24V

090-3150-07 Assembly, OA1900C,CDMA,F BLK, 1 CH,24/48V, W/O DIV
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Table 12-21 OA1900C Configuration Part Numbers

Part # Description

090-3600-01 Assembly, OA1900C,CDMA,A BLK, 1 CH,115/230V, W/DIV

090-3600-02 Assembly, OA1900C,CDMA,A BLK, GROWTH BOX 115/230V

090-3600-03 Assembly, OA1900C,CDMA,A BLK, 1 CH,115/230V, W/O DIV

090-3600-05 Assembly, OA1900C,CDMA,A BLK, 1 CH,24/48V, W/DIV

090-3600-06 Assembly, OA1900C,CDMA, A BLK, GROWTH BOX 24V

090-3600-07 Assembly, OA1900C,CDMA,A BLK, 1 CH,24/48V, W/O DIV

090-3610-01 Assembly, OA1900C,CDMA,B BLK, 1 CH,115/230V, W/DIV

090-3610-02 Assembly, OA1900C,CDMA,B BLK, GROWTH BOX 115/230V

090-3610-03 Assembly, OA1900C,CDMA,B BLK, 1 CH,115/230V, W/O DIV

090-3610-05 Assembly, OA1900C,CDMA,B BLK, 1 CH,24/48V, W/DIV

090-3610-06 Assembly, OA1900C,CDMA,B BLK, GROWTH BOX 24V

090-3610-07 Assembly, OA1900C,CDMA,B BLK, 1 CH,24/48V, W/O DIV

090-3620-01 Assembly, OA1900C,CDMA,C BLK, 1 CH,115/230V, W/DIV

090-3620-02 Assembly, OA1900C,CDMA,C BLK, GROWTH BOX 115/230V

090-3620-03 Assembly, OA1900C,CDMA,C BLK, 1 CH,115/230V, W/O DIV

090-3620-05 Assembly, OA1900C,CDMA,C BLK, 1 CH,24/48V, W/DIV

090-3620-06 Assembly, OA1900C,CDMA, C BLK, GROWTH BOX 24V

090-3620-07 Assembly, OA1900C,CDMA,C BLK, 1 CH,24/48V, W/O DIV

090-3621-01 Assembly, OA1900C, CDMA C-LOW BLK,1 CH,115/230V, W/DIV

090-3621-02 Assembly, OA1900C, CDMA C-LOW BLK,GROWTH BOX,115/230VAC

090-3621-03 Assembly, OA1900C,CDMA C-LOW BLK,1CH,115/230 V W/ODIV

090-3621-05 Assembly, OA1900C,CDMA C-LOW BLK,1CH,24 V W/DIV

090-3621-06 Assembly, OA1900C,CDMA C-LOW BLK GROWTH BOX 24V

090-3621-07 Assembly, OA1900C,CDMA C-LOW BLK,1 CH,24V W/O DIV

090-3622-01 Assembly, OA1900C,CDMA C-HIGH,1 CH,115/230V, W/DIV

090-3622-02 Assembly, OA1900C,CDMA C-HIGH BLK,GROWTH BOX,115/230VAC

090-3622-03 Assembly, OA1900C,CDMA C-HIGH BLK,1 CH,115/230 V W/ODIV

090-3622-05 Assembly, OA1900C,CDMA C-HIGH BLK,1CH,24 V W/DIV

090-3622-06 Assembly, OA1900C,CDMA C-HIGH BLK GROWTH BOX 24V
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Table 12.21 (continued) OA1900C Configuration Part Numbers

Part # Description

090-3622-07 Assembly, OA1900C,CDMA C-HIGH BLK,1 CH,24V W/O DIV

090-3630-01 Assembly, OA1900C,CDMA,D BLK, 1 CH,115/230V, W/DIV

090-3630-02 Assembly, OA1900C,CDMA,D BLK, GROWTH BOX 115/230V

090-3630-03 Assembly, OA1900C,CDMA,D BLK, 1 CH,115/230V, W/O DIV

090-3630-05 Assembly, OA1900C,CDMA,D BLK, 1 CH,24/48V, W/DIV

090-3630-06 Assembly, OA1900C,CDMA, D BLK, GROWTH BOX 24V

090-3630-07 Assembly, OA1900C,CDMA,D BLK, 1 CH,24/48V, W/O DIV

090-3640-01 Assembly, OA1900C,CDMA,E BLK, 1 CH,115/230V, W/DIV

090-3640-02 Assembly, OA1900C,CDMA, E BLK, GROWTH BOX 115/230V

090-3640-03 Assembly, OA1900C,CDMA,E BLK, 1 CH,115/230V, W/O DIV

090-3640-05 Assembly, OA1900C,CDMA,E BLK, 1 CH,24/48V, W/DIV

090-3640-06 Assembly, OA1900C,CDMA, E BLK, GROWTH BOX 24V,

090-3640-07 Assembly, OA1900C,CDMA,E BLK, 1 CH,24/48V, W/O DIV

090-3650-01 Assembly, OA1900C,CDMA,F BLK, 1 CH,115/230V, W/DIV

090-3650-02 Assembly, OA1900C,CDMA, F BLK, GROWTH BOX 115/230V

090-3650-03 Assembly, OA1900C,CDMA,F BLK, 1 CH,115/230V, W/O DIV

090-3650-05 Assembly, OA1900C,CDMA,F BLK, 1 CH,24/48V, W/DIV

090-3650-06 Assembly, OA1900C,CDMA, F BLK, GROWTH BOX 24V

090-3650-07 Assembly, OA1900C,CDMA,F BLK, 1 CH,24/48V, W/O DIV
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Table 12-22 Spare Parts and Accessory Items

Description Part Number

Antennas* Call for information.

Connectors Call for information.

Coaxial Cable Call for information.

AC Power Cord 103-0137-01

Pole Mounting Kit 137-0438-01

McMaster-Carr 3/4-inch Banding Kit Part No. 5653K12, McMaster-Carr Supply Co., 
Los Angeles, CA, USA, Tel. # (562) 692-5911)

I/O Entry Box Door (OA850C only) 024-1008-01

I/O Entry Box (OA850C only) 024-1007-01

I/O Box Door Gasket (OA850C only) 022-0122-01

I/O Entry Box and Door (OA1900C only) 024-1004-01

I/O Box Door Gasket (OA1900C only) 022-0127-01

I/O Box Gasket (OA850C only) 022-0124-01

Internal Lead Acid Back-up Battery 149-0852-01

PC Interface Cable DB9, 9-Pin, Female-to-
Female

187-0713-01

Modem Module (OA850C only) 087-1524-05

Modem Module (OA1900C only) 087-1524-01

Wireless Interface Cable To be announced.

BUPS-25/80 250-1011-07

Surge Protector - N(M) to N(F) Lightning Call RTI

Operations Manual (Hard Copy) 550-5100-01

Operations Manual (CD-ROM) 550-5100-02.

Alarm, Power, and Growth Cabinet Button Plugs 137-0446-01

Conduit Fitting 137-0447-01

Back Mounting Plate 020-1229-03

Stainless Steel 3/8” Locking Washer 125-0059-07

Stainless Steel 3/8” x 1” Flat Washer 125-0068-07

Stainless Steel Pin-in Head Security Bolts 125-0212-13

Stainless Steel Hex Head Bit Pin-in Head, 7/32” 129-0007-08



12-12 Repeater Technologies, Inc.—Company Confidential Chapter 12. Reviewing Technical Specifications

Table 12.22 (continued) Spare Parts and Accessory Items

To select a BUPS (Back-up Power System) for the repeater application, match the repeater with 
the amount of back-up time required.

Table 12-23 Back-up Power System Selection Guide

Table 12-24 Contents of AC and DC Accessory Kits, for OA1900C

Description Part Number

Door Hinge Set 137-0428-01

Allen Wrench 129-0007-02

RepeaterNet NMS Craft Software 519-1200-03

BUPS Power & Alarm Cable Assy (Kit) 187-0188-01

*  Typical antennas include parabolic reflectors, corner reflectors, circular, linear, directional 
   co-linears, cross or slant polarization, log periodic array, or Yagi.

Power Calculated Back-up Hours

Product Consumption Current BUPS-25/80

Model Number @ 24 Vdc @ 24 Vdc 25 A 80 A-H

OAxxx, 1-channel 260 W 10.8 A 7.4

OAxxx, 2-channel 500 W 20.8 A 3.8

AC Accessory Kit (P/N 091-0105-01) DC Accessory Kit (P/N 091-0105-02)

Items Quantity Items Quantity

Power Cord 1 each BUPS Power and Alarm Cable 
Assembly

1 each

Wrench, Hex Key (Allen Wrench) 1 each Wrench, Hex Key (Allen Wrench) 1 each

PC Interface Cable DB9, Female to 
Female

1 each PC Interface Cable 1 each

Hex Bit, Pin-in-Socket, 7/32” 1 each Hex Bit, Pin-in-Socket, 7/32” 1 each

Alarm, Power, and Growth Cabinet 
Button Plugs

4 each Alarm, Power, and Growth Cabinet 
Button Plugs

4 each

Conduit Fitting 4 each Conduit Fitting 4 each

Operations Manual (Hard Copy) 1 each Operations Manual (Hard Copy) 1 each

RepeaterNet Craft Software 4 disks RepeaterNet Craft Software 4 disks
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Table 12-25 Contents of AC and DC Accessory Kits, for OA850C

AC Accessory Kit (P/N 091-0105-01) DC Accessory Kit (P/N 091-0105-02)

Items Quantity Items Quantity

Power Cord 1 each BUPS Power and Alarm Cable 
Assembly

1 each

Wrench, Hex Key (Allen Wrench) 1 each Wrench, Hex Key (Allen Wrench) 1 each

PC Interface Cable DB9, Female to 
Female

1 each PC Interface Cable 1 each

Hex Bit, Pin-in-Socket, 7/32” 1 each Hex Bit, Pin-in-Socket, 7/32” 1 each

Alarm, Power, and Growth Cabinet 
Button Plugs

4 each Alarm, Power, and Growth Cabinet 
Button Plugs

4 each

Conduit Fitting 4 each Conduit Fitting 4 each

Operations Manual (Hard Copy) 1 each Operations Manual (Hard Copy) 1 each

RepeaterNet Craft Software 4 disks RepeaterNet Craft Software 4 disks



12-14 Repeater Technologies, Inc.—Company Confidential Chapter 12. Reviewing Technical Specifications

12.3 Technical Services

Repeater Technologies offers technical services, to supplement the manpower resources of its 
customers. RTI will provide quotations for the following services, upon request:
• Site and construction surveys.

• Network design.

• Design verification.

• Training.

• Installation.

• Accessories (antennas, coaxial cabling, and so on).
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Chapter 13 Programming the Cellular Phone

13.0 Introduction

This chapter describes how to program the Motorola Micro T.A.C. Elite II cellular phone. This 
phone is installed in the Entry Box of the repeater (the Entry Box is the separate housing 
attached to the bottom of the main repeater box). The cellular phone includes a battery, but the 
repeater provides normal operating power to the phone.

13.1 Removing the Cellular Phone for Programming

The cellular phone is located inside the lid of the repeater’s Entry Box (see Figure 13-1).

Figure 13-1 Motorola Micro T.A.C. Elite II Cellular Phone, Installed in Entry Box Lid

To remove the cell phone unit for programming, use the following procedure.
1. Open the lid of the repeater’s Entry Box.

2. Disconnect the power plug, located at the base of the phone.

3. Carefully pull the phone away from its cradle.
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13.2 Programming the Cellular Phone 

1. To program the cellular phone properly, install an AC charger, and a cell phone antenna.

2. Press the phone PWR (Power) button, to turn ON power to the cellular phone.

3. Press the FCN (Function) button, followed by 0.

NOTE: The factory Default Security Code is 000000. 

4. Enter the six-digit security code, TWICE.

5. Press the RCL (Recall) button on the cellular phone.

6. Press the Star (*) button.

The program advances to the first data field, for Entry 01 (the System ID).

7. Use the keypad to enter the new data for this field.

8. Repeat Steps 5 and 6 to advance to, and to set, each subsequent data field in the 
programming sequence.

Refer to Table 13-1 for the programming sequence.

9. Exit the programming mode.

• To exit the programming mode without saving changes, press the Pound (#) button.
• To save the newly-entered data, press the SND (Send) button, while on any entry 

number. After the cellular phone sends all entries, the sequence wraps around to Entry 
01.

10. Press the PWR (Power) button, to turn OFF power to the cellular phone.

13.3 Reinstalling the Cellular Phone, After Programming

After programming the cellular phone, use the following procedure to reinstall the unit in the 
Entry Box lid.
1. Remove the cellular battery and antenna from the phone.

2. Reconnect the plug, at the base of the phone.

3. Press the cell phone back into its cradle.

4. Secure the lid of the repeater’s Entry Box.
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Table 13-1 Data Sequence Programming

Entry 
Number

Standard 
Default Description

01 00000 System ID  (SID). The five-digit number that the FCC assigns, 
for system identification.  “A” side is odd; “B” side is even.

02 111 Cellular Area Code.  Assigned by the System Operator.

03 1110111 Cellular Telephone Number.  Assigned by the System 
Operator.

04 XX Station Class mark.

05 00 Access Overload Class.

06 00 Group ID Mark.

07 000000 User Security Code.

08 123 Unlock Code.

09 0334 Initial Paging Channel.  Enter 0333 for “A” side System IDs 
(SIDs), and 0334 for “B” side SIDs.

10 011100 Options Programming .  Binary bits (1 or 0), read from left to 
right.

0 Internal Speaker Disable.

1 Local Use.  Assigned by the System Operator.

1,0,? MIN Mark.

1 Auto Recall 1=enabled.

0 Second Telephone Number Enable .

0 Diversity 1=enabled.
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Appendix A Default Alarm Settings

Table A-1 Default Alarm Settings

Subsystem Option Alarm Default Setting

Front End Forward Fwd FE Alarm Critical

Reverse RevFE Alarm
RevFEProtect Alarm

Critical
Critical

Diversity DiversityFE Alarm Critical

Channel 1 Reverse PA Rev PA Alarm
Rev PA VSWR Alarm
Rev PA Thermal Alarm
Rev PA Ext Shutdown Alarm

Critical
Disabled
Major
Disabled

Forward PA Fwd PA Alarm
Fwd PA VSWR Alarm
Fwd PA Thermal Alarm
Fwd PA Ext Shutdown Alarm

Critical
Disabled
Major
Disabled

PA Control Reverse PA
Forward PA

OFF
OFF

Reverse Filter CSF Rev Alarm Event

Forward Filter CSF Fwd Alarm Event

Gain Forward and Reverse 65DB

Channel 2 Reverse PA Rev PA Alarm
Rev PA VSWR Alarm
Rev PA Thermal Alarm
Rev PA Ext Shutdown Alarm

Critical
Disabled
Major
Disabled

Forward PA Fwd PA Alarm
Fwd PA VSWR Alarm
Fwd PA Thermal Alarm
Fwd PA Ext Shutdown Alarm

Critical
Disabled
Major
Disabled

PA Control Reverse PA
Forward PA

OFF
OFF

Reverse Filter CSF Rev Alarm Event

Forward Filter CSF Fwd Alarm Event

Alarm Control 
Unit (ACU)

(*If the repeater uses 
external inputs or 
external equipment, set 
alarm severity as 
appropriate.)

External Input 1* Alarm
External Input 2* Alarm
Temperature Alarm
Tamper Alarm
Analog Input Alarm
Ext. Growth Box Alarm

Disabled
Disabled
Minor
Major
Disabled
Disabled
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Table A.1 (continued) Default Alarm Settings

Subsystem Option Alarm Default Setting

Power Supply Channel  PS Input Power 
Power Supply Alarm
Battery Alarm

Critical
Critical
Minor

Backup Power 
Supply (BUPS)

AC Fail Alarm
Low Battery Alarm
High Battery Alarm
Charge Fail Alarm
UPS Summary Alarm
Tamper Alarm

Disabled
Disabled
Disabled
Disabled
Disabled
Disabled

Modem Modem Alarm Minor

Cell Phone Cell Phone Alarm Minor
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Appendix B Troubleshooting

B.1 Verifying Correct Installation

This section summarizes how to verify that the repeater is correctly installed.

Isolating the Primary Cabinet

1. Disconnect EVERYTHING from the OA1900C, except the Back-up Power Supply (BUPS).

2. Power the repeater on.

3. Start the RepeaterNet software, pull down the Configuration  menu, and select 
Hardware.

4. Uncheck growth box , if it is checked.

5. Exit RepeaterNet.

6. Restart RepeaterNet.

7. Turn on the Power Amplifier (PA) gains, and make sure that everything in functioning.

8. Turn off the PAs.

9. Exit RepeaterNet.

This test verifies that the primary cabinet is working properly.

Testing the Primary Cabinet, with Antennas

1. Connect the antennas to the repeater, one at a time. 

2. Start the RepeaterNet software, and make sure that no alarms are currently reported.

3. Turn on the PAs, and adjust gains.

4. Turn off the PAs.

5. Exit RepeaterNet.

6. Disconnect the antennas.

This test verifies that the primary cabinet and antennas are working properly.

Isolate the Primary and Growth Cabinets

1. Connect the Growth Cabinet to the Primary Cabinet.

2. Power on ONLY  the Primary Cabinet, and ensure that the connector is at +24 Volts DC.

NOTE: This step does not work on OA1900C repeaters that have small entry boxes.

3. With the multimeter still monitoring +24VDC, turn on the Growth (secondary channel) 
Cabinet.

4. If all is well, place the meter on the BUPS amps test port, and monitor the current.
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5. Set the multimeter for "mV" range. 

NOTE: On the BUPS, 1mV = 1 AMP.

6. Start the RepeaterNet software, pull down the Configuration  menu, and select 
Hardware.

7. Check the growth box selection.

8. Exit RepeaterNet.

9. Restart RepeaterNet, and check for secondary-channel function.

If there is no growth box function, check +24VDC, at the input to the second channel, then 
check the ribbon cable for reverse-polarity. Finally, repeat Step 6.

10. Turn on the PAs (without antennas), and monitor the multimeter to ensure that the current 
is still within normal limits.

NOTE: The BUPS is designed for 25AMPS.

11. Turn off the PAs.

This test verifies that the primary and growth cabinets are working properly.

Loaded Test

1. Connect the antennas.

2. Turn on all Power Amplifiers (PAs).

3. Monitor the BUPS current.

NOTE: The following error conditions might occur during these tests.

1. One or both channels are oscillating, drawing more current than the BUPS can provide. If 
this occurs, the PAs off, and check whether DC power returns to both repeater units.

2. The antenna cables might be shorted, causing the PA to draw more current than the BUPS 
can provide. If this occurs, disconnect the antennas, and ohm out the connectors.

3. The BUPS has failed. It cannot handle the load of both the Primary and Growth cabinets.
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B.2 Verifying Correct Operation

This section describes some of the problems that you might encounter while operating the 
RepeaterNet system. The steps listed (to resolve the problem) might not include all of the 
possible reasons for non-operability, but this information is provided to assist you in 
identifying the actual difficulty. The problem attributes in the following paragraphs are in 
descending order, starting with the most likely problem listed first.

If the repeater continues to have problems, call Repeater Technologies Customer Support for 
assistance. See the front cover of this manual, for current telephone numbers.

Problem 1 RepeaterNet reports that it cannot open the database.

Either the Data Source Name (DSN) is configured improperly, the DSN does not point to the 
proper location, or the system did not find the DSN itself. Call Customer Support for 
assistance.

• The correct DSN or User ID is not identified.
• The Windows Open DataBase Connectivity (ODBC) drivers are not installed.
• The database file, to which the DSN points, is corrupted, or needs repair.

Problem 2 RepeaterNet reports that it cannot read the database Ports table.

You have not configured the ports, in the system database.

The Ports table in the database might be corrupted. Repair the database and retry.

Problem 3 The System starts up without error, but when you launch a repeater graphical user 
interface, no detailed data appears.

Wait for up to 4 minutes (the maximum time required to complete a cell modem connection), 
to determine whether the program can connect to the repeater. If the program cannot 
connect, a warning pops-up after 4 minutes, indicating that RepeaterNet could not establish 
communications.

Problem 4 A specific port does not seem to be in use, and an Alert exists. Or the database log 
reports the error “Unable to initialize port COMn”, where n designates the non-
functioning port.

You configured the port number incorrectly, or the port does not exist.

The port is assigned to another program, operating in the same PC. Windows does not 
permit two active programs to share a communications port. Shut down the other program.
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Problem 5 The system reports “Unable to connect to repeater...”

This error message can indicate any of the following:

• The cellular carrier is not handling the call.
• The phone number that you provided is incorrect, or is out of service.
• The modem or phone line has a problem.
• The repeater itself has a problem.

Problem 6 The system reports the message “An unsupported operation was attempted.”

This message appears if the installation failed to register the Object Linking and 
Embedding (OLE) controls, for alarm bitmaps.

Problem 7 RepeaterNet conflicts with Microsoft Fax.

To disable the Microsoft Fax auto answer mode:

1. Open the mail icon from the Microsoft Control Panel.

2. Select Microsoft Fax from the Services tab.

3. Click on the Properties button.

4. Select either the Manual or the Don’t answer radio button.

5. Click the OK button, to save this change.
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B.3 Verifying Primary and Secondary Channels

B.3.1 Test Equipment

Table 1-2 lists the test equipment and tools required for verifying both traffic channels. You can 
use equivalent substitutes for the tools listed here.

Table 1-2 Test Equipment for Channel Verification Tests

B.3.2 Applying Power

1. Terminate the antenna ports on the Repeaters, using Type N (male) 50-ohm Terminations.

2. Connect the laptop to the repeater.

3. Apply power to the Primary Cabinet, either AC or DC, as required.

4. Check that both the Critical LED and the Minor LED (on the entry panel of the Main 
Repeater) are ON.

NOTE: When Repeater Technologies ships the repeater from the factory, the Forward PA (Power 
Amplifier) and Reverse PA are both in the OFF position. The standby battery (located 
inside the Entry Panel) is disconnected.

5. Connect the red battery lead, to the standby NiCad battery.

Item Tests

Voltmeter, Fluke 75 Power System, Analog Test Points

Power Meter, HP 435B with 8481 Sensor Power Output

Spectrum Analyzer, HP 8560 series,
capable of up to 2 GHz

Power Output

Type N (male) 50-Ohm Termination, 20W, (2 ea.) Power Output

Signal Generator, capable of generating CW signal of 
+10 dBm or greater, at 800 MHz or greater frequencies

Power Output

Laptop computer RepeaterNet configurations

Type N (m) 30 dB pad, or bi-directional 30 dB coupler Power Output

Open End Wrench or Spanner, 5/16 inch (1 ea.)* Power Monitor, Maintenance

Screwdriver, 1/4 inch, 6 mm blade* Wiring, Maintenance

Screwdriver, #1 Phillips Wiring

* Not supplied with Growth Box.
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B.3.3 Measuring Voltage

Measure the AC or DC voltage, at the J3 connector in the Entry Panel, to verify the proper 
voltage.

B.3.4 Measuring the Output

This section covers the testing required, to determine proper operation of the Repeater and the 
Growth Box.
1. Start the RepeaterNet software.

NOTE: You must use the RepeaterNet Craft Admin program, to configure the connection to the 
Repeater and the Growth-Box, before you can access the RepeaterNet Craft software.

2. Select Configuration/Hardware Setting  from the RepeaterNet menus, to ensure that the 
Growth-Box configuration is enabled (see Figure 6-2).

.

3. Check the “Growth-Box is attached” box, and click the OK button. 

Figure 6-2 Hardware Setting Screen
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4. Select Configuration/Channel 1 from the RepeaterNet menu, and select the Channel # 
tab to display and set the operating channel. 

5. After selecting a channel #, click the Apply button. 

RepeaterNet displays the corresponding frequencies. Record these frequencies; you will use 
them when you set up the Signal Generator.

6. Select Configuration/Channel 2 from the RepeaterNet menu, and select the Channel # 
tab to display and set the operating channel. 

7. After selecting a channel #, click the Apply button. 

RepeaterNet displays the corresponding frequencies. Record these frequencies; you will use 
them when you set up the Signal Generator.

Figure 6-3 Channel Properties Screen, 
Channel # Tab
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8. Verify that the Reverse Power Amplifier is OFF, using the Rev PA tab in the Channel 
Properties screen, for both channel 1 and channel 2 (as shown in Figure 6-4). 

9. Verify that the Forward Power Amplifier is OFF, using the Fwd PA  tab in the Channel 
Properties screen, for both channel 1 and channel 2 (as shown in Figure 6-5). 

Figure 6-4 Channel Properties Screen, 
Reverse PA Tab

Figure 6-5 Channel Properties Screen, 
Forward PA Tab
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10. Using the Gain tab in the Channel Properties screens for both Channels 1 and 2, set the 
channel gains to the minimum setting of 65 dB (see Figure 6-6).

Figure 6-6 Channel Properties Screen, 
Channel Gain Tab
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B.3.5 Verifying Forward Power Out, Channels 1 and 2

Configure the test equipment as shown in Figure 6-7.

Figure 6-7 Configuration for Measuring Forward Path Power

1. Ensure that the Forward PA (Power Amplifier) is turned OFF, for both the repeater and the 
Growth Cabinet.

2. Set the Signal Generator to the channel 2 forward frequency, to verify that the second 
(growth cabinet) channel works.

3. Set the Signal Generator output level to -56 dBm.

4. Configure the Spectrum Analyzer, so that the measurement includes the 30 dB attenuation 
of the coupler.

5. Using the RepeaterNet software, ensure that the repeater channel frequency corresponds to 
the Signal Generator frequency.

RT111903
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Setting the Channel Gain to 95 dB

Perform the following procedure for both Channels 1 and 2.
1. In RepeaterNet, select Configuration, Channel 1 and 2.

The Channel Properties screen opens.

2. Click the Gain tab.

3. Click and drag the Forward horizontal sliders, until they are set to 95 dB.

The gain value box (centered under the slider) displays the selected gain.

4. Click the Apply button.

The Apply button sets the gain.

5. Click the OK button.

The OK button closes the window.

Turning On the Forward Power Amplifiers

1. In RepeaterNet, select Configuration, Channel 1 and 2.

The Channel Properties screen opens.

2. Click the PA Control tab.

The PA Control tab provides a switch to turn Power Amplifier (PA) power either ON or OFF.

3. Click on the value in the Forward PA box, to change the value to ON.

4. Click the Apply button.

The Apply button turns on Forward PA power.

5. Click the OK button.

The OK button closes the window.

Measuring Forward PA Power

1. Observe the Spectrum Analyzer display. The amplitude of the signal should be +38.5 dBm, 
to within +0.5 dB.

2. Turn off the Forward PAs.

3. Set the Forward Channel Gain to 65 dB.
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B.3.6 Verifying Reverse Power Out, Channels 1 and 2

Configure the test equipment as shown in Figure 6-8.
1. Ensure that the Reverse PA (Power Amplifier) is turned OFF, for both the repeater and the 

Growth Box.

2. Set the Signal Generator to the channel (1 or 2) forward frequency.

3. Set the Signal Generator output level to -77 dBm.

4. Configure the Spectrum Analyzer, so that the measurement includes the 30 dB attenuation 
of the coupler.

5. Using the RepeaterNet software, ensure that the repeater channel frequency corresponds to 
the Signal Generator frequency.

Figure 6-8 Configuration for Measuring Reverse Path Power

RT111902



Appendix B. Troubleshooting Repeater Technologies, Inc.—Company Confidential B-13

A
p

p
en

dix B

Setting the Channel Gain to 95 dB

Perform the following procedure for both Channels 1 and 2.
1. In RepeaterNet, select Configuration, Channel 1 and 2.

The Channel Properties screen opens.

2. Click the Gain tab.

3. Click and drag the Reverse horizontal sliders, until they are set to 95 dB.

The gain value box (centered under the slider) displays the selected gain.

4. Click the Apply button.

The Apply button sets the gain.

5. Click the OK button.

The OK button closes the window.

Turning On the Reverse Power Amplifiers

1. In RepeaterNet, select Configuration, Channel 1 and 2.

The Channel Properties screen opens.

2. Click the PA Control tab.

The PA Control tab provides a switch to turn Power Amplifier (PA) power either ON or OFF.

3. Click on the value in the Reverse PA box, to change the value to ON.

4. Click the Apply button.

The Apply button turns on Reverse PA power.

5. Click the OK button.

The OK button closes the window.

Measuring Reverse PA Power

1. Observe the Spectrum Analyzer display. The amplitude of the signal should be +18 dBm, to 
within +0.5 dB.

2. Turn off the Reverse PAs, and set the Reverse Channel Gain to 65 dB.

B.3.7 Concluding the Test

1. Exit the RepeaterNet software.

2. Turn off power to the repeater.

3. Disconnect the Spectrum Analyzer, the pad or coupler, and the Signal Generator.
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Glossary

This glossary defines communications industry acronyms, symbols, and terms. Hardware-
related and software-related acronyms are also included. Because this glossary supplements all 
operations manuals from Repeater Technologies, not all items listed here necessarily appear in 
this manual.

A Amp or Amps.

ACU Alarm Control Unit.

ALC Automatic Level Control.

AMPS Advanced Mobile Phone System.

API Application Programming 
Interface.

BACK-BEAM A back-beam antenna transmits 
energy backward, towards the 
donor BTS. This increases the 
allowable distance between the 
donor BTS and repeater sites, in 
CDMA networks.

BNC Type of connector.

BTS Base Transceiver Station.

BUPS Back-Up Power Supply.

CDMA Code Division Multiple Access.

C/E Carrier-to-Echo Ratio.

C/I Carrier-to-Interface Ratio. The 
ratio between the mean signal 
level of the desired radio signal, 
and the signals from other 
(interfering) sources. Typically 
expressed in dB.

CPC Circular Plastic Connector.

CRC Cyclical Redundancy Check.

CSM Cell Site Modem.

DAMPS Digital Advanced Mobile Phone 
System (equivalent of TDMA).

DARLINGTON 
PAIR

Two transistors, arranged so 
that the emitter of one drives 
the base of the other, and 
connects the collectors together. 
The result is an increase in gain 
compared to a single transistor, 
because the gains of the two 
transistors are multiplied 
together. The trade-off for this 
increased gain is reduced speed, 
because of the very high gain's 
effect on the collector-to-base 
capacitance. You can use this 
pair of transistors as a single 
transistor: common emitter, 
emitter follower, and so on. 

dB Decibel or decibels.

dBC Decibels, referenced to the 
carrier level.

dBi Decibels, referenced to the 
isotropic antenna.

dBm Decibels, referenced to one 
milliwatt.

DF, DFB Distributed Feedback (Laser).

DONOR An antenna that communicates 
between a repeater and a BTS.

DSN Data Source Name. A name that 
represents the database file (or 
connection).

DVM Digital Voltmeter.

EM Electromagnetic.
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EMI Electromagnetic Interference.

ERP Effective Radiated Power.

F/B Front-to-Back Ratio.

FCC Federal Communications 
Commission (USA).

FE Front End.

FIFO First In First Out.

FORWARD 
DIRECTION

Direction of transmission from 
the base station, through the 
Repeater, and on to Mobile or 
hand-held units. Downlink 
transmission.

FORWARD 
GAIN

Gain setting for Forward 
(downlink) transmissions.

FRU Field Replaceable Unit

FSK Frequency-Shift Keying.

GAIN Number of decibels by which a 
repeater amplifies an audio 
(speech) signal, when 
transmitting it to (reverse gain) 
or from (forward gain) a base 
station (BTS).

GSM Global System for Mobile 
Communications, or Groupe 
Speciale Mobile.

GUI Graphical User Interface.

HAND-OFF On a cellular system, the act of 
transferring a call in progress, 
from one cell or sector to 
another. Typically also involves 
changing to a different voice 
channel.

HBW Horizontal Beam Width of an 
antenna.

HOT TONE If a Mobile transmits at full 
power in close proximity to a 
receive antenna, a hot tone—for 
example, a receive signal above -
40 dBm—is produced. Too hot a 
tone can over-modulate a 
system, and force it to drop all 
calls. If a system is designed to 
control reverse attenuation, it 
can moderate the potentially-
damaging effect of hot tones.

HPP Half Power Point of an antenna.

IF Intermediate Frequency.

IM Intermodulation.

IMD Intermodulation Distortion.

LED Light-Emitting Diode.

LESS Link Engineering Spread Sheet. 
Controls signal noise and gain 
between the base transceiver 
station (BTS) and the repeater.

LNA Low Noise Amplifier.

LO Local Oscillator, high-level 
input into mixer.

LOS Line-Of-Sight.

MICROCELL Any small, low-power cell site.

MORPHOLOGY The structure (layout) of the 
repeater coveragre area. 
Morphology factors include 
natural signal-path obstructions 
(trees and hills), man-made 
obstacles (buildings and 
billboards), distance between 
the repeater and the base 
station, number of cell-phone 
users within the repeater 
coverage area, and coverage 
inside buildings and tunnels.
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MPRL Maximum Power radiation 
Limit of an antenna.

MSC Mobile Switching Center 
(equivalent to MTSO).

MTSO Mobile Telephone Switching 
Office (equivalent to MSC).

MULTIPATH Radio propagation between a 
transmitter and receiver, where 
the received signal contains 
multiple rays. Each ray has 
undergone one or more 
reflections and/or refractions. 
Cellular coverage is usually 
multipath, especially in high-
density city areas.

NIM Noise Injection Margin. The 
amount of noise (dB) that a 
repeater injects into the CDMA 
air interface.

NR Network Repeater.

ODBC Open DataBase Connectivity. 
An Application Programming 
Interface (API) in Windows, 
that lets a programmer abstract 
a program from a database.

OLE Object Linking and Embedding. 
Integrates applications, and 
permits copying objects from 
one application to another. Uses 
the first application’s editing 
techniques, when editing a 
copied object in the second 
application.

OTU Optical Transceiver Unit.

PA Power Amplifier.

PAGING 
CHANNEL

Passes parameters over a 
CDMA network, during 
operation.

PEP Peak Envelope Power.

PILOT 
CHANNEL

Measures power, and performs 
initial synchronization, over a 
CDMA network.

PLL Phase Locked Loop.

PSTN Public Switched Telephone 
Network.

QCCB Quick-Connect Connecting 
Block.

RBS Radio Base Station. See also 
BTS.

REVERSE  
DIRECTION

Direction of transmission from 
the Mobile or portable, through 
the repeater, and on to the RBS. 
Uplink transmission.

REVERSE  
GAIN

Gain setting for Reverse 
(uplink) transmissions.

RF Radio Frequency.

RFI Radio Frequency Interference.

RMA Returned Materials 
Authorization. Issued before you 
return a repeater to RTI for 
upgrading.

ROT Rise Over Thermal. The amount 
of increase in noise level (dB) at 
the BTS, that the repeater 
creates.

RPE Radiation Pattern Envelope. 
Defines the attenuation of side-
lobe energy from an antenna.

RSL Receive Signal Level.

RSA Rural Service Area.

RSSI Receive Signal-Strength 
Indicator.

RTI Repeater Technologies, Inc.

RX Receive.

SID System ID. A five-digit number 
that the FCC assigns for system 
identification.

SIMULCAST The process of transmitting the 
same signal from two or more 
sites simultaneously.

SMA A type of connector.

SMB A type of connector.
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SUBSCRIBER An antenna that communicates 
between a repeater, and either a 
cellular phone or another 
repeater.

SYNC 
CHANNEL

Passes parameters, during 
initial synchronization of a 
CDMA network.

TDMA Time Division Multiple Access 
(equivalent to DAMPS).

TRAFFIC 
CHANNEL

Carries communications traffic 
over a CDMA network.

TSA Traffic Service Area.

TX Transmit.

UCU Universal Control Unit.

UHF Ultra High Frequency.

UPS Uninterruptable Power Supply. 
The BUPS is a type of UPS.

V Volt or Volts.

VAC Voltage, Alternating Current.

VDC Voltage, Direct Current.

VOCODER A vocoder, or voice coder, divides 
speech signals into various 
bands of the audio spectrum, 
compresses and encrypts the 
resulting audio segments, and 
transmits the digitized speech 
over a cellular (wireless) 
network. The cellular phone 
(receiver) decrypts, 
decompresses, and reassembles 
the transmitted audio segments, 
to sound like normal (analog) 
speech again. To receive and 
retransmit speech signals 
between base stations (BTS), an 
RTI repeater needs to know the 
transmission rate and frequency 
that the vocoder uses on the 
specific cellular network. Use 
the Link Engineering 
Spreadsheet (LESS) to report 
this information to the repeater.

VSWR Voltage Standing Wave Ratio.

W Watt or Watts.

XPD Cross Polarization.
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selecting 12-12
setting alarms 10-26
wiring 9-11

buttons
cell phone function 13-2
cell phone Pound 13-2
cell phone power 13-2, 13-2
cell phone recall 13-2
cell phone send 13-2
cell phone Star 13-2
FCN 13-2
Pound 13-2
PWR 13-2, 13-2
RCL 13-2
SND 13-2
Star 13-2

C
cabinets

growth 5-14, 5-14
cables

AC 6-32
alarm 6-8
alarms 6-25, 6-26
conduit 6-19, 6-21
DC 6-32
growth cabinet 6-32
horizontal mount 6-27, 6-27
insertion loss 4-12
power 6-19, 6-21 to 6-23, 6-32, 6-39
return loss 4-12
RF 4-7, 6-3, 6-3, 6-8, 6-23, 6-27, 6-31, 6-38
RF/Connect 6-19, 6-19 to 6-21
sweeping antenna 4-12
threading 6-31
vertical mount 6-28, 6-28

cabling
coaxial 12-6

CDMA networks
timing 11-1

CDMA repeaters
link engineering 4-1

cell phone
installing 13-2
removing 13-1

Cell Phone Status screen 10-33
cell phones 13-3

Access Overload class 13-3
alarms 7-11
area codes 13-3
checking properties 7-11

data sequence programming 13-3
diversity 13-3
FCN button 13-2
Group ID marks 13-3
internal speakers 13-3
introduction 13-1
local use 13-3
MIN marks 13-3
Motorola Micro TAC Elite II 13-1
paging channels 13-3
Pound button 13-2
programming 13-1
programming options 13-3
properties 10-23
PWR button 13-2, 13-2
RCL button 13-2
repeater entry boxes 13-1, 13-2
second number 13-3
security codes 13-2, 13-3
setting alarms 10-23
SND button 13-2
speakers 13-3
Star button 13-2
Station Class marks 13-3
status 10-33
system ID 13-3
telephone numbers 13-3
timing 11-1
unlock codes 13-3

Cellular Phone Properties screen 7-11, 7-11, 10-23
cellular phones

(see cell phones)
Channel # tab 7-8, 10-14
Channel Filter Status screen 10-30, 10-30, 10-30
channel filters

status 10-30
Channel Forward Filter

alarms 7-7
Channel Forward Filter tab 7-7, 10-14
Channel Forward PA tab 10-12
channel gain

setting B-11, B-13
Channel Gain tab 7-8, 10-15
channel PA

status 10-30
Channel PA Control tab 10-13
Channel Properties screen 7-5, 10-10, 10-11, 10-14,
B-8
Channel Reverse Filter

alarms 7-7
Channel Reverse Filter tab 7-7, 10-13
channel search window
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width 11-3
channels

checking 7-5
paging 13-3
properties 10-10
traffic 11-4

characteristics
electrical 12-1, 12-3
mechanical 12-1, 12-3
OA1900C 12-4
OA850C 12-2

Charger Fail alarm 10-26, 10-34
chargers

BUPS 9-9, 9-13
check list 2-1
checking

ACU 7-9
batteries 8-11
cell phone properties 7-11
channels 7-5
front end 7-4
modem properties 7-10
properties 7-2
tower hazard lights 8-12, 8-13
UPS properties 7-12

chips
modem (see CSM modem chip)

circuit breakers
BUPS 9-12
DC power 9-7

classes
Access Overload 13-3
Station 13-3

closing
RepeaterNet 10-47

coaxial cabling 12-6
mounting 5-2

codes
cell phone security 13-2, 13-3
cell phone unlock 13-3

collecting data
drive testing 11-5

color-independent icons 10-6, 10-43
commands

About 10-44
Alarm and Event Log 10-43
Alarm Sounds 10-43
Download Properties 10-35
Exit 10-39, 10-47
Find 10-47
Help Topics 10-44
Properties 10-39

Update Repeater Firmware 10-37
Upload Properties 10-36

concluding
repeater tests B-13

conduit cables
Liquidtight 6-19, 6-21

conduits
Liquidtight 9-7
strain-relief 9-2, 9-3

configuration files 10-35 to 10-36
saving 6-13

Configuration Files folder 6-13
Configuration menu 10-39

Craft software 10-5
configurations

antennas 4-2
OA1900C 12-7, 12-9
OA850C 12-6

configuring
alarm severity 10-7
growth cabinet 6-40
properties 10-8
repeater connections 10-2
repeaters 10-1
subsystems 10-5

conflicts
MicroFax B-4

connecting
BUPS 9-10
external alarms 8-1
ground 6-37
growth cabinet 6-19
power 6-34, 6-35, 6-36
power source 9-1
RF Cables 6-27

connections
configuring 10-2
troubleshooting B-4

connectors
alarms 6-26, 8-1
antenna interface 12-6
digital inputs 8-1
J1 8-1, 8-13
J2 8-1
J22 8-1
J23 8-1
Liquidtight 6-19 to 6-21, 6-21 to 6-23
power 6-33
relays 8-1, 8-1
RF type one 6-29
RF type two 6-30

contacting
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RTI ii, 2-1
Contents tab 10-45
control

RepeaterNet 12-2, 12-4
wiring 8-1

control screen
alarm status 10-6
Craft software 10-3, 10-3

Control tab 10-27
controlling

blowers 8-7
channel PAs 10-13
digital outputs 8-4
fans 8-7
lamps 8-7
relay outputs 8-6

controls
I/O 10-17

cords
AC power 9-3, 9-3
American power 9-6
international power 9-6

correct installation
verifying B-1

couplers
directional 4-9

coverage
equation 11-3

Craft software 2-1, 10-1
Configuration menu 10-5
installing 10-1
main control screen 10-3, 10-3
requirements 10-1
starting 10-3

Craft window 10-3
critical alarms

relays 8-9
CSM modem chip 11-3
customer support

services 12-14

D
damage

reporting 1-1
data

collecting in drive test 11-5
data sequence programming

cell phones 13-3
databases

MTSO 11-4
repeaters 11-4
troubleshooting B-3

DC
input voltage 8-13
monitoring power 8-13
power cables 6-32
power connections 6-36
voltage threshold 10-18

DC accessories
OA1900C 12-12
OA850C 12-13

DC power
circuit breakers 9-7
entry boxes 9-8, 9-8
fuses 9-7
power plants 9-7
wiring 9-7

default settings
alarms A-1

defining
alarm severity 10-7
gain 10-15

definitions Glossary-1
delays

differential 11-2
descriptions

I/O 10-16
diagrams

BUPS 9-9
differential delay

equation 11-2
digital inputs 8-1, 8-11

voltages 8-12
digital outputs 8-4
directional couplers 4-9
disable input

PAs 8-14
disabling

cell phone speakers 13-3
diversity

antennas 4-6
cell phones 13-3

diversity FE
tabs 10-10

Diversity FE alarm 10-29
Diversity Front End Status screen 10-29
donor antennas 12-6
donor BTS

measuring idle power 3-2
measuring power 3-1
reverse link 11-3

donor BTS loaded power
measuring 3-3

donor BTS power



Index-vi Repeater Technologies, Inc.—Company Confidential Index

measuring equipment 3-2
donor BTS signal

measuring 3-1
doors

electronic lock 8-5
Download Properties command 10-35
downloading

configuration files 10-35 to 10-36
firmware 6-16, 10-38

drive testing
collecting data 11-5
equipment 11-5
repeaters 11-5

dual-polarized subscriber antennas 4-3

E
electrical characteristics 12-1, 12-3

OA1900C 12-3
OA850C 12-1

electrical power 12-6
electronic door lock 8-5
Elite II

cell phones 13-1
enabling

diversity 13-3
PAs 6-41
second cell phone number 13-3

ending
RepeaterNet session 10-47

engineering
CDMA repeater links 4-1

entry boxes
cell phones 13-1, 13-2
grounding lugs 5-11, 9-15
OA850 9-8, 9-8
primary cabinet 9-6

equations
differential delay 11-2
repeater coverage 11-3
TOA 11-4

equipment
drive testing 11-5
measuring antenna isolation 4-10, 4-11
measuring BTS power 3-2
mounting 5-2
required 1-1, 1-2
testing repeaters 7-1
verifying repeaters B-5

events
log 10-43

Exit command 10-39, 10-47
exiting

RepeaterNet 10-47
exterior

wiring 9-7
external alarms

connecting 8-1
pins 8-2

external DC input voltage 8-13
External DC Voltage tab 10-18
External Growth Box alarm 10-31
External Input alarms

ACU 10-31
external shutdown alarm

forward PA 10-12
reverse PA 10-11

F
fans

controlling 8-7
fault distance

antenna cables 4-12
FAX

RTI ii
FCN button

cell phones 13-2
FEs

diversity 10-10, 10-29
forward 10-9, 10-28
reverse 10-9, 10-29

File menu 10-35
files

configuration 6-13, 10-35 to 10-36
firmware upgrade 6-15

filters
channel 10-30
channel forward 7-7, 10-14
Channel Forward alarms 7-7
channel reverse 7-7, 10-13
Channel Reverse alarms 7-7

Find command
results 10-47

Find Setup Wizard 10-46
Find tab 10-46
firmware

downloading 6-16, 10-38
saving 10-38
updating 10-37
upgrading 6-11
uploading 6-15

firmware update
verifying 6-17

firmware upgrade file 6-15
flashing
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alarm lamps 8-10
folders

configuration files 6-13
forward

channel filter 7-7
channel filter alarms 7-7

forward channel filters 10-14
forward FE

tabs 10-9
Forward FE alarm 10-9, 10-28
Forward Filter alarm 10-14
Forward Front End Status screen 7-4, 10-28
Forward PA

alarms 7-6, 10-12
Forward PA External Shutdown alarm 10-12
Forward PA tab 7-6
Forward PA Thermal alarm 10-12
forward PAs 8-14, B-10

measuring power B-11
turning on B-11

forward path
measuring power B-10

frequencies
OA1900C 12-3
OA850C 12-1

front end
(see also FEs)
alarms 7-5
checking properties 7-4
properties 10-9

Front End Status screen 10-28
function button

cell phones 13-2
functional repeater test 7-1
fuses

DC power 9-7

G
gain

channel tab 7-8
channels 10-15
setting B-11, B-13

glossary Glossary-1
graphical user interface

(see GUI)
ground

connecting 6-37
grounding

BUPS 9-16
input power 5-11, 9-15
repeaters 5-11, 9-15

grounding lugs 5-11, 9-15

BUPS 9-16
primary cabinet 5-12, 9-16

Group ID marks 13-3
growth box

(see growth cabinet)
Growth Box Input Power alarm 10-25
Growth Box Power Supply alarm 10-25
growth cabinet

accessories 6-4
accessory kit 6-3
alarms 10-31
BUPS 5-15
configuring 6-40
connecting 6-19
connecting power 6-34
hardware settings 6-40
horizontal mount 6-8 to 6-9
horizontal mounting 5-14
installing 6-1
installing cables 6-32
introduction 6-1
mounting 5-14, 5-14, 6-8
mounting housing 6-25
OA1900 6-2
power cables 6-32
power connector 6-33
RepeaterNet software 6-40
RF cables 6-3, 6-31, 6-38
RF/Connect cable 6-19 to 6-21
testing B-1
threading cables 6-31
tools 6-3, 6-5 to 6-7
verifying B-5
vertical mount 6-10 to ??
vertical mounting 5-14

GUI
troubleshooting B-3

guide bolt
mounting 5-6

H
hardware

mounting 5-7
pole mounting 5-10
settings 10-8

hardware settings
growth cabinet 6-40

hazards
tower lights 8-12, 8-13
tower warning lights 8-11

help
contents 10-45
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find 10-46
index 10-45

Help menu 10-44
Help Topics command 10-44
High Battery alarm 10-26, 10-34
horizontal

wall installation 9-2
horizontal mount

cable connections 6-27
growth cabinet 6-8 to 6-9

horizontal mounting
growth cabinet 5-14

housing
growth cabinet 6-25
installing 6-29 to 6-30

I
I/O

OA1900C 12-5
OA850C 12-2
terminals 8-1

I/O Controls tab 10-17
I/O Descriptions tab 10-16
I/O pins 8-3
icons

alarms 10-6
color-independent 10-6, 10-43

ID
cell phone groups 13-3
cell phones 13-3

idle power
donor BTS 3-2

Index tab 10-45
indicators

LEDs 12-5
indoors

wiring 9-1
input power

grounding 5-11, 9-15
growth cabinet 10-25

Input Power alarm 10-24, 10-33
Input/Output

(see I/O)
inputs

analog 8-13, 10-31
battery monitor 8-11
DC voltage 8-13
digital 8-1, 8-11, 8-12
disable PAs 8-14
external 10-31
OA1900C 12-5
OA850C 12-2

power 9-1
insertion loss

antenna cables 4-12
inside

wiring 9-1
inspecting

repeaters 1-1
installation

overview 5-1
typical 5-2
verifying B-1

installing
AC power cords 9-3, 9-3
AC wiring 9-1
alarm cables 6-8
bell housing 6-29 to 6-30
cell phones 13-2
DC wiring 9-7
external alarms 8-1
growth cabinet 6-1, 6-5 to 6-7
growth cabinet cables 6-32
growth cabinet with OA1900 6-2
horizontal 9-2
lock nut 9-4
power cables 6-32
RepeaterNet Craft software 10-1
repeaters 10-1
RF cables 6-8, 6-23, 6-31
strain-relief conduit 9-2, 9-3
wall 9-2

installing repeaters 2-1
accessory kit 1-3
overview 2-1
required equipment 1-1, 1-2

interfaces
antenna connectors 12-6

interior
wiring 9-1

internal speakers
cell phones 13-3

international
power cords 9-6

introduction
cell phones 13-1
growth cabinet 6-1
measuring BTS power 3-1
power source 9-1

intrusion alarm 8-5
inventory

accessory kit 1-3
repeaters 1-1, 10-41

isolating
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primary cabinet B-1
repeaters B-1

isolation
measuring 4-9, 4-10, 4-11
repeaters 11-1

J
J1

connectors 8-13
J1 connector 8-1
J18 receptacle 9-5
J2 connector 8-1
J22 connector 8-1
J23 connector 8-1

K
kits

accessory 1-3, 6-3
banding 5-9
pole mounting 5-9

L
lamps

alarms 8-10
controlling 8-7

LED indicators
OA1900C 12-5

LESS
lightning protection 4-7

lightning
protection 4-7, 4-7

lightning arrestors 4-7
lightning protection

LESS 4-7
lights

tower hazard 8-11, 8-12, 8-13
link engineering 11-1

CDMA repeaters 4-1
Liquidtight

conduit cables 6-19, 6-21
conduits 9-7
connectors 6-19 to 6-21, 6-21 to 6-23

loaded power
donor BTS 3-3

loaded tests
repeaters B-2

local use
cell phones 13-3

lock nut
installing 9-4

locks
electronic 8-5

login
repeaters 10-42

logs
alarm 10-43
event 10-43

loss
insertion 4-12
return 4-12

Low Battery alarm 10-26, 10-34

M
main cabinet

(see primary cabinet)
main control screen

alarm status 10-6
Craft software 10-3, 10-3

marks
Group ID 13-3
MIN 13-3
Station Class 13-3

McMaster-Carr 5-8
Measurements tab 10-27
measuring

ACU 10-32
antenna isolation 4-9, 4-10, 4-11
donor BTS idle power 3-2
donor BTS loaded power 3-3
donor BTS power 3-1
donor BTS signal 3-1
forward PA power B-11
forward path power B-10
output B-6
PAs 10-31
reverse PA power B-13
reverse path power B-12
using pilot scanner 3-3
voltage B-6

measuring BTS power
equipment 3-2
introduction 3-1

measuring power
spectrum analyzer 3-3

mechanical characteristics 12-1, 12-3
OA1900C 12-3
OA850C 12-1

menus
Configuration 10-5, 10-39
File 10-35
Help 10-44
Options 10-43
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RepeaterNet 10-35
System 10-39

Micro TAC
Elite II cell phones 13-1

Microsoft Fax
repeater conflicts B-4

MIN marks 13-3
Mobile Telephone Switching Office

(see MTSO)
Mobile_TX parameter 11-5
modem chip

(see CSM modem chip)
Modem Properties tab 7-10, 10-20
Modem Status screen 10-32
modems

alarms 10-19
checking properties 7-10
properties 10-19
repeaters 10-21
setup 10-21
status 10-32

monitoring
batteries 8-11
DC power 8-13
repeater status 10-27
RepeaterNet 12-2, 12-4
tower hazard lights 8-12, 8-13

Motorola
Micro TAC Elite II cell phones 13-1

mounting
antennas 5-2
associated equipment 5-2
BUPS 5-2, 5-15, 9-10
coaxial cabling 5-2
growth cabinet 6-8, 6-8 to 6-9, 6-10 to ??
growth cabinet housing 6-25
guide bolt 5-6
hardware 5-7
pole hardware 5-10
poles 5-8
power cables 6-39
repeaters 5-1 to 5-13, ?? to 5-15, 12-6
RF cables 6-27, 6-28, 6-38
slot 5-6
wall 5-5
wall bracket 5-5

mounting brackets
repeaters ?? to 5-3, 5-4 to ??
wall 5-5

MTSO
database 11-4

N
neighbor search windows

width 11-2

O
OA1900

growth cabinet 6-2
OA1900 repeaters

RF cables 6-3
serial numbers 6-2

OA1900C 12-3, 12-3
AC accessories 12-12
characteristics 12-4
configuration 12-7, 12-9
DC accessories 12-12
frequencies 12-3
I/O 12-5
inputs 12-5
LED indicators 12-5
outputs 12-5
power options 12-4

OA850
BUPS 9-12
entry boxes 9-6, 9-8, 9-8

OA850C 12-1, 12-1
AC accessories 12-13
characteristics 12-2
configuration 12-6
DC accessories 12-13
frequencies 12-1
I/O 12-2
inputs 12-2
outputs 12-2
power options 12-2
specifications 12-1

online help 10-44
contents 10-45
find 10-46
index 10-45

operations
unsupported B-4

optimizing
repeaters 11-1

optimizing repeaters 2-1
options

cell phone programming 13-3
OA1900C power 12-4
OA850C power 12-2

Options menu 10-43
ordering

repeaters 12-5
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orienting
alarm cables 6-26

outdoors
wiring 9-7

output
measuring B-6

outputs
alarm relays 8-8
digital 8-4
OA1900C 12-5
OA850C 12-2
relays 8-6

outside
wiring 9-7

over-the-air repeaters
modems 10-21

overview
alarms 8-1
installation 5-1
installing repeaters 2-1
testing repeaters 7-1

P
PA Alarms tab 10-30
PA Control tab 6-11, 7-7
PA Measurement tab 10-31
PA Power buttons 6-11
PA Status screen 10-30
Pager Setting tab 7-11, 10-22
pagers

alarms 10-22
paging channels 3-1

cell phones 13-3
parameters

Mobile_TX 11-5
RFER 11-5
SRCH_WIN_N 11-2

parts
spare 12-11

PAs 6-11
alarms 7-5, 7-6
channel 10-30
channels 10-13
control tab 7-7
disable input 8-14
enabling 6-41
forward 7-6, 8-14, 10-12, 10-12, B-10, B-11, B-11
reverse 7-5, 8-14, 10-11, 10-11, B-12, B-13, B-13
status 10-30

paths
forward B-10
reverse B-12

performance
optimizing 11-1

phases
Pilot PN 11-4

phone numbers
cell phones 13-3

pilot channel 3-1
Pilot PN phase 11-4
pilot scanner

using to measure 3-3
pins

external alarms 8-2
I/O 8-3

plugs
AC power 9-4

polarized antennas
dual 4-3
vertical 4-4

pole mounting
banding kit 5-8
hardware 5-10
repeaters 5-8
side view 5-11

pole mounting kit 5-9
PolyPhaser 4-7, 4-7
ports

troubleshooting B-3, B-3
positions

active search window 11-1
neighbor search window 11-2

Pound button
cell phones 13-2

power
AC 6-35, 9-1
applying 7-1, B-5
back-up 9-15, 12-6
connecting 6-34
DC 6-36, 9-7, 9-8, 9-8
DC circuit breakers 9-7
DC fuses 9-7
donor BTS 3-1, 3-2
donor BTS idle 3-2
electrical 12-6
forward PAs B-11
input 9-1, 10-33
input alarm 10-24
measuring forward path B-10
measuring loaded BTS 3-3
measuring reverse path B-12
measuring with pilot scanner 3-3
monitoring DC 8-13
reverse PAs B-13
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Power Amplifiers
(see PAs)

power button
cell phones 13-2, 13-2

power cable 6-19
power cables 6-21 to 6-23

AC 6-32
DC 6-32
installing 6-32
vertical mounting 6-39

power connections
primary cabinet 6-35, 6-36

power connectors
growth cabinet 6-33

power cords
American 9-6
installing 9-3, 9-3
international 9-6
lock nuts 9-4

power measurement
spectrum analyzer 3-3

power options
OA1900C 12-4
OA850C 12-2

power plants
DC power 9-7

power plugs
AC 9-4

power source
connecting 9-1
introduction 9-1

power supply
Battery alarm 10-33
battery alarm 10-25
growth cabinet 10-25

Power Supply alarm 10-24, 10-33
power system

alarms 7-4, 10-33
properties 10-24
status 10-33
voltages 10-34

Power System Properties screen 10-24
Power System Status screen 10-33, 10-33
preparing

repeaters 7-12
primary cabinet

AC power 9-1
AC power plugs 9-4
DC power 9-7
entry boxes 9-6
grounding lugs 5-12, 9-16
isolating B-1

power connections 6-35, 6-36
RF cables 6-39
testing B-1
verifying B-5

problems
(see troubleshooting)

proetction
lightning 4-7, 4-7

programming
cell phone 13-1
cell phone data sequences 13-3

programming options
cell phones 13-3

properties
ACU 10-16
BUPS 10-26
cell phones 7-11, 10-23
channels 10-10, 10-10, 10-14
checking 7-2
configuring 10-8
downloading 10-35
front end 7-4, 10-9
modems 7-10, 10-19, 10-20
power system 10-24, 10-24
uploading 10-36
UPS 7-12, 10-26

Properties command 10-39
protection

lightning 4-7
PS Battery alarm 10-25, 10-33
PWR button

cell phones 13-2, 13-2

R
radius

traffic channel search window 11-4
range

repeater coverage 11-3
RCL button

cell phones 13-2
recall

cell phones 13-3
recall button

cell phones 13-2
receiving

repeaters 1-1
receptacles

J18 9-5
rectifiers

BUPS 9-9, 9-13
relays

alarms 8-8
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connectors 8-1, 8-1
critical alarms 8-9
outputs 8-6

removing
cell phones 13-1

Repeater Technologies, Inc.
(see RTI)

RepeaterNet
alarms 12-2, 12-4
control 12-2, 12-4
exiting 10-47
menus 10-35
monitoring 12-2, 12-4

RepeaterNet Craft software 2-1, 10-1
installing 10-1
requirements 10-1

RepeaterNet Craft window 10-3
RepeaterNet software 8-6, 8-8

Admin window 10-2
closing B-13
growth cabinet 6-40
upgrading 6-11

repeaters
accessories 12-11
accessory kit 1-3
applying power 7-1, B-5
BUPS 9-12
BUPS connections 9-10
BUPS wiring 9-11
cell phones 13-1, 13-2
channel gain 7-8
checking properties 7-2
concluding tests B-13
configuring 10-1
configuring connections 10-2
configuring properties 10-8
connecting BUPS 9-10
coverage equation 11-3
database 11-4
definitions Glossary-1
drive testing 11-5
drive testing equipment 11-5
entry boxes 13-1, 13-2
firmware 10-37
functional test 7-1
gain 10-15
grounding 5-11, 6-37, 9-15
grounding lugs 5-11, 9-15
growth cabinet 5-14, 5-14, 6-34
horizontal wall installation 9-2
indoors 9-1
inspecting 1-1

installation equipment 1-1, 1-2
installing 2-1, 10-1
installing cell phones 13-2
inventory 1-1, 10-41
isolating B-1
isolation 11-1
lightning protection 4-7
link engineering 4-1
loaded tests B-2
login 10-42
measuring output B-6
measuring voltage B-6
MicroFax conflicts B-4
modems 10-21
monitoring status 10-27
mounting 5-1 to 5-13, ?? to 5-15, 12-6
mounting brackets ?? to 5-3, 5-4 to ??
mounting hardware 5-7
OA850 9-12
optimizing 2-1, 11-1
ordering 12-5
outdoors 9-7
pole mounting 5-8
preparing 7-12
primary cabinet 6-35, 6-36
problems (see troubleshooting)
properties 10-8, 10-35, 10-36
receiving 1-1
removing cell phones 13-1
reporting damage 1-1
reverse link 11-3
RF cables 6-39
spare parts 12-11
specifications 12-1
status 10-27
test equipment 7-1
testing 7-1, 11-1
testing with antennnas B-1
timing 11-1
troubleshooting B-1
troubleshooting connections B-4
typical installation 5-2
unpacking 1-1
unsupported operations B-4
upgrading firmware 6-11
verifying B-5
wall mounting 5-5
wall mounting bracket 5-5
wiring BUPS 9-11

reporting
alarm status 10-6
damage 1-1
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status 10-6
required equipment

installation 1-1, 1-2
requirements

RepeaterNet Craft software 10-1
results

Find command 10-47
return loss

antenna cables 4-12
reverse

channel filter 7-7
channel filter alarms 7-7

reverse channel filters 10-13
reverse FE

tabs 10-9
Reverse FE alarm 10-9, 10-29
Reverse Filter alarm 10-13
Reverse Front End Status screen 10-29
reverse link

access 11-3
Reverse PA

alarms 7-5, 10-11
Reverse PA External Shutdown alarm 10-11
Reverse PA tab 7-5
Reverse PA Thermal alarm 10-11
reverse PAs 8-14, B-12

measuring power B-13
turning on B-13

reverse path
measuring power B-12

reviewing
technical specifications 12-1

RF cables
antennas 4-7
connecting 6-27
growth cabinet 6-3, 6-38
horizontal mount 6-27
installing 6-8, 6-23, 6-31
OA1900 repeaters 6-3
primary cabinet 6-39
vertical mount 6-28
vertical mounting 6-38

RF connectors
type one 6-29
type two 6-30

RF/Connect cable 6-19, 6-19 to 6-21
RFER parameter 11-5
ribbon cable

alarms 6-25, 6-26
RTI

address ii
contacting ii, 2-1

FAX ii
technical services 12-14
telephone ii
web site ii

running
Craft software 10-3

S
saving

configuration files 6-13
firmware 10-38

screens
ACU Properties 10-16
ACU Status 10-31, 10-31
ACU status 8-6
Cell Phone Status 10-33
Cellular Phone Properties 7-11, 7-11, 10-23
Channel Filter Status 10-30, 10-30, 10-30
Channel Properties 7-5, 10-10, 10-11, 10-14, B-8
control 10-6
Craft main control 10-3, 10-3
Diversity Front End Status 10-29
Forward Front End Status 7-4, 10-28
Front End Status 10-28
hardware settings 10-8, B-6
Modem Status 10-32
PA Status 10-30
Power System Properties 10-24
Power System Status 10-33, 10-33
Reverse Front End Status 10-29
Status 10-27
status 10-6
System Properties 10-40
UPS Properties 10-26
UPS Status 10-34

search windows
channel 11-3
traffic channel 11-4
width 11-1, 11-2

second channel
(see growth cabinet)

second number
cell phones 13-3

security codes
cell phones 13-2, 13-3

selecting
BUPS 12-12
gain 10-15

send button
cell phones 13-2

sequence programming
cell phones 13-3
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In
d

ex

serial number
OA1900 repeaters 6-2

services
technical 12-14

setting
ACU alarms 10-17
alarm severity 10-7
BUPS alarms 10-26
cell phone alarms 10-23
channel gain B-11, B-13
digital outputs 8-4
gain 10-15
I/O 10-16
Input Power alarm 10-24
modem alarms 10-19
modem properties 10-19, 10-20
pager alarms 10-22
pagers 10-22
Power Supply alarm 10-24
power system properties 10-24
relay outputs 8-6
SRCH_WIN_N parameter 11-2
traffic channel search window radius 11-4

settings
alarm defaults A-1
hardware 6-40, 10-8

setup
Find Wizard 10-46
modems 10-21

severity
alarms 10-7
pager alarms 10-22

shutdown alarm
forward PA 10-12
reverse PA 10-11

SID
cell phones 13-3

side view
pole mounting 5-11

signal strength
donor BTS 3-1

signals
donor BTS 3-1

slots
mounting 5-6

SND button
cell phones 13-2

software
Admin window 10-2
closing RepeaterNet B-13
Craft 2-1
installing 10-1

main control screen 10-3, 10-3
RepeaterNet 6-11, 6-40, 8-6, 8-8
RepeaterNet Craft 2-1, 10-1
starting Craft 10-3

sounds
alarms 10-6, 10-43

spare parts 12-11
speakers

cell phones 13-3
specifications 12-1

OA850C 12-1
specifying

gain 10-15
spectrum analyzer

measuring power 3-3
SRCH_WIN_A 11-1
SRCH_WIN_N parameter

setting 11-2
Star button

cell phones 13-2
starting

Craft software 10-3
Station Class marks 13-3
status

ACU 10-31, 10-31
alarms 10-6
cell phones 10-33, 10-33
channel filters 10-30, 10-30, 10-30
channel PAs 10-30
Diversity Front End 10-29
Forward Front End 7-4, 10-28
front end 10-28
modems 10-32, 10-32
monitoring 10-27
PAs 10-30
power system 10-33
Reverse Front End 10-29
UPS 10-34

Status screens 10-27
status screens 10-6

ACU 8-6
strain-relief conduit

installing 9-2, 9-3
strength

donor BTS signal 3-1
subscriber antennas 12-6

dual-polarized 4-3
vertically-polarized 4-4

subsystems
configuring 10-5
status screens 10-6

summary alarms
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UPS 10-26, 10-34
support

services 12-14
sweeping

antenna cables 4-12
sync channel 3-1
system ground 5-13
system ID

cell phones 13-3
System Inventory tab 10-41
System Login tab 10-42
System menu 10-39
System Properties screen 10-40
System tab 10-40

T
tabs

ACU Alarm 10-31
ACU Alarms 7-9
ACU Alarms Setting 10-17
ACU DC Voltage Alarm 10-18
ACU Measurement 10-32
Alarm 10-28, 10-33
Alarm Setting 10-19, 10-26
alarm setting 7-10
Alarms 10-27, 10-34
Alarms Setting 10-23
Channel # 7-8, 10-14
Channel Forward Filter 7-7, 10-14
Channel Forward PA 10-12
Channel Gain 7-8, 10-15
Channel PA Control 10-13
Channel Reverse Filter 7-7, 10-13
Contents 10-45
Control 10-27
diversity FE 10-10
External DC Voltage 10-18
Find 10-46
forward FE 10-9
Forward PA 7-6
I/O Controls 10-17
I/O descriptions 10-16
Index 10-45
Measurements 10-27
Modem Properties 7-10, 10-20
PA Alarms 10-30
PA Control 7-7
PA Measurement 10-31
Pager Setting 7-11, 10-22
reverse FE 10-9
Reverse PA 7-5
System 10-40

System Inventory 10-41
System Login 10-42
Voltages 10-27, 10-34

tamper alarm 8-5
Tamper alarms

ACU 10-31
tamper alarms

UPS 10-26, 10-34
technical services 12-14
technical specifications 12-1
technical support

services 12-14
telephone

RTI ii
telephone numbers

cell phones 13-3
Temperature alarms

ACU 10-31
terminal one

wires 8-2
terminals

I/O 8-1
terms

definitions Glossary-1
test equipment

repeaters 7-1
verifying repeaters B-5

testing
antennas with repeaters B-1
drive 11-5
growth cabinet B-1
overview 7-1
primary cabinet B-1
repeaters 11-1
repeaters under load B-2

tests
concluding B-13
functional 7-1

thermal alarms
Forward PA 10-12
Reverse PA 10-11

threading cables
growth cabinet 6-31

thresholds
DC voltage 10-18

Times of Arrival
(see TOA)

timing
BTS 11-1
CDMA networks 11-1
repeaters 11-1

TOA
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In
d

ex

equation 11-4
tools

growth cabinet 6-3, 6-5 to 6-7
tower hazard lights

monitoring 8-12, 8-13
tower hazards

warning lights 8-11
traffic channel search window

radius 11-4
traffic channels 3-1
troubleshooting

connections B-4
databases B-3
GUI B-3
MicroFax conflicts B-4
ports B-3, B-3
repeater connections B-4
repeaters B-1
unsupported operations B-4

turning on
forward PAs B-11
reverse PAs B-13

type one RF connectors 6-29
type two RF connectors 6-30
typical repeater installation 5-2

U
Uninterruptable Power Supply

(see UPS)
unlock codes

cell phones 13-3
unpacking

repeaters 1-1
unsupported operations

troubleshooting B-4
Update Repeater Firmware command 10-37
updating

firmware 6-17
OA1900 for growth cabinet 6-2

upgrading
firmware 6-11, 6-15, 6-17
RepeaterNet software 6-11

Upload Properties command 10-36
uploading

firmware 6-15
UPS

alarms 10-34
checking properties 7-12
properties 10-26
status 10-34

UPS Properties screen 10-26
UPS Status screen 10-34

UPS Summary alarm 10-26, 10-34
UPS Tamper alarm 10-26, 10-34
utilities

Find Setup Wizard 10-46

V
verifying

firmware update 6-17
growth cabinet B-5
installation B-1
primary cabinet B-5

verifying repeaters
test equipment B-5

vertical mount
cable connections 6-28
growth cabinet 6-10 to ??

vertical mounting
growth cabinet 5-14
power cables 6-39
RF cables 6-38

vertically-polarized subscriber antennas 4-4
voltage

DC threshold 10-18
measuring B-6

Voltage Standing Wave Ratio
(see VSWR)

voltages
DC input 8-13
digital inputs 8-12

Voltages tab 10-27, 10-34
VSWR 4-12

W
wall mounting

repeaters 5-5
wall mounting bracket

repeaters 5-5
walls

repeater installation 9-2
warning lights

tower hazard 8-11
web site

RTI ii
width

active search windows 11-1
channel search window 11-3
neighbor search windows 11-2

windows
active search 11-1
Admin 10-2
channel search 11-3
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Craft 10-3
neighbor search 11-2
RepeaterNet Craft 10-3
traffic channel search 11-4

wire
terminal one 8-2

wiring
AC power 9-1
alarms 8-1
BUPS 9-11
control 8-1
DC power 9-7
indoors 9-1
outdoors 9-7

wizards
Find Setup 10-46


